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Preface

Welcome to Release 11i of the Oracle iSupport Implementation Guide. This guide is 
intended to be utilized in the implementation of Oracle iSupport version 11i (11.5.6).

Audience for this Guide
This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle iSupport

If you have never used Oracle iSupport, Oracle suggests you attend one or 
more of the Oracle iSupport training classes available through Oracle 
University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

How To Use This Guide
This guide contains the information you need to implement Oracle iSupport and 
Oracle Knowledge Management, release 11.5.6. It is organized into the following 
chapters:

■ Chapter 1 -- Introduction -- Contains an overview of the features and 
functionality of Oracle iSupport. It also highlights what is new in this release of 
the application.
xiii



■ Chapter 2 -- Technology, Requirements, and Performance -- contains an architectural 
overview of the application, as well as the minimum software and hardware 
requirements of Oracle iSupport. 

■ Chapter 3 -- Dependency Requirements and Verification -- details Oracle iSupport’s 
dependency relationships with other Oracle applications. This chapter also 
provides installation and dependency verification steps.

■ Chapter 4 -- Implementation Overview -- describes in general terms the high-level 
implementation steps for Oracle iSupport and its dependencies.

■ Chapter 5 -- Implementation Tasks -- provides the step-by-step instructions 
required to successfully set up Oracle iSupport and its dependencies.

■ Chapter 6 -- Verifying the Implementation -- can assist you in verifying that you 
have successfully implemented the major features and functionality of Oracle 
iSupport.

■ Chapter 7 -- Integrating Oracle iSupport with Service Request -- contains 
information to successfully implement the service request functionality of 
Oracle iSupport.

■ Chapter 8 -- Integrating Oracle iSupport with Products and Returns -- details the 
Oracle applications that provide product information to various processes. This 
chapter also describes the returns process and setup dependencies for returns.

■ Chapter 9 -- Integrating Oracle iSupport with Oracle Knowledge Management -- 
describes how to set up the Knowledge Management application.

■ Chapter 10 -- Integrating Oracle iSupport with Oracle Workflow -- discusses the 
functionality that Oracle Workflow provides to Oracle iSupport.

■ Chapter 11 -- Diagnostics and Troubleshooting -- provides details of common 
problems found while implementing or accessing the application. This chapter 
also contains FAQs for Oracle iSupport administration.

■ Appendix A -- Profile Options -- describes how to set up the profile options 
related to implementing Oracle iSupport.

■ Appendix B -- Seed Data -- provides information on the data that is seeded 
within Oracle iSupport.

■ Appendix C -- Oracle iSupport APIs -- lists the iSupport-specific APIs that are 
public, published, and supported by Oracle.
xiv



Typographic Conventions
This manual uses the typographic conventions listed in the following table:

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program web site at:

http://www.oracle.com/accessibility.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle Corporation does not own or control. Oracle Corporation 
neither evaluates nor makes any representations regarding the accessibility of these 
Web sites. 

Related Documentation and Training
Oracle iSupport shares business and setup information with other Oracle 
Applications products. Therefore, you will need to refer to other documentation 

Convention Meaning

italic text Book or chapter titles

Courier text User commands, file content examples, directory names

UPPERCASE Structured Query Language (SQL) commands, initialization 
parameters, profile options, responsibilities, or environment 
variables

boldface text Menu, button, keyboard, and form options, emphasis

< > Angle brackets enclose user-supplied names. 

Note: Do not type the angle brackets.
xv
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when setting up the application. You also may wish to access training. This section 
discusses your documentation and training options.

Documentation Related to Oracle iSupport Setup/Usage
Oracle iSupport online HTML help is available by selecting CRM Applications > 
Internet Business Applications > Oracle iSupport from the online help menu. 
Printed versions of the user and implementation manuals are available for purchase 
from Oracle Store (http://store.oracle.com) and Oracle Documentation Center 
(http://docs.oracle.com). Online HTML help patches and PDF versions of guides 
are available on Oracle MetaLink (http://metalink.oracle.com).

Available PDF version of the guides used for implementing and using Oracle 
iSupport and its dependencies are listed below.

■ Oracle iSupport Guides

■ Oracle iSupport Implementation Guide

■ Oracle iSupport Concepts and Procedures

■ Knowledge Base Applications Guides

■ Oracle iSupport Implementation Guide: Integrating Oracle iSupport with Oracle 
Knowledge Management chapter

■ Oracle iSupport Concepts and Procedures: Using Oracle Knowledge Management 
and Understanding Oracle Knowledge Management

■ Oracle Marketing Encyclopedia System Implementation Guide

■ Oracle Marketing Encyclopedia System Concepts and Procedures

■ Oracle Products Applications Guides

■ Oracle Inventory Implementation Guide

■ Oracle Inventory Concepts and Procedures

■ Oracle Bills of Material (BOM) Implementation Guide

■ Oracle Bill of Materials (BOM) Concepts and Procedures

■ Oracle Install Base Implementation Guide

■ Oracle Install Base Concepts and Procedures

■ Oracle Purchasing-Related Applications Guides

■ Oracle Order Management Implementation Guide
xvi



■ Oracle Order Management User’s Guide

■ Oracle Quoting-Forms Implementation Guide

■ Oracle Quoting-Forms Concepts and Procedures

■ Oracle iStore Implementation Guide

■ Oracle iStore Concepts and Procedures

■ Oracle Customer Support/Service Request Applications Guides

■ Oracle Support Concepts and Procedures

■ Oracle Support Implementation Guide

■ Oracle Customer Care Concepts and Procedures

■ Oracle Customer Care Implementation Guide

■ System Test Plan - Customer Support

■ Oracle Contracts Applications Guides

■ Oracle Contracts for Service Concepts and Procedures

■ Oracle Contracts Core Concepts and Procedures

■ Oracle Telephony Manager Guides

■ Oracle Telephony Manager Implementation Guide

■ Oracle Telephony Manager Concepts and Procedures

■ Oracle Call Center Guides

■ Installing Oracle Call Center Connectors

■ Oracle Call Center Connectors Implementation Guide

■ Oracle Call Center Applications Setup

■ Oracle Scripting Guides

■ Oracle Scripting Implementation Guide, Release 11i

■ Oracle Scripting Concepts and Procedures, Release 11i

■ Oracle Quality Online (formerly DEMS) Guides

■ Oracle Quality Online Implementation Guide, Release 11i

■ Oracle Quality Online Concepts and Procedures, Release 11i
xvii



Documentation Related to All Oracle Products
All Oracle Applications documentation is available online (HTML or PDF) by 
selecting Library from the documentation CD-ROM, or by selecting the Help button 
on the user interface (UI). Online HTML help patches and PDF versions of guides 
are available on Oracle MetaLink (http://metalink.oracle.com).

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle iSupport (and 
any other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing Getting Started with Oracle 
Applications from any Oracle Applications help file.

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.
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Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library (AOL) 
components needed to implement the Oracle Applications user interface described 
in the Oracle Applications User Interface Standards for Forms-Based Products. It also 
provides information to help you build your custom Oracle Forms Developer 6i 
forms so that they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.
xix



Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle iSupport. This 
manual details additional steps and setup considerations for implementing Oracle 
iSupport with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle iSupport with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle 
iSupport.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle iSupport implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Oracle MetaLink

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.
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Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle iSupport and 
reach full productivity quickly. You have a choice of educational environments. You 
can attend courses offered by Oracle University at any one of our many Education 
Centers, you can arrange for our trainers to teach at your facility, or you can use 
Oracle Learning Network (OLN), Oracle University's online education utility. In 
addition, Oracle training professionals can tailor standard courses or develop 
custom courses to meet your needs. For example, you may want to use your 
organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle iSupport working for 
you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.

OracleMetaLink
Oracle MetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With Oracle MetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
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download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com). Bugs created against the 
Oracle iSupport application use the bug identifier number of 381. 

Alerts: You should check Oracle MetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
xxii



software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Introduction

This topic group provides an introduction to the Oracle iSupport 11i application and 
its components, and lists features and functionality new in this release.

■ Oracle CRM E-Commerce Suite Overview

■ Oracle iSupport Overview

■ New in the 11.5.6 Release 

1.1 Oracle CRM E-Commerce Suite Overview
Oracle CRM E-Commerce Suite, Release 11i, is a comprehensive, fully web-based 
solution for unassisted business-to-business and business-to-consumer selling, 
marketing, and servicing via the Internet. The E-Commerce suite applications cover 
the entire spectrum of e-commerce, including customer relationship management, 
business-to-business, financials, projects, human resources, and business 
intelligence. For more information, visit the Oracle website at:

http://oracle.com.

1.2 Oracle iSupport Overview
Oracle iSupport is an Internet-based customer support application that enables 
merchants to provide self-service customer support online. Oracle iSupport 
functionality allows organizations to provide users with support information and 
problem solutions. Integration with other Oracle products gives users the ability to 
manage their own service needs.

A fully-realized Oracle iSupport implementation can reduce service costs, 
consolidate service and product information, and allow service personnel to focus 
ction 1-1
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Oracle iSupport Overview
on non-repetitive customer requests, thus increasing customer satisfaction and 
product viability.

1.2.1 Oracle iSupport Key Features
Key features and benefits of Oracle iSupport include the following:

1.2.1.1 Service Request
Oracle iSupport enables users to manage their service request activity online. This 
functionality is available if the merchant sets up the service request functionality 
detailed in the chapter, Integrating Oracle iSupport with Service Request. Additional 
support features can be realized by implementing Oracle Knowledge Management 
and the products and returns features. See the chapters, Integrating Oracle iSupport 
with Oracle Knowledge Management and Integrating Oracle iSupport with Products and 
Returns for more information.

Once the service request information has been entered, it is validated by Oracle 
Customer Support (TeleService) and assigned a unique tracking number for future 
reference. Merchants can enforce product selection and/or knowledge base 
searching during the service request process.

A typical business scenario might be:

■ Customer logs in to Oracle iSupport.

■ Customer queries knowledge base directly for troubleshooting help prior to 
creating a new request.

■ Customer accesses Create Service Request screen and enters contact and service 
request detail information. Customer sets up optional service request profile to 
aid in date entry for submitting this and future service requests. Customer may 
also attach any type of file(s) to the service request.

■ Once the service request is submitted, the system returns a tracking number to 
the customer. At the end of the service request submission process, customers 
have the option of adding the service request link to the Homepage, and/or 
having the service request details sent to the e-mail address that is set up in the 
Personal Profile.

■ After service request submission, customers can view, close, update, attach 
additional files, and/or conditionally re-open their service requests.
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Oracle iSupport Overview
1.2.1.2 Knowledge Base
Oracle Knowledge Management and Marketing Encyclopedia System (MES) 
implementation allows access to the known problems/solutions database, and 
permits users to locate technical documents, including white papers, user guides, 
and FAQs. The merchant benefits by increased knowledge among customers and 
reduced call center activity. The Knowledge Management and MES user interfaces 
are easy to use and feature flexible search capabilities. For additional information, 
see the Oracle Marketing Encyclopedia Implementation Guide and Integrating Oracle 
iSupport with Oracle Knowledge Management chapter of this guide.

A typical business scenario might be:

■ Customer logs in to Oracle iSupport. Customer views Alerts and Company 
News on the Homepage.

■ Customer accesses the knowledge base from the Homepage or by using the 
Support page.

■ Customer uses either basic or advanced search functions to locate answers.

■ Customer views solution detail, and can add link to the Homepage if desired.

1.2.1.3 Account Management
Oracle iSupport’s optional account management functionality allows users to view 
detailed transaction history and status, and to create returns. Integration with 
products and returns applications allows a user to view orders, invoices, payments, 
and shipping information, as well as to create return material authorizations 
(RMAs). Integration with Oracle Contracts Suite, if these optional modules are 
implemented, provides a view of contracts, entitlements validation, and customer 
service programs and warranties.

If all required applications are implemented, this functionality allows customers to 
service their own account needs. For more information, see the chapter, Integrating 
Oracle iSupport with Products and Returns. For setting up Contracts functionality, 
refer to Oracle Contracts Core Implementation Guide, and Oracle Contracts for Service 
Implementation Guide.

A typical business scenario might be:

■ Customer logs in to Oracle iSupport.

■ Using the Accounts tab, the customer has online, real-time access to information 
regarding account data, including:

■ Orders
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■ Shipments

■ Invoices

■ Payments

■ Contracts

■ Returns

1.2.1.4 Products Repository
Oracle Install Base is a repository of customer or organization/party purchase 
information, including purchase date, product attributes, and applicable service 
agreements. Oracle Install Base maintains information about purchased products in 
a tree structure showing all of the parent and child assemblies. It allows users to 
drill down to view detailed product information. Oracle Install Base tracks, updates, 
and maintains product configurations whenever a new part or component is 
installed or replaced. It also allows the grouping of customer products into systems 
for ease of service. The Install Base tracks serialized and non-serialized products, 
and provides powerful search capabilities. Support organizations benefit from 
having customers who are informed about their transaction and product histories 
and applicable contracts.

Required integration with Oracle Inventory, as well as optional integration with 
Oracle Bills of Material, further facilitate access to product information. With 
Products functionality, users can manage and track products themselves online, 
thus decreasing calls to customer service centers and increasing customer control 
over service issues. For more information, see the chapter, Integrating Oracle iSupport 
with Products and Returns.

A typical business scenario might be:

■ Customer logs in to Oracle iSupport.

■ Customer accesses Install Base from the Products tab.

■ Customer reviews product details and/or adds products to the Install Base.

1.2.1.5 Oracle iSupport Homepage
Oracle iSupport’s homepage features links to support areas of the application.

General users can personalize their homepages with links to service request activity 
and knowledge base search results. The user also has the option of having the 
contents of his homepage e-mailed to him; this is known as a homepage 
subscription.
1-4       Oracle iSupport Implementation Guide



Oracle iSupport Overview
Integration with Oracle Marketing Encyclopedia System enables merchants to send 
alerts and other system messages to the homepage for viewing by general users and 
employees. The merchant has the option of making some homepage content 
mandatory.

For more information, see the Setting up iSupport Homepage topic area in this 
guide’s Implementation Tasks chapter.

A typical business scenario might be:

■ Customer logs in to Oracle iSupport and access the Homepage (the initial 
landing page).

■ Customer views Alerts, company news, or other content provided by the 
administrator.

■ Customer accesses Content hyperlink to add or remove content.

■ Customer accesses Layout hyperlink to change the layout of content.

■ Customer selects Edit hyperlink on Service Request Quick Links, Service 
Request (saved views), and/or Quick Links bins to configure display of these 
bins.

1.2.1.6 Oracle iSupport Forums
Oracle iSupport Forums are online message boards where customers can post 
questions and comments and review those from other users. Organized into 
categories, forums enable customers to share information. In Oracle iSupport, users 
can search for specific subjects or browse within a particular forum. Oracle iSupport 
allows merchants to create and manage forums, and to use forum moderators for 
certain forum administrative tasks. For more information, see the Setting up 
iSupport Forums topic area in this guide’s Implementation Tasks chapter.

A typical business scenario might be:

■ Customer logs in to Oracle iSupport.

■ Customer accesses Forums tab to view organized categories and forums 
subcategories. 

■ Customer selects a hyperlinked forum message, views the message, and can 
post a new message underneath that forum message or start a new message 
thread.

■ Customer can use forums signature feature to allow personalized signing of his 
forum messages.
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■ Customer can use Advanced Search to query by keyword, category, date, 
message status, and author. 

1.3 New in this Release
Oracle iSupport contains the following new functionality in this release.

Service Request
■ Customizable templates used for gathering relevant data about service requests

■ Ability by users to close, update, and conditionally re-open service requests

Users and User Management
■ Support for Employee User type

■ User registration framework

■ User profile settings

Homepage
■ Service request bookmark bin

■ Service request views (saved searches) bin

Install Base
■ Uptake of Install Base 11.5.6 features, including ability to create products

Forums
■ Ability by user to "subscribe" to forums

■ Ability by administrator to create forum moderators

Knowledge Management
■ Solution authoring ability with source control features

■ Categorization of solutions

■ Ability to search for matching statements/solutions while creating a statement

■ Ability to find related statements/solutions to reuse when creation solutions

■ Ability to search for solutions by category, product, or platform
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■ Ability to add external links and/or comments to solutions

■ Multiple search methods, including Intermedia text, user defined, keyword, 
and boolean

■ Integration with Oracle Workflow to manage the solution creation process
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Technology, Requirements, and

Performance

This chapter provides details on the architecture of Oracle iSupport 11i. 

2.1 Architectural Overview
Oracle iSupport runs on a 3-tier system comprised of:

Data Tier - The data tier includes Oracle ERP and CRM main tables which comprise 
their common schema. These are driven by the Oracle 8i database. Most of the CRM 
application business logic that is written in PL/SQL are also in the data tier.

Application Tier - The application tier uses business logic APIs and CRM 
Foundation services, Java Server Pages (JSP), and Java APIs. In addition, the Oracle 
Application Object Library (AOL) supplies technology and common libraries for the 
applications. In Oracle applications, Internet Application Server (iAS) drives this 
tier and the Presentation tier discussed below.

Presentation Tier - Generated Java code and compiled servlet code utilize JSP 1.0 
and Servlet 2.0 to form the presentation tier. In Oracle applications, the Apache 
Server 1.3.9 drives this tier.

The diagram below depicts this 3-tier structure.
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Figure 2–1 Oracle iSupport Architecture
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Dependency Requirements and Verification

This chapter describes in general terms the dependency requirements and 
verification of dependencies for Oracle iSupport 11i. Topics include:

■ Overview of Dependencies

■ Mandatory Dependencies

■ Conditional Dependencies

3.1 Overview of Dependencies
Because Oracle iSupport is comprised of multiple Oracle modules supplying varied 
data and functionality, merchants can choose which modules to implement, based 
on their specific business requirements. These integrated modules present many 
dependencies to Oracle iSupport.

Dependencies are classified as either mandatory, meaning that Oracle iSupport 
cannot function without them, or conditional, meaning that they supply additional 
functionality, but are not required to run Oracle iSupport. The Mandatory and 
Conditional Dependencies sections in this chapter provide overviews of these 
dependencies.

For documentation and training related to these modules, please see the Preface 
to this guide.

3.2 Mandatory Dependencies
Oracle iSupport relies on several Oracle ERP and CRM modules for its data and 
functionality. The modules that must be installed and set up for Oracle iSupport to 
function properly are discussed in the following paragraphs.
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3.2.1 Oracle Application Object Library (AOL)
The Oracle Applications Object Library (AOL) is a required dependency of all 
Oracle applications. Supplying technology and common libraries for Oracle 
applications, AOL allows user creation, responsibility creation and maintenance, 
and the assignment of responsibilities to users. 

3.2.2 Oracle CRM Technology Foundation
Oracle CRM Technology Foundation is a prerequisite for implementation of any 
Oracle CRM module. The technology stack supplies debug logging trails and cookie 
encryption.

3.2.3 Oracle Workflow
In all Oracle applications, Oracle Workflow provides the ability to send e-mail 
notifications, and allows you to define various workflow processes required for 
normal business operations. Oracle Applications 11i comes with Oracle Workflow 
(WF) already installed as part of the Applications Object Library (AOL). For details 
on how Oracle iSupport uses Oracle Workflow, please see the chapter in this guide, 
Integrating Oracle iSupport with Oracle Workflow.

3.2.4 Oracle Trading Community
The 11i Oracle Trading Community Model -- also known as Oracle Trading 
Community Architecture or the acronym, TCA -- consists of a database schema, 
APIs, and data quality management utilities that allow you to capture and exploit 
valuable information about your commercial community: organizations, people, 
places, and the network of relationships that bring them together. Oracle Trading 
Community is used by both Oracle ERP and Oracle CRM applications. In R11i, 
Oracle’s customer model is TCA. 

Some APIs for TCA are being published as part of Release 11.5.6. Refer to current 
TCA documentation for API details.

3.2.5 Accounts Receivable
A central data repository for customer information that uses the TCA model, Oracle 
Accounts Receivable (AR) provides customer account data for Oracle iSupport. 
Once a customer books an order in an Oracle CRM application, an account is 
created in AR. If a customer is directly created in AR, an account number is also 
generated. AR also calculates taxes and generates invoices.
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3.2.6 Oracle General Ledger
Oracle iSupport uses General Ledger to set up ledgers and books, store exchange 
rates, and store related business information. Refer to Oracle General Ledger User 
Guide for complete setup information.

3.2.7 Human Resource Management System
Oracle Human Resources Management System (HRMS) provides employee data for 
CRM and ERP applications.

3.2.8 Oracle CRM Foundation
CRM Foundation 11i suite of applications supplies a significant amount of 
functionality for Oracle iSupport. Beginning with the 11.5.6 release, the CRM 
Foundation software suite has been split into two distinct but interrelated 
application groups:

■ CRM Technology Foundation (JTT) - Provides Java-based infrastructure 
software that is used to develop e-business solutions such as Sales, Marketing, 
Service, E-Commerce, Contracts, and Interaction Center applications. It offers a 
common platform for developing applications with HTML, XML, and Java. It 
also provides user-friendly screens for centralized setup and administration. 
This web-based interface is called the System Administrator Console. The CRM 
User Management Framework uses this application group. For more 
information, see the Oracle CRM Technology Foundation Implementation Guide and 
the Oracle CRM Technology Foundation Concepts and Procedures.

■ CRM Application Foundation (JTA) - Consists of the following CRM 
applications: Territory Manager, Resource Manager, Notes, Calendar, Task 
Manager, Interaction History, Fulfillment, Assignment Manager, and Escalation 
Management. Documentation for this application group also includes 
information on using Spreadtables and TCF Servers for Gantt. For more 
information, see Oracle CRM Application Foundation Implementation Guide and 
the Oracle CRM Application Foundation Concepts and Procedures.

In Oracle iSupport, the service request processes are highly dependent upon 
Assignment Manager, Notes, Resource Manager, and Territory Manager. 
Knowledge Management also uses Notes and Resource Manager. For more 
information, see Integrating Oracle iSupport with Service Request and Integrating 
Oracle iSupport with Knowledge Management.
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3.3 Conditional Dependencies
Oracle iSupport relies on several other Oracle applications to extend its 
functionality. The applications that are conditional to Oracle iSupport are discussed 
in the following paragraphs.

3.3.1 Oracle Customer Support (TeleService)
A forms-based product, Oracle Customer Support (TeleService) contains the bulk of 
the service request functionality for Oracle iSupport. Integration with Oracle 
Support allows customers using Oracle iSupport to submit, view, edit, and re-open 
their service requests online. Setup information is in the chapter, Integrating Oracle 
iSupport with Service Request.

3.3.2 Oracle Inventory and Oracle Install Base
Oracle Inventory supplies the infrastructure that contains an organization’s entire 
product repository and configuration. It integrates closely with Install Base, which 
is the repository of customer- or party-purchased products. Both Inventory and 
Install Base are required for full service request functionality in Oracle iSupport. 
Both applications also supply product information during retrieval of account 
information on the Oracle iSupport Accounts tab. Setup information is in the 
chapter, Integrating Oracle iSupport with Products and Returns.

3.3.3 Oracle Bills of Materials
Oracle Bills of Materials (BOM) allows you to configure groups of products into 
coordinated and complementary systems. BOM allows the creation of products 
containing multiple components and subcomponents. It integrates with Inventory 
and Install Base. Setup information is in the chapter, Integrating Oracle iSupport with 
Products and Returns.

3.3.4 Oracle Order Management
Oracle Order Management (OM) processes orders booked in Oracle Forms-Quoting, 
Oracle HTML-Quoting, Oracle iStore, and Oracle Order Management itself. OM 
and Oracle Quoting-Forms are both integral applications for returns functionality in 
Oracle iSupport. OM integrates with Oracle Pricing for determining prices of goods 
sold and Oracle Shipping for shipping execution. OM uses Oracle Receivables for 
keeping records of customers and invoices, and capturing payments. OM also 
depends on Oracle General Ledger. Setup information is in the chapter, Integrating 
Oracle iSupport with Products and Returns.
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3.3.5 Oracle Quoting-Forms and Order Capture APIs
Orders quoted in Oracle Quoting-Forms (formerly called Oracle Order Capture) are 
sent to Order Management for processing. These orders then can be viewed within 
the Oracle iSupport Accounts tab. There are three parts to quoting: Oracle 
Quoting-Forms, Oracle Quoting-HTML, and Order Capture APIs. All of these 
coordinate in the returns process, and Oracle Order Capture APIs are essential to 
returns functionality in Oracle iSupport. Setup information is in the chapter, 
Integrating Oracle iSupport with Products and Returns.

3.3.6 Oracle Purchasing
The Receipts form of Oracle Purchasing receives returns created in Oracle iSupport. 
Setup information is in the chapter, Integrating Oracle iSupport with Products and 
Returns.

3.3.7 Oracle iStore
The Oracle iStore application provides allows merchants to set up Internet 
storefronts that capture and process customer orders. Oracle iStore is not required 
for any functionality within Oracle iSupport, but orders placed in Oracle iStore can 
be viewed within the Oracle iSupport Accounts tab. Setup information is contained 
within the Oracle iStore Implementation Guide.

3.3.8 Oracle Contracts Suite
Oracle Contracts Suite - made up of Contracts Core and Contracts for Service - 
provides a complete range of contracts creation, service, organization, and 
termination. Oracle iSupport relies on the Contracts Suite to provide data about 
customer entitlements, service contracts, warranties, extended warranties, and 
response commitments. This data is retrieved by Oracle iSupport when customers 
view account information and create service requests. See the latest Contracts 
documentation available on MetaLink for setup information.

3.3.8.1 Contracts Core
Contracts Core is both an application that provides supporting master agreements 
and a foundation for all other Contracts modules. The generic functionality 
required by all types of contracts is contained in the Contracts Core foundation 
layer, e.g., contract access control, renewal, termination, and notification 
management. 
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3.3.8.2 Contracts for Service
Contracts for Service (or Service Contracts) creates and manages service contracts, 
warranties and extended warranties; provides visibility to contract entitlements; 
and acts upon contractual commitments within the contract. Contracts for Service 
builds upon the foundation of the Contracts Core and adds functionality to meet 
the specific needs of the service industry, e.g., coverage terms, entitlement checking.

3.3.9 Oracle Customer Care
Oracle Customer Care is comprised of four modules:

■ Contact Center

■ Relationship Plans

■ Customer Profile/Dashboard

■ Critical Customer Management

These modules allow customer support agents to manage many aspects of support, 
including real-time interactions, information retrieval, customer creation, historical 
views, service request creation, knowledge base data retrieval, product 
management, and relationship plans.

Oracle Customer Care integrates with several ERP and CRM modules to support 
and extend its functionality. Setup information can be found in the Oracle Customer 
Care Implementation Guide.

3.3.10 Oracle Knowledge Management
In Oracle iSupport, Oracle Knowledge Management (KM) allows knowledge base 
searches during service request creation, the display of frequently used solutions on 
the homepage, and knowledge base searches from the Support tab. For the 11.5.6 
release of KM, all KM documentation is contained within the Oracle iSupport 
documentation. Setup information is in the chapter, Integrating Oracle iSupport with 
Oracle Knowledge Management.

3.3.11 Oracle Marketing Encyclopedia System
In Oracle iSupport, Oracle Marketing Encyclopedia System (MES) provides 
functionality for publishing information to the homepage Alerts bin, displaying 
other optional homepage content, and searching the technical library from the 
Support tab. Setup information can be found in the Oracle Marketing Encyclopedia 
System Implementation Guide.
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3.3.12 Web Call-Back Dependencies
The Web Call-Back (Call Me) feature allows users to submit a call-back request via 
the Oracle iSupport UI. The web call-back requires implementation of the CRM 
Interaction Center (formerly Call Center Technology - CCT) suite of applications 
and the purchase of call center hardware. It also requires the implementation of 
Oracle Universal Work Queue (UWQ), Oracle Customer Care, and Oracle CRM 
Foundation Notes module. For further information, see the Setting up iSupport Web 
Call-Back in the Implementation Tasks chapter.

3.3.13 Oracle Scripting
Oracle iSupport uses Oracle Scripting to provide Surveys functionality. Scripting 
also presents scripts to the desktop of an Interaction Center agent to aid customer 
service. For further information, see the Setting up iSupport Surveys topic in the 
Implementation Tasks chapter.
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Implementation Overview

This chapter provides an overview of the implementation process for Oracle 
iSupport 11i (11.5.6). 

Topics include:

■ Process Overview

■ Implementation Task Sequence

4.1 Process Overview
Oracle iSupport is reliant on other Oracle applications for its functionality. In order 
to successfully implement Oracle iSupport, you must set up its mandatory 
dependencies, and optionally, its conditional dependencies.

The tasks described in this guide are meant to assist your set up of Oracle iSupport, 
Release 11i, version 11.5.6. Many companies installing Oracle iSupport already are 
running some of the mandatory and/or conditional Oracle applications, and for 
them, Oracle iSupport is an add-on or upgrade. Thus, depending upon your 
particular situation, you may or may not need to perform all of the tasks listed here.

4.2 Implementation Task Sequence
The following table, Oracle iSupport Implementation Steps, shows the 
recommended task sequence for setting up Oracle iSupport.
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Table 4–1 Oracle iSupport Implementation Steps

Step Required? Related Documentation

Install Oracle iSupport Yes Oracle iSupport Implementation Guide

Confirm General Oracle 
Applications Setups

Yes Oracle iSupport Implementation Guide, Preface

Perform System Administrator 
Setups for iSupport

Yes Oracle iSupport Implementation Guide

Oracle Applications System Administrator’s Guide

Set up Oracle Workflow Yes Oracle iSupport Implementation Guide, Chapter 10, Integrating 
Oracle iSupport with Oracle Workflow

Oracle Workflow Guide

Oracle Workflow Guide Documentation Update, Release 2.6.1

Oracle Workflow Builder Documentation Supplement Release 2.6.1

Set up Oracle CRM Foundation Yes Oracle CRM Technology Foundation Implementation Guide

Oracle CRM Application Foundation Implementation Guide

Set up Oracle iSupport Users Yes Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Set up Oracle iSupport 
Homepage

Yes Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Set up CRM User Management 
Framework

No Oracle CRM Technology Foundation Implementation Guide

Set up Service Request No Oracle iSupport Implementation Guide, Chapter 7, Integrating Oracle 
iSupport with Service Request

Oracle Support Implementation Guide

Set up Products and Returns No Oracle iSupport Implementation Guide, Chapter 8, Integrating Oracle 
iSupport with Products and Returns

Set up Knowledge Base 
Applications

No Oracle iSupport Implementation Guide, Chapter 9, Integrating Oracle 
iSupport with Oracle Knowledge Management

Set up Oracle iSupport Forums No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Set up Oracle iSupport 
Surveys/Feedback

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Set up Oracle iSupport Web 
Call-Back

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks
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Set up Oracle Contracts 
Applications

No Oracle iSupport Implementation Guide, Chapter 5, Implementation 
Tasks

Oracle Contracts Core Concepts and Procedures

Oracle Contracts for Service Concepts and Procedures

Set up Oracle Customer Care No Oracle Customer Care Implementation Guide

Verify the Implementation No Oracle iSupport Implementation Guide, Chapter 6, Verifying the 
Implementation

Table 4–1 Oracle iSupport Implementation Steps

Step Required? Related Documentation
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Implementation Tasks

This topic group provides step-by-step implementation tasks for setting up Oracle 
iSupport 11i (11.5.6). Topics include:

■ Installing the Application

■ Confirming General Oracle Applications Setups

■ Performing System Administration Setups

■ Setting up Oracle Workflow

■ Setting up Oracle CRM Foundation

■ Setting up iSupport Users

■ Setting up iSupport Homepage

■ Setting up Oracle CRM User Management Framework

■ Setting up Service Request

■ Setting up Products and Returns

■ Setting up Knowledge Base Applications

■ Setting up iSupport Forums

■ Setting up iSupport Surveys

■ Setting up iSupport Web Call-Back (Call Me)

■ Setting up Oracle Contracts Applications

■ Setting up Oracle Customer Care

■ Verifying the Implementation
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5.1 Installing the Application
Oracle is strongly encouraging all applications customers to install the latest 11i CD 
Pack or upgrade to the latest Maintenance Pack. The Maintenance Pack is a 
consolidation of product minipacks. Customers wishing to upgrade their pre-11.5.6 
applications may upgrade to version 11.5.6 by applying the Maintenance Pack. 

To obtain the Maintenance Pack, go to the Oracle MetaLink homepage and click on 
Patches (left hand menu), enter patch number 1808429 in the Patch Number box, 
select your platform in the Platform box, and press the Submit button. 

Customers who are upgrading from an earlier version of applications (R10.7 or R11 
for example) or conducting a fresh installation of the applications should order the 
latest Release 11i CD Pack from Oracle Store (http://store.oracle.com).

As with any maintenance pack, you may need to apply additional individual 
product patches in order to bring your applications to the latest code. Please 
continue to check for high-priority patches for your product areas via the Patches 
button on the MetaLink homepage. 

Oracle iSupport 11.5.6 will be available on the Oracle CD Pack and on Oracle 
MetaLink (http://metalink.oracle.com). 

Please be sure to download the latest copy of the Release Notes, Installation Update 
Notes for your platform and RapidWiz prior to beginning your install or upgrade. 

5.1.1 Running Rapid Install
Rapid Install (RapidWiz) helps you install a complete set of Oracle Applications 
products at the latest available maintenance pack level. It installs the required 
technology stack and creates the Oracle Applications database. You can use Rapid 
Install to install any of three environments: a production installation, a test 
installation, and an installation of the Vision Demo database. In addition, Rapid 
Install lets you license products, country-specific functionality, and languages.

Note: On the screens that tell RapidWiz where to store 
files/directories, do not press Ctrl + V (paste) with an empty 
clipboard. Be sure your clipboard has some data stored on it   
before pressing Ctrl + V, or you will receive an error, 
Java.lang.NullPointerException. (The command in Windows for 
copying text to the clipboard is Ctrl + C.)
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Rapid Install stores the parameters you choose in a configuration file, and then uses 
that file as a road map to perform the installation or upgrade. It installs all 
necessary components, and then sets up your database listeners, web listener, web 
server, Forms server, and Reports server.

In a single-node installation, all servers (database, concurrent processing, forms, and 
web) are installed on a single node. This type of installation is generally used for 
smaller installations and for demonstration purposes. In a two-node installation, one 
node contains the database server, concurrent processing server, and reports server, 
and another node contains the forms server and the web server. A multi-node 
installation sets up any combination of servers you specify, on any number of 
nodes. This type of installation provides the most scalability. 

For more information on Rapid Install, see the latest version of Installing Oracle 
Applications and Upgrading Oracle Applications.

5.1.2 Using the Oracle Application Implementation Wizard
Use the Oracle Application Implementation Wizard (AIW) to coordinate 
dependency setups and identify the steps required to implement the Oracle 
iSupport. You can use AIW to see the graphical overview of the steps involved, read 
online help on set up and open the appropriate forms. You can also document your 
actions for further reference and review. 

The Wizard detects the products installed on your implementation site and displays 
all the processes you need to run in the correct order. You can locate specific 
processes and corresponding task assignments using a variety of flexible selection 
criteria. Once you are in a task, you are automatically routed from step to step.

The processes guide you through the specific implementation steps required for 
your installation. The sequence of steps are contingent on which application 
modules you install. This structure reduces complexities introduced when you must 
implement multiple application modules that have the same setup steps.

As you proceed through the implementation processes, you are able to document 
the completion of setup steps and append notes for later recall. Additionally, the 
Wizard provides guidance, such as instructions, options, warnings, and alerts to 
help with key decision making.

Refer to Oracle Application Implementation Wizard User’s Guide for more details.
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5.2 Confirming General Oracle Applications Setups
Your setup steps for Oracle iSupport will depend upon whether you are creating a 
fresh install of Oracle Applications or upgrading to the current release from a 
previous release. The steps in this section are confirming setups of applications that 
all Oracle applications depend upon. 

On Oracle MetaLink, the Oracle Applications Installations and Upgrade Self-Service 
Toolkit page contains information on the top subjects for Oracle applications 
installations. You will find the latest patchset information in addition to the 
following:

■ Current Issues (alerts and selected articles) 

■ Patches (specific patches related to the subject) 

■ Setup and Usage (white papers and setup instructions for the subject) 

■ FAQ (Frequently Asked Questions) 

■ Troubleshooting (troubleshooting guide for the subject) 

After logging into MetaLink (http://metalink.oracle.com), navigate to the 
Self-Service Toolkit page as follows: 

Technical Libraries > ERP Applications > Applications Installation and Upgrade. 

5.2.1 Confirming Oracle Trading Community (TCA) Setup
Ensure the set up of the following in Oracle Trading Community Model (TCA):

■ Parties

■ Party Relationships

■ Locations

■ Contact Points

■ Customer Attributes

Refer to current Trading Community Model documentation for additional details.

5.2.2 Confirming Accounts Receivable Setup
Confirm the setup of Oracle Accounts Receivable.

Refer to Oracle Accounts Receivable documentation, available on Oracle MetaLink 
under the Technical Library > Financials > Receivables.
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5.2.3 Defining Employees
Define or confirm the definitions of your employees in Oracle Human Resources 
Management System or another HR application.

For Oracle Human Resources Management System documentation, refer to the 
following titles available on MetaLink:

■ Implementing Oracle HRMS

■ Using Oracle HRMS - The Fundamentals

■ Managing People Using Oracle HRMS

■ Customizing, Reporting and System Administration in Oracle HRMS

■ Managing Total Compensation Using Oracle HRMS

5.2.4 Confirming CRM Foundation Technology Stack Setup
Confirm the setup of the technology stack. Refer to CRM Foundation Technology 
Stack documentation, available on MetaLink. The CRM Foundation Technology 
stack is also known as the HTML Stack or Tech Stack.

5.3 Performing System Administration Setups
The merchant implementing Oracle iSupport will receive a system administrator 
login and will use that login in the setup of the application. The system 
administrator username and password that are seeded are: sysadmin/sysadmin. It 
is recommended that you change this password to something unique.

Some of the setups listed here are optional. Refer to the text for details.

5.3.1 Confirm Menus/Functions Setup
The menus on the Oracle iSupport HTML UI are seeded in AOL. They are linked to 
the seeded Functions in AOL. It is optional to confirm the setup of menus and 
functions. 

For a list of seeded menus and functions in Oracle iSupport, see the appendix, 
Oracle iSupport Seed Data.

5.3.1.1 Confirm Functions
Functions link to coding within specific JSPs and to application menus. Those 
necessary for Oracle iSupport are seeded in AOL. To view Functions in AOL, log 
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into the Oracle Forms application as sysadmin and navigate to System 
Administrator > Application > Function. From there, query for function names that 
begin with IBU_.

5.3.1.2 Confirm iSupport Menus
Each menu in Oracle iSupport links to a Function. Confirming Menus is not 
mandatory. To view Menus in AOL, log into the Oracle Forms application as 
sysadmin and navigate to System Administrator > Application > Menus. From 
there, query for menu names that begin with IBU_.

For additional information, see the Oracle Applications System Administrator’s Guide.

5.3.2 Understanding Responsibilities and Roles
Responsibilities are defined for application security and determine which menus a 
user will see. Roles are collections of permissions which allow users to perform 
various functions. Roles and responsibilities must be assigned to usernames to be 
effective. 

If you are using the CRM User Management Framework for user setup, 
responsibilities and roles are seeded within each User Type. As each user is 
approved, the default roles and responsibilities that are assigned will depend upon 
your setup of the user framework. Refer to the CRM Technology Foundation 
Implementation Guide for more information on what is seeded by user type, and how 
to customize user types. 

The Oracle iSupport module has its own seeded responsibilities and roles that you 
can use in addition to or in place of the user framework. Setup steps for creating 
users are in the Setting up Oracle iSupport Users section. Refer to the Seed Data 
appendix for Oracle iSupport roles and responsibilities that ship with the 
application.

Refer to AOL documentation for information on how to set up new responsibilities, 
roles, and permissions, or to customize existing ones.

5.3.3 Set up Profile Options
Profile options are seeded within all Oracle applications, and each module has its 
own specific set of profile options. Although all profile options are seeded, there are 
some settings that must be performed by sysadmin. See the appendix, Profile 
Options, for details.
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5.3.4 Set up Properties
There are two sets of key components for Oracle iSupport that must be set. These 
are:

■ Company key components

■ Quick Find window key components 

Steps
1. Log in to the JTF UI as sysadmin/sysadmin.

2. Navigate to Settings > System > Advanced. Select Oracle iSupport’s product 
code, IBU, from the View drop list.

3. Set the following company key components to appropriate values: 

■ COMPANY_ADDRESS

■ COMPANY_EMAIL ADDRESS

■ COMPANY MERCHANT_NAME

■ COMPANY_NAME

■ COMPANY_URL

4. To confirm the set up the Quick Find window items, verify that the 
search.factories component is set to: 

■ oracle.apps.ibu.requests.bean.RequestSearchFactory

5. Next, verify that the Quick Find window key components are set according to 
what your business processes require. Remove any items which you do not 
wish to use

■ When deleting items, be sure to remove the pairs of items that end in 
.categories and .desc.

Here is an example of what the seeded components will be:

Install Base:

■ service.oracle.apps.cs.inquiries.bean.IBSearchFactory.categories

The value of this component is Install Base.

■ service.oracle.apps.cs.inquiries.bean.IBSearchFactory.desc

The value of this component is IBSearch.item.
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Forums:

■ service.oracle.apps.ibu.communities.bean.MyForumSearchFactory.categories

The value of this component is Forums.

■ service.oracle.apps.ibu.communities.bean.MyForumSearchFactory.desc

The value of this component is MyForumSearch.item.

Knowledge Management:

■ service.oracle.apps.ibu.knowledge.bean.SMSSearchFactory.categories

The value of this component is Solutions.

■ service.oracle.apps.ibu.knowledge.bean.SMSSearchFactory.desc

The value of this component is SMSSearch.item.

Marketing Encyclopedia System (MES):

■ service.oracle.apps.ibu.knowledge.bean.TechLibSearchFactory.categories

The value of this component is Library.

■ service.oracle.apps.ibu.knowledge.bean.TechLibSearchFactory.desc

The value of this component is TechLibSearch.item.

Service Request:

■ service.oracle.apps.ibu.knowledge.bean.RequestSearchFactory.categories

The value of this component is Service Requests;

■ service.oracle.apps.ibu.knowledge.bean.RequestSearchFactory.desc

The value of this component is RequestSearch.item.

5.4 Setting up Oracle Workflow
See the chapter in this guide, Integrating Oracle iSupport with Oracle Workflow, or refer 
to Oracle Workflow Guide.

5.5 Setting up CRM Foundation
Set up and/or confirm the setup of the CRM Foundation software suite. Oracle 
iSupport service request functionality uses the Notes, Resources, and Assignment 
Manager modules. Oracle Knowledge Management functionality also uses Notes 
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and Resources. Thus, at a minimum, you should be familiar with the setup and 
functionality of Notes, Resources, and Assignment Manager. For information on the 
Oracle iSupport-specific setups related to these modules, see these chapters:

■ Integrating Oracle iSupport with Service Request

■ Integrating Oracle iSupport with Oracle Knowledge Management 

Refer to CRM Application Foundation Implementation Guide for full implementation 
details.

5.6 Setting up iSupport Users
In Release 11.5.6, Oracle iSupport has uptaken the new Oracle CRM User 
Management Framework. Since Oracle iSupport also has its own user 
responsibilities and roles, this section contains information on setting up Oracle 
iSupport users exclusive of the new framework. See Setting up Oracle CRM User 
Management Framework for more information on its functionality.

5.6.1 Set up Oracle iSupport Administrator
The merchant implementing Oracle iSupport will use the sysadmin login to set up 
the Oracle iSupport Administrator. This is a required user, and is not one of the 
seeded user types within the CRM User Management Framework. 

The Oracle iSupport Administrator responsibility -- IBU_NORMAL_USER -- is 
seeded in AOL.

The menu assigned to this responsibility is called iSupport Administration Root 
(IBU_NORMAL_USER_TOP_MENU). See Oracle Applications System Administrator’s 
Guide for more information on building menus and creating responsibilities.

The Oracle iSupport Administrator typically performs routine but high-level 
administrative tasks, such as:

■ Setting up users and assigning appropriate roles and responsibilities

■ Setting up the application homepage

■ Setting up optional service request functionality

■ Setting up optional products and returns modules

■ Setting up optional knowledge management modules

■ Setting up optional accounts functionality
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■ Setting up iSupport forums

■ Setting up iSupport Call Me (web call-back)

■ Setting up iSupport Surveys/Feedback feature

Oracle iSupport Administrator functions are accessible by using the Oracle iSupport 
Administrator username and password on the JTF login page, and then selecting 
the Administration button in the top-right of the screen.

5.6.1.1 Steps to Set up Oracle iSupport Administrator
Follow the steps below to set up the Oracle iSupport Administrator.

Prerequisite:
Employees have been defined using Oracle Human Resources Management System 
or another human resources application. For Oracle HRMS documentation, refer to 
the following titles available on MetaLink:

■ Implementing Oracle HRMS

■ Using Oracle HRMS - The Fundamentals

■ Managing People Using Oracle HRMS

■ Customizing, Reporting and System Administration in Oracle HRMS

■ Managing Total Compensation Using Oracle HRMS

Associate User Name to Employee and Assign Responsibility
1. Log in to Oracle Forms application as sysadmin. Select System Administrator 

responsibility. Navigate to Security > Users > Define. The Users window opens.

2. In the Users form, enter the username for the Oracle iSupport Administrator. 
An example might be IBUADMIN. (IBU is the product code for Oracle 
iSupport.)

3. Associate the user with an employee by using the Person LOV in the User 
Form. Select the desired association by double-clicking on the employee name.

4. Tab to Password field and enter a password. Tab to clear the field and re-enter 
the same password to validate.

5. In the Responsibilities tab, select the IBU_NORMAL_USER responsibility.  

6. Save changes.

7. Still using System Administrator responsibility, navigate to Profile > System. 
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8. Query with the username in the username field and JTF%DEF% in the Profile 
field.

9. Set the following profile option at the user level for the administrator:

■ JTF_PROFILE_DEFAULT_APPLICATION - 672

This tells the system that the default application for this user is Oracle iSupport, 
whose application ID is 672.

10. Find the responsibility ID for the IBU_NORMAL_USER responsibility (see steps 
below) and enter that value as the JTF_PROFILE_DEFAULT_
RESPONSIBILITY value. Set at user level. 

This tells the system that the default responsibility for this user is IBU_
NORMAL_USER.

5.6.1.2 Finding Responsibility ID
Use the following steps to find the RESPONSIBILITY_ID value of a 
responsibility. See the Profile Options appendix for details on determining 
APPLICATION_ID values -- The application ID is used when setting system 
profile values.

a. In Oracle Forms as System Administrator, navigate to Security > 
Responsibility > Define. The Responsibilities form opens.

b. From the top menu, select View > Find. Search for the IBU_NORMAL_
USER responsibility. Once found, highlight the responsibility, and click Ok 
in the search window. The Responsibilities form is populated with the 
information for the responsibility.

c. With the cursor in any field of the record, select Help > Diagnostics > 
Examine. The Examine Field and Variable Values form opens.

d. In the Examine Field and Variable Values form, select RESPONSIBILITY_ID 
from the Field LOV. The Value field displays the value of 
RESPONSIBILITY_ID.

11. Save and close the form.

Approval
1. Log in to the JTF login page as sysadmin. Navigate to Users > Registration > 

Pending Approvals. 

2. In the Request Summary screen, select the appropriate underlined username.
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3. Fill in the mandatory information. Click Next.

4. Select the Accounts button. Choose the company account(s) to associate with 
the user. Select Next.

5. Enter any comments in the Comments area. Click Accept.

Assign Role(s)
1. Navigate to Users > Registration > User Maintenance.

2. Find the user who will be the Oracle iSupport Administrator. Select the 
underlined hyperlink of the username. 

3. Select Roles. Assign IBU_SYSTEM_ADMIN and IBU_REG_USER to the user.

4. Select Update.

5. Log out.

Verification
1. Log in to the JTF login as the Oracle iSupport Administrator just created.

2. Verify that appropriate menus are displayed. The Oracle iSupport 
Administrator will have the following main tabs on the UI: 

■ Home

■ Accounts (subtabs: Orders, Invoices, Payments, Contracts, Returns, Service 
Requests)

■ Products

■ Support (subtabs: Ask Me, View/Update Requests, Create Request, Call 
Me, Survey)

■ Forum

3. Under the Profile button, the Oracle iSupport Administrator will have access to 
the following links:

User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Preferences
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■ Accounts

■ Support

4. Select the Administration button at the top of the screen. Verify that the Oracle 
iSupport Administrator can access the following administrator tabs:

■ User (subtabs: User, Pending Approvals)

■ Homepage (subtabs: Content, Subscription)

■ Support (subtabs: Request Management, Call Me, Survey, Technical Library, 
Usergroup)

■ Forum (subtabs: Category, Forum, Messages, Usergroup)

■ Solutions (subtabs: Setup, Solution, Search)

5.6.2 Steps to Assign Additional Roles and Responsibilities in iSupport
After you have set up the Oracle iSupport Administrator, you can use that user to 
assign additional responsibilities and/or roles to users. 

Remember, as a CRM User Management Framework User Type is approved, the 
system automatically will give those users a default role(s) and a default 
responsibility. Which roles and responsibilities are granted depends upon how you 
have configured the user management framework, including what roles and 
responsibilities are linked to the User Type and Enrollment selected during 
registration. 

If you are creating custom users or if you need to assign additional responsibilities 
or roles to users, use the following steps:

1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Administration > Users. Search for the user whom you wish to 
modify.

3. Select the underlined link of the username.

4. In the User Details screen, select either Roles or Responsibilities as appropriate.

5. Assign the roles/responsibilities as desired. If you assign additional 
responsibilities, be sure to select a default responsibility.
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5.6.3 Set up iSupport Primary User
The Oracle iSupport Primary User typically:

■ Approves other users within his party/organization

■ Adds/modifies responsibilities to users within his party/organization

■ Adds/modifies roles to users within his party/organization

The primary user can be approved by another primary user with the same 
responsibility as that of an Oracle iSupport Primary User for the party 
(organization) to which the primary user belongs, or by the Oracle iSupport 
Administrator.

Steps to Set up iSupport Primary User
Follow the steps below to set up the Oracle iSupport Primary User.

Registration
1. Select the Register Here link on the JTF login. Or, have the user self-register 

using the Register Here link.

Note: If you have already set up this user through the Oracle Forms interface, 
Oracle Human Resources Management System (HRMS), or your company’s 
own HR application, you may skip the Registration step. Instead, associate an 
employee to a user name in the Forms application (as you did with the 
administrator-user) and assign the IBU_PRIMARY_USER_RESP responsibility 
there.

2. Select Primary User as the user type; click Next.

3. Enter the company ID in the textbox and Submit. The company ID is a unique 
number assigned during company registration. The User Registration screen 
appears. 

4. Enter required information on the User Registration form. Make a note of the 
username and password. Select Submit. The Available Enrollments screen 
appears.

Note: The default responsibility that is active at the time a user 
logs in to the JTF login will determine which application he initially 
accesses. The user can change this default by accessing the Profile > 
Preferences menu in Oracle iSupport.
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5. Select Self-Service Support Over the Web and click Next. 

Note: The Enrollments screen brings in the CRM User Management 
Framework. The default roles and responsibilities linked to the Self-Service 
Support Over the Web enrollment will be assigned to this user upon approval. 
See the topic, Seeded Self-Service Support Over the Web Enrollment, for default 
roles and responsibilities that are seeded by user type for this enrollment.

6. A confirmation message appears. Click Next. 

Approval
1. Log in to the JTF login page as sysadmin. 

Note: It is possible to set up a user other than sysadmin to be the approver. 
Consult the Oracle CRM Technology Foundation Implementation Guide and the 
Oracle CRM Technology Foundation Concepts and Procedures for details.

2. Navigate to Users > Registration > Pending Approvals. 

3. In the Request Summary screen, select the appropriate underlined username.

4. Fill in the mandatory information. Click Next.

5. Select the Accounts button. Choose the company account(s) to associate with 
the user. Select Next.

6. Enter any comments in the Comments area. Click Accept.

Verification
1. At the JTF login page, log in as the Primary User just created.

2. Verify that appropriate menus are displayed. The Primary User will have access 
to the following main tabs on the UI: 

■ Home

■ Accounts (subtabs: Orders, Invoices, Payments, Contracts, Returns, Service 
Requests)

■ Products

■ Support (subtabs: Ask Me, View/Update Requests, Create Request, Call 
Me, Survey)

■ Forum

3. Under the Profile button, the Primary User will have access to the following 
links:
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User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Preferences

■ Accounts

■ Support

Company Profile:

■ Information

■ Contact Points

■ Addresses

■ Administrators

4. Select the Administration button at the top of the screen. Verify that the Primary 
User can access the following administrator tabs:

■ User

■ Pending Approvals

5.6.4 Set up Employee User
This type of user is an employee of the merchant using Oracle iSupport. This user is 
set up through the Forms interface and approved by the Oracle iSupport 
Administrator or the Primary User for the Employee User’s organization.

5.6.4.1 Steps to Set up Employee User
Follow the steps below to set up this user.

Prerequisite:
Employees have been defined using Oracle Human Resources Management System 
or another HR application. For Oracle HRMS documentation, refer to the following 
titles available on MetaLink:

■ Implementing Oracle HRMS

■ Using Oracle HRMS - The Fundamentals
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■ Managing People Using Oracle HRMS

■ Customizing, Reporting and System Administration in Oracle HRMS

■ Managing Total Compensation Using Oracle HRMS

Steps
1. Log into Oracle Forms application as sysadmin. Select System Administrator 

responsibility.

2. Navigate to Security > User > Define. The Users form appears.

3. Enter a Username for the user. For example, you could use the first initial and 
last name of the employee.

4. On the User form, associate the new username with an employee: Click in the 
Person field on the User form. Search for the employee by clicking on the LOV 
field [...}, entering a partial value and clicking Find. Select the employee by 
double-clicking on the employee name.

5. In the Password field, enter a password for the username. Use the Tab key to 
clear the Password field, and then re-enter the password to validate.

6. If desired, limit the number of days this password will be valid by entering a 
value in days in either the Accesses or Days fields. The user will be prompted to 
change this password after x number of days/accesses (where x represents the 
value you entered in the Days field or Accesses field). If you select None, the 
user will not be required to change the password.

7. In the Responsibility tab, click in the Responsibility field. Select the LOV {...} 
that displays and enter IBU% to query for IBU responsibilities.

8. Double-click the IBU_EMPLOYEE_USER_RESP responsibility.

9. Under Effective Dates, enter an the effective date in the From field. If desired, 
enter an end-date for the user in the To field. Leave the To field blank to create 
the user with no end-date.

10. Save and close the form.

Assign Role(s) and Default Responsibility
1. Log in to the JTF login page as Oracle iSupport Administrator. Navigate to 

Administration > User.

2. Search for the user. Once you find the user, select the underlined hyperlink of 
the username. The Personal Profile page displays.
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3. Select Roles. Assign IBU_REG_USER and IBU_EMPLOYEE to the employee.

4. Save your work.

5. Return to the Personal Profile page. Select Responsibilities and assign the IBU_
EMPLOYEE_USER_RESP as the default responsibility for this user.

6. Save your work.

Verification
1. At the JTF login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The Employee User will have the 
following main tabs on the UI: 

■ Home

■ Support (subtabs: Ask Me, View/Update Requests, and Create Request)

■ Forum

3. Under the Profile button, the Employee User will have access to the following 
links:

User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Preferences

■ Accounts

■ Support

5.6.5 Set up Business (B2B) User
B2B (business users) are generally customers who have accounts on the merchant, 
and are no associated with the merchant’s company. These users will select the 
Register Here link on the JTF login page to register. 

Note: When setting up new users of the Install Base functionality, 
please add the role, CSI_END_USER, to them. This role contains 
the required permissions for Install Base general users.
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5.6.5.1 Steps to Set up B2B User
Follow the steps below to set up this user.

Registration
1. Select the Register Here link on the JTF login. Or, have the user self-register 

using the Register Here link.

2. Select Business User from the list of User Types. Click Next.

3. Enter the company ID in the textbox and Submit. The company ID is a unique 
number assigned during company registration. 

4. Enter required information on the User Registration form. Make a note of the 
username and password. Select Next. The Available Enrollments screen 
appears.

5. In the Enrollments screen, select Self-Service Support Over the Web and click 
Next. A confirmation message appears. Click Next.

Approval
1. Log in to the JTF login page as sysadmin. Navigate to Users > Registration > 

Pending Approvals. 

2. In the Request Summary screen, select the appropriate underlined username.

3. Fill in the mandatory information. Click Next.

4. Select the Accounts button. Choose the company account(s) to associate with 
the user. Select Next.

5. Enter any comments in the Comments area. Click Accept.

Verification
1. At the JTF login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The B2B User will have the 
following main tabs on the UI: 

■ Home

Note: When setting up new users of the Install Base functionality, 
please add the role, CSI_END_USER to them. This role contains the 
required permissions for Install Base general users.
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■ Accounts (subtabs: Orders, Invoices, Payments, Contracts, Returns, Service 
Requests)

■ Products

■ Support (subtabs: Ask Me, View/Update Requests, Create Request, Call 
Me, Survey)

■ Forum

3. Under the Profile button, the B2B User will have access to the following links:

User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Preferences

■ Accounts

■ Support

Company Profile:

■ Information

■ Contact Points

■ Addresses

■ Administrators

5.6.6 Set up Individual (B2C) User
The B2C (individual users) is typically an individual person with no relationship to 
the organization using Oracle iSupport. B2C users will normally be self-registering 
over the Internet, using the Register Here link on the JTF login page.

A B2C user’s seeded approval process in the CRM User Management Framework is 
automatic. B2C users thus will be able to access the application immediately after 
registering, unless you set up a separate approval process. Consult the Oracle CRM 
Technology Foundation Implementation Guide for more details.

5.6.6.1 Steps to Set up B2C User
Follow the steps below to set up this user.
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Registration
1. Select the Register Here link on the JTF login. In the list of available user types, 

select Individual User. Click Next.

2. Enter required information on the User Registration form. Make a note of the 
username and password. Select Submit. The Available Enrollments screen 
appears.

3. Select Self-Service Support Over the Web and click Next. A confirmation 
message appears. 

Verification
1. At the JTF login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The B2C User will have the 
following main tabs on the UI: 

■ Home

■ Accounts (subtabs: Orders, Invoices, Payments, Contracts, Returns, Service 
Requests)

■ Products

■ Support (subtabs: Ask Me, View/Update Requests, Create Request, Call 
Me, Survey)

■ Forum

3. Under the Profile button, the Employee User will have access to the following 
links:

User Profile:

■ Personal Profile

■ Contact Points

■ Addresses

■ Preferences

■ Accounts

■ Support
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5.6.7 Set up Knowledge Management Administrator-User
This is an administrator-user who performs Oracle Knowledge Management setup 
and management. This user is required only if the merchant will use the Knowledge 
Management functionality. For more information, see the chapter in this guide, 
Integrating Oracle iSupport with Oracle Knowledge Management.

5.6.8 Set up Survey Administrator-User
This is a user who performs Surveys setup and management. This User Type is not 
seeded in the JTT user management framework. This user is required only if the 
merchant will use Surveys. For more information, see the Setting up iSupport 
Surveys topic of this chapter.

5.7 Setting up iSupport Homepage
The Homepage is a work screen and the application landing page for the user. Here, 
users can store service request and knowledge base bookmarks, as well as receive 
system alerts and other data that the merchant chooses to display. Options for 
Homepage setup include:

■ Use default settings shipped with the application (some basic setups are 
required).

■ Add bins from a pre-defined selection that ships with the application.

■ Add content from Oracle Marketing Encyclopedia System (MES).

■ Disable content.

■ Make content a required item (mandatory) on UI.

■ Change display of mandatory content on UI.

Oracle iSupport does not currently support custom bins based on PL/SQL 
procedures and/or Java objects. The sections that follow discuss Homepage 
options.

5.7.1 Add MES Content to Homepage
Oracle Marketing Encyclopedia System (MES) can supply the functionality to 
provide bin content on the Homepage. Examples include Alerts and Company 
News bins. You can also publish other types of information in MES and select it as 
Homepage content in Oracle iSupport. 
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Prerequisites
■ Set up MES.

■ Publish content within MES.

■ Run MES concurrent programs.

■ Verify MES setup.

See Oracle Marketing Encyclopedia System Implementation Guide and Oracle Marketing 
Encyclopedia System Concepts and Procedures for details.

Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content > Add MES Content 
(bottom of screen).

3. In the Add MES Content screen, the content you have published in MES will 
display. Select the content that you wish to add by activating the appropriate 
checkbox. 

4. Select Save. The Content Administration screen appears.

5. Navigate to the Home tab on the general user UI to verify that the content 
displays on the page.

5.7.2 Understanding the Add/Update Content Page
The Add/Update Content page allows you to:

■ Set content as mandatory.

■ Disable existing content.

5.7.2.1 Setting Homepage Content as Mandatory
You can set information on the homepage as mandatory. Mandatory content has the 
following characteristics:

■ Cannot be disabled by users.

■ Always displays at the top of the column which it is in.

■ Can be displayed as wide-format or narrow-format.

Follow the steps below to change content to mandatory and choose its layout.
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Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. The Content 
Administration screen appears.

3. Select the underlined hyperlink of the content you wish to make mandatory. 
The Update Content screen appears.

4. In the Update Content screen, place a checkmark in the Mandatory checkbox.

5. Select Update.

5.7.2.2 Disabling Homepage Content
Follow the steps below to disable homepage content and make it inaccessible to all 
but the Oracle iSupport Administrator.

Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. The Content 
Administration screen appears.

3. Select the underlined hyperlink of the content you wish to disable. The Update 
Content screen appears.

4. In the Update Content screen, place a checkmark in the Disable checkbox.

5. Select Update.

5.7.3 Changing Mandatory Bin Layout/Display
If you have more than one mandatory homepage content item and wish to change 
the order of the bins, follow the steps below to do so.

Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content > Mandatory Layout.

3. Select and arrange content as desired, using the right (>) and left (<) arrow 
buttons to move content from two to three column layout. 

4. To arrange content vertically in a column, select content and click the up or 
down arrow buttons to set the order.
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5. Select Update to save changes.

5.7.4 Enabling Homepage Subscription E-Mails
The Subscription E-Mails feature of Oracle iSupport allows users to receive 
Homepage content in e-mail form. This can be useful if a user is unable to access the 
Homepage for a period of time. Set up of this feature includes: 

■ Set up template.

■ Run necessary concurrent programs.

Prerequisites
■ The e-mail subscription feature must be activated for the user who is to receive 

the e-mails. Navigate to Profile > Support; select content and delivery days as 
desired.

■ You must be running Oracle Workflow to enable this feature. For more 
information, refer to the chapter in this guide, Integrating Oracle iSupport with 
Oracle Workflow.

5.7.4.1 Setting up E-Mail Subscription Templates
Setting up the e-mail template allows you to control the framework for the e-mail 
that is delivered to a user. 

Steps
1. Log in to the JTF login as Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Subscription. The Subscription 
Template Administration screen displays.

3. In the Subject text field, enter the text to display as the subject of the e-mail that 
will be sent to the user.

4. In the Header and Footer fields, enter the information you wish to display in 
the header (top) and/or footer (bottom) area of the template. 

Use the Clue Word/Description table (copy and paste as desired) at the bottom 
of the screen to build the header and footer text. 

5. Optionally, select Preview to see how the framework will appear to the user.

6. To save changes, select Update. A confirmation message displays.
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5.7.4.2 Running Concurrent Programs
In Oracle (Forms) Applications, run the Notification Mailer and Message Delivery 
Scheduler concurrent programs. See Oracle Applications Concepts Release 11i for more 
information on running concurrent programs. For more information on Oracle 
Workflow, see the chapter in this guide, Integrating Oracle iSupport with Oracle 
Workflow. You should also consult the Oracle Workflow User’s Guide. 

5.8 Setting up CRM User Management Framework
The Oracle CRM User Management Framework consists of enrollments 
(subscription services), approval processes, registration templates, and user types. 
These components provide a flexible framework for user creation, approval, 
management, and information gathering.

The user management framework is an optional but recommended integration for 
your organization. While the framework will be installed automatically when you 
install CRM Foundation modules, there are some setups you will need to perform. 

The information in this section is meant to give you an overview of the user 
management framework concepts. Consult the Oracle CRM Technology Foundation 
Implementation Guide and the Oracle CRM Technology Foundation Concepts and 
Procedures for more details.

5.8.1 Setting up Enrollments (Subscription Services)
Enrollments are application-specific subscription services at the user level. They 
reference the registration templates, roles, and responsibilities that are tied to user 
types. Enrollments are of two basic types:

■ Implicit - Implicit enrollments are services that the user receives automatically 
during the registration process. 

■ Explicit - Explicit enrollments are services that users select during registration 
following their selection of user type.

One enrollment can equal: 

■ 0 or 1 responsibility - You can link no more than one responsibility to an 
enrollment.

■ 0 or 1 template - You can link no more than one registration template to an 
enrollment.

■ 0 or 1 workflow - You can link no more than one workflow process to an 
enrollment.
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■ 0 or more roles - You can link any number of roles to an enrollment.

5.8.1.1 Seeded Self-Service Support Over the Web Enrollment
The enrollment tied to Oracle iSupport is called the Self-Service Support Over the 
Web Enrollment. It is seeded within the CRM User Management Framework.

The table below, Self-Service Support Over the Web Enrollment Responsibilities, 
lists seeded responsibilities and corresponding Oracle iSupport user types for the 
Self-Service Support Over the Web Enrollment. 

The table below, Self-Service Support Over the Web Enrollment Roles, lists seeded 
roles and corresponding Oracle iSupport user types for the Self-Service Support 
Over the Web Enrollment.

5.8.1.2 Modifying Seeded Enrollments
The seeded enrollments can be modified, and you can also create new enrollments. 
Consult the Oracle CRM Technology Foundation Implementation Guide and the Oracle 
CRM Technology Foundation Concepts and Procedures for details.

5.8.2 Setting up Registration Templates
Applications require different pieces of information to register various user types. 
Registration of a sales representative might require the sales territory, while a 
consumer registration would need to include the credit card number. Registration 

Table 5–1 Self-Service Support Over the Web Enrollment Responsibilities

Responsibility Description

IBU_INDIVIDUAL USER_RESP Individual User (B2C)

IBU_PRIMARY_USER_RESP Primary User

IBU_BUSINESS_USER_RESP Business User (B2B)

Table 5–2 Self-Service Support Over the Web Enrollment Roles

Role Description

IBU_REG_USER Individual User (B2C) or Business 
User (B2B)

IBU_B2B_PRIMARY_USER_
MANAGEMENT and IBU_REG_USER

Primary User
Implementation Tasks 5-27



Setting up CRM User Management Framework
data is being stored in different tables - some is common data and is stored (mostly) 
in the Trading Community Architecture (TCA); the rest is stored into 
application-specific tables. 

Registration templates, which can be one JSP or multiple pages, accommodate these 
information-gathering requirements. The registration pages rendered to a user will 
depend on the user type and the services/enrollments the user is subscribing to. 
Registration templates refer to JSP files that are used to capture the registration 
information that is particular to a User Type.

Characteristics of registration templates include:

■ JSPs associated to a template handler to execute the logic on data captured 
through JSP pages

■ Can be tied to enrollments

■ Are set up by the application administrator during implementation

■ Can consist of one page or many

5.8.2.1 Defining New Registration Templates
New registration templates can be created using the JTF sysadmin console. Consult 
the Oracle CRM Technology Foundation Implementation Guide and the Oracle CRM 
Technology Foundation Concepts and Procedures for details.

5.8.3 Setting up Approval Processes
Approval is a step in the registration process whereby users and/or their 
enrollments are confirmed by an approving authority. Once the approval process is 
completed, the system automatically grants the appropriate default role(s) and 
responsibility (based on User Type and/or Enrollments) that allow access to the 
application.

The approval process uses Oracle Workflow to track and route the request (via an 
e-mail message) to each approver set up in the approval definition. The e-mail 
informs the approvers of the request type (user type or enrollment) and what action 
is required.

5.8.3.1 Seeded JTF Approval Processes
User Type seeded approval processes are:

■ Individual User - No approval required

■ Business User - Approval notification sent to Primary User(s)
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■ Primary User - Approval notification sent to Oracle iSupport Administrator, or 
System Administrator

5.8.3.2 Who Can Be an Approver?
■ Request Owner - This user is the current approver based on the approver list 

and current state of workflow defined for given approval. The Request Owner 
will only be able to approve the requests that are owned by him. This user 
should have JTF_APPROVER permission.

■ Oracle Applications System Administrator (sysadmin) - The sysadmin will see 
and be able to approve all pending requests. Users who have the JTF_REG_
APPROVAL permission are considered sysadmins. In Release 11.5.6, the Oracle 
iSupport Administrator role (IBU_SYSTEM_ADMIN) has been given the JTF_
REG_APPROVAL permission.

■ Oracle iSupport Administrator - The Oracle iSupport Administrator will see a 
list of pending approvals. Users who have the IBU_SYSTEM_ADMIN role are 
considered to be the Oracle iSupport Administrator.

■ Primary User - This user will be able to view and approve the requests which 
are assigned to the Primary User role, as well as the requests owned by the 
Primary User. The requests assigned to the Primary User role will be filtered 
based on the current approver’s organization. Primary Users need the JTF_
PRIMARY_USER_SUMMARY role to view the pending requests page showing 
their list of users waiting approval. Requests assigned to the Primary User role 
are identified by the JTF_PRIMARY_USER profile option which should be set to 
a predetermined username or an FND dummy user. The name used for the 
Primary User Role needs to be in the approval hierarchy if the primary user is 
needed for approval.

5.8.3.3 Defining a New Approval Process
New approval processes can be defined on the JTF sysadmin console. Consult the 
Oracle CRM Technology Foundation Implementation Guide and the Oracle CRM 
Technology Foundation Concepts and Procedures for details.

5.9 Setting up Service Request
See the chapter, Integrating Oracle iSupport with Service Request.
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5.10 Setting up Products and Returns Applications
See the chapter in this guide, Integrating Oracle iSupport with Products and Returns.

5.11 Setting up Knowledge Base Applications
The following Oracle knowledge base applications integrate with Oracle iSupport:

■ Oracle Knowledge Management

■ Oracle Marketing Encyclopedia System (MES)

MES is also known as the Technical Library.

5.11.1 Setting up Knowledge Management
Set up Oracle Knowledge Management. See the chapter in this guide, Integrating 
Oracle iSupport with Oracle Knowledge Management. 

5.11.2 Setting up Marketing Encyclopedia System
Oracle Marketing Encyclopedia System (MES) is required for technical library 
functionality in Oracle iSupport. It also supplies the Alerts bin content. Refer to 
Marketing Encyclopedia System Implementation Guide for setup details.

5.12 Setting up iSupport Forums
The sections below details steps for setting up Oracle iSupport interactive forums.

5.12.1 Creating Categories
Categories help to organize forums into topic areas. Oracle iSupport allows you to 
set up as many categories as you wish. The steps below describe how to create a 
category.

Steps
1. At the JTF login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Category > Create. The Create New 
Category screen displays.

3. You can choose to have the category exist at the topmost (root) level, or you can 
structure the category to be a sub-category of another category.
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Of course, the very first category that you create will be at the Category Root 
level. Thus, for the first one, leave the Choose a parent category field set to 
Category Root. 

Guidelines for creating additional categories:

■ Leave the drop-down menu set to Root to create a category at the top-most 
level.

■ Select the parent category to create a sub-category within a category.

4. Enter a name for the Category in the Enter the name of the new category field.

5. Select an Access Type. Access type determines who can view the category on 
the UI. Access options are:

Open - All users can view/access.

Restrict - Only members of a usergroup can view/access. For more information, 
see Restricting Access to Categories or Forums.

Close - This option closes the category or forum to all users except the Oracle 
iSupport administrator. It can be utilized as a temporary state for a category or 
forum while the administrator is performing maintenance or setup tasks 
relating to the category or forum. It can also be used to permanently disable a 
category or forum.

6. Select Create. Respond to the confirmation message.

5.12.2 Creating Forums
Forums are focussed topic areas within broader categories. There is no limit to the 
number of forums you can create within any given category or sub-category. Follow 
the steps below to create a forum. 

Steps
1. At the JTF login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Forum > Create. The Create New Forum 
screen displays.

3. From the drop-down list, select the category within which you wish the forum 
to reside.

4. Enter a name for the forum in the Enter forum name field.

5. Select an Access Type:
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Open - All users can view/access.

Restrict - Only members of a usergroup can view/access. For more information, 
see Restricting Access to Categories or Forums.

Close - This option closes the category or forum to all users except the Oracle 
iSupport administrator. It can be utilized as a temporary state for a category or 
forum while the administrator is performing maintenance or setup tasks 
relating to the category or forum. It can also be used to permanently disable a 
category or forum.

6. Select Create. Respond to the confirmation message.

5.12.3 Restricting Access to Categories or Forums
In Oracle iSupport, the administrator has the ability to create categories and forums 
that only members of a usergroup can view and access. 

5.12.3.1 Set Restricted Access on Category or Forum
Use the procedures below to set the Access Type of Restricted on a category or 
forum.

Prerequisite
A category or forum has been created.

Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator. 

2. Navigate to the Forum tab.

3. To change the access type of a category, navigate to Category > Modify Status. 
To change the access type of a forum, navigate to Forum > Modify Status. The 
Modify Access Status page displays for either forums or categories.

Note: Restricted categories and forums will not display to users 
who are not members of the usergroup associated with the 
restricted category/forum. You should inform users of the existence 
and nature of restricted areas so that they can request inclusion in 
them, if appropriate.
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4. In the Modify Access Status page, select the category or forum you wish to 
restrict.

5. In the Choose access type area, select the Restricted radio button. 

6. Select Next or Modify, depending upon which button appears. Respond to the 
confirmation message.

5.12.3.2 Create Usergroup
Follow the steps below to set up a usergroup to associate with the restricted 
category or forum. Only the usernames that are associated with the usergroup will 
be able to view the category or forum.

Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Usergroup > Create.

3. Enter a unique name for the usergroup in the Name field.

4. Select a effective date for the usergroup using the Start Date calendar icon.

5. Select an ending date for the usergroup using the End Date calendar icon. 

You can also end date a usergroup to disable it.

6. Enter a brief description for the usergroup in the Description text field.

7. In the SQL statement field, enter an appropriate SQL statement.

Sample SQL Usergroup Select Statement

select EMPLOYEE_ID from FND_USER where EMPLOYEE_ID > 0

This select statement retrieves all employee IDs greater than zero (i.e., all 
employees) from the fnd_user table.

Note: Usergroup select statements support PARTY_ID and EMPLOYEE_ID, but 
not USER_ID.

8. Select Save.

5.12.3.3 Running Usergroup Creation Program 
To populate necessary tables in the database, run the concurrent program 
Usergroup Creation Program (short name is IBUUG). This concurrent program 
must be run each time you update or add users to a usergroup.
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5.12.3.4 Associate Usergroup to Restricted Category/Forum
Follow the steps below to associate a usergroup with a restricted category or forum.

Prerequisites
■ A restricted category or forum has been created. 

■ A usergroup has been created. 

■ The usergroup creation concurrent program has been run.

Steps 
1. At the JTF login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Usergroup > Associate.

3. Choose a category or forum from the drop-down list.

4. Select a Usergroup to associate with the Forum. 

5. Select Associate.

6. A confirmation screen appears.

5.12.4 Creating Forum Moderators
A Forum Moderator is a user designated to handle specific administrative tasks for 
message threads (groups of related messages). 

Forum moderators can:

■ Change the status (open or closed) of a message thread

■ Change the distribution (public or internal) of a message thread - internal 
threads can only be viewed by employee users

■ Delete message threads

Forum moderators cannot:

■ Change access type of a category or forum

■ Set up usergroups for restricted categories or forums

■ Create forums or categories

■ Move message threads from one forum to another

Steps for creating forum moderators are below. See the Oracle iSupport Concepts and 
Procedures for more information on typical forum moderator tasks.
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Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Forum > Modify Attributes.

3. From the drop-down list, select a Forum where you wish to add a Moderator.

4. Select Next. The Modify Forum Attributes screen displays. 

5. Select the Add button under Moderator List area. The Add Moderator screen 
appears.

6. Enter the name of the user who will be the Forum moderator. 

If necessary, search for the user:

a. Enter partial search criteria, using % as a wildcard

b. Select the radio button next to the appropriate username

7. After you have entered the appropriate name in the textbox, select Add. A 
confirmation message displays.

5.13 Setting up iSupport Surveys
The Surveys functionality of Oracle iSupport allows you to survey usergroups on 
topics of your choice. Surveys require you to set up Oracle Scripting. Follow the 
steps below to implement Surveys.

5.13.1 Setting up Oracle Scripting
Oracle Scripting presents scripted messages which guide interaction center agents 
through their interactions with customers. With the 11.5.6 release of Scripting, 
Oracle introduced the survey component of Scripting, called iSurvey. Through the 
Scripting Survey component, enterprises can create, manage, and report on surveys 
to evaluate customer satisfaction, gain customer input on new initiatives, and gain 
other feedback from survey respondents. Oracle Scripting is one application 
module of Oracle's Interaction Center Suite of Applications.

Oracle Scripting consists of the following components: 

■ Scripting Engine - The simple graphical user interface that displays a script at 
an agent's workstation via a browser or within an Oracle Form. 

■ Scripting Author - A script and survey development studio which is 
downloaded to a user’s workstation. Scripting Author uses visual layouts to 
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allow a script developer to create, modify, and deploy scripts for agents at the 
interaction center. 

■ Survey Component - An HTML user interface providing web-based surveys 
that can be deployed on the Internet, via email messages or direct links on 
enterprise web sites. The survey component contains all the tools needed to 
manage lists, set up survey campaigns, and provide result information. 

Set up Oracle Scripting according to the Oracle Scripting Implementation Guide. 

5.13.2 Create Surveys in Oracle Scripting
Oracle iSupport uses only the non-list-based types of surveys. 

Create scripts in Oracle Scripting according to the steps and guidelines documented 
in the Oracle Scripting Implementation Guide and Oracle Scripting Concepts and 
Procedures. 

5.13.3 Assign Survey Administrator Responsibility to an iSupport User
Assign the responsibility, Survey Administrator, to either an existing Oracle 
iSupport user (such as the Oracle iSupport Administrator), or to a special user 
created just for this purpose. See the Implementation Tasks chapter of this guide, 
Setting up iSupport Users section, for details on how to set up users.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Select Administration > User. Search for the user who will be the Survey 
Administrator, whether this is you as the Oracle iSupport Administrator or 
another user. Select the underlined hyperlink of the username.

3. In the User Details Screen, select Responsibilities. 

4. In the Responsibilities screen, select the underlined hyperlink of the word, 
Select. A list of responsibilities appears. If necessary, search for the Survey 
Administrator responsibility. Once found, select the Survey Administrator 
responsibility. 

Note: Do not set the Survey Administrator responsibility as the default unless 
you wish to force the user to log into iSurvey the next time the user logs in to 
the HTML JTF login.

5. Save your work.
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5.13.4 Set up iSupport Survey in iSurvey
Surveys have three parts:

■ Header - this is the header area of the survey

■ Error - this is the error page that is displayed when an error occurs during the 
survey

■ Final - this is the final page displayed to the user after the survey is complete

All of these parts you create as JSPs in the steps outlined in this section.

Follow the steps below to set up Surveys in the Oracle iSurvey module.

Steps
1. Log in to the JTF login page as the user with Survey Administrator 

responsibility. 

If you are already in Oracle iSupport, you can change current responsibility: 
Navigate to Profile > Preferences and select the Survey Administrator 
responsibility from the Current Responsibility LOV on the General Preferences 
page. Select Update.

2. Navigate to Survey Campaign > Survey Resources. In the Resources screen, 
click on the Create button.

3. In the Create Resource screen, create a Header page, a Final page, and an Error 
page according to the steps and guidelines documented in the Oracle Scripting 
Concepts and Procedures, with the following exception:

■ Be sure to enter ibupfbgl.jsp in the File Name field for the Final page 
file. This is the Oracle iSupport JSP which lists the surveys you set up.

4. Navigate to Survey Campaign > Survey Campaign.Click on the Create button. 

5. In the Create Survey screen, select the appropriate script using the Go button 
and the % as a wildcard.

6. Continue creating the survey by following the steps and guidelines 
documented in the Oracle Scripting Concepts and Procedures, with the following 
exception:

■ For the Final page field, using the Go button, select the resource, Oracle 
iSupport JSP (ibupfbgl.jsp), created in step 3 above.

7. Select Create to save the survey.
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8. Navigate to Survey Campaign > Cycle and set up a cycle to associate with the 
survey by following the steps and guidelines documented in the Oracle Scripting 
Concepts and Procedures.

9. Navigate to Survey Campaign > Deployment and create a deployment for the 
survey by following the steps and guidelines documented in the Oracle Scripting 
Concepts and Procedures.

10. Deploy the survey by clicking on the Deploy button.Oracle iSupport will only 
display surveys which have the status of Active and whose dates fall within 
current dates. See the Oracle Scripting Concepts and Procedures for additional 
information.

5.13.5 Make Survey Available in iSupport
After you have created the survey in iSurvey, you need to select it in Oracle 
iSupport and then associate a usergroup(s) to the survey. Follow the steps below to 
activate the survey in Oracle iSupport. This section contains three parts:

■ Set up usergroup.

■ Run Usergroup Creation concurrent program.

■ Select Survey and Usergroup in iSupport.

5.13.5.1 Set up Usergroup
 Follow the steps below to set up a usergroup to associate with any surveys you 
have created in iSurvey. Only the usernames that are associated with the 
usergroup(s) selected will be able to view the surveys you have created.

Steps
1. Log in to the JTF login screen as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Usergroup > Create.

3. Enter a unique name for the usergroup in the Name field.

4. Select a effective date for the usergroup using the Start Date calendar icon.

5. Select an ending date for the usergroup using the End Date calendar icon. 

You can also end date a usergroup to disable it.

6. Enter a brief description for the usergroup in the Description text field.

7. In the SQL statement field, enter an appropriate SQL statement.
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Sample SQL Usergroup Select Statement

select EMPLOYEE_ID from FND_USER where EMPLOYEE_ID > 0

This select statement retrieves all employee IDs greater than zero (i.e., all 
employees) from the fnd_user table.

Note: Usergroup select statements support PARTY_ID and EMPLOYEE_ID, but 
not USER_ID.

8. Select Save.

5.13.5.2 Run Usergroup Creation Concurrent Program 
To populate necessary tables in the database, run the concurrent program 
Usergroup Creation Program (short name is IBUUG). This concurrent program 
must be run each time you update or add users to a usergroup.

5.13.5.3 Select Survey and Usergroup to Associate to Survey
Use the following steps to associate the usergroup(s) with surveys that you have 
created in iSurvey. Only members of the usergroup(s) will be able to view and 
respond to surveys.

1. Log into Oracle iSupport as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Survey. Click on the Add New Survey 
button. The Survey Detail screen will display with a drop-list of active surveys.

3. Select the desired survey from the drop-list, and then select a usergroup(s) to 
associate with the survey, by clicking on one or more of the checkboxes.

4. Select Create to save the changes.

5. To take the created survey(s), log into Oracle iSupport as a member of a 
usergroup associated with a survey, and navigate to Support > Survey.

5.13.6 View Survey Results
iSurvey allows you to view the results of your surveys. The following steps can 
assist you in retrieving survey results. For complete information, refer to the Oracle 
Scripting Implementation Guide and the Oracle Scripting Concepts and Procedures.

Steps
1. Log in to iSurvey as a user with Survey Administrator responsibility. 
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From iSupport, to switch current responsibility, select the Profile > Preferences 
menu to switch current responsibility to the Survey Administrator 
responsibility. You must select the Update button to save changes.

2. In iSurvey, navigate to Response > Survey. Follow the steps and guidelines 
documented in the Oracle Scripting Concepts and Procedures to view and manage 
your survey results.

5.14 Setting up iSupport Web Call-Back
The Web Call-Back (Call Me) feature allows users to submit a call-back request via 
the Oracle iSupport UI. The web call-back requires implementation of:

■ CRM Interaction Center (formerly Call Center Technology - CCT) suite

■ Oracle Universal Work Queue (UWQ)

■ Oracle Customer Care

■ Oracle CRM Foundation, Notes module

The purchase of call center hardware also is required.

This section provides an overview of the call-back functionality in Oracle iSupport. 
For more information, consult the CRM Interaction Center documentation available 
on MetaLink.

Outside of Oracle iSupport, the call routing process is essentially this: Once the 
call-back entry is made by the user, Oracle iSupport sends the request to the CCT 
server group specified by the Oracle iSupport Administrator on the Oracle iSupport 
UI. The CCT applications and hardware route the request to the UWQ server. The 
UWQ server decodes the customer information (the Notes module captures 
comments from user) and assigns it to the UWQ client, and the call request 
immediately pops up in an agent’s screen in Oracle Customer Care.

There are very few setups required in Oracle iSupport once the dependencies listed 
above are installed and functioning properly. Oracle iSupport simply calls one of 
the CCT APIs to provide the list of available call center server groups that appear 
the Oracle iSupport UI. 

Refer to Oracle CRM Interaction Center documentation for information on setting 
up the underlying products which enable the Web Call-Back functionality in Oracle 
iSupport.
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Once the CCT and UWQ applications and call center hardware are installed and 
implemented, then you may use the steps below to set up Call Me in Oracle 
iSupport.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Support > Call Me.

3. In the Call Me Administration screen, select a call center server group from the 
drop-list.

4. Select Update to save the data. 

5.15 Setting up Contracts Applications
Set up and/or confirm the setup of Oracle Contracts Core and Oracle Service 
Contracts. 

There are no contracts setups specific to Oracle iSupport. See the following 
documentation for setup information:

■ Oracle Contracts Core Concepts and Procedures

■ Oracle Contracts for Service Concepts and Procedures

5.16 Setting up Customer Care
Set up and/or confirm the setup of Oracle Customer Care. Refer to Oracle Customer 
Care Implementation Guide.

5.17 Verifying the Implementation
Refer to Verifying the Implementation chapter of this guide.
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Verifying the Implementation

This chapter contains steps to verify the successful implementation of Oracle 
iSupport 11i (11.5.6). Topics include:

■ Implementation Verification Overview

■ Verifying Homepage Implementation

■ Verifying User Setups

■ Verifying Service Request Implementation

■ Verifying Products and Returns Integration

■ Verifying Forums Implementation

■ Verifying Knowledge Management Implementation

6.1 Implementation Verification Overview
Following are brief guidelines to verify the successful installation of the major 
functional areas of Oracle iSupport. 

You will be using both administrator and regular user screens during the 
verification process. However, all of the verification tasks below assume you will 
log in as a regular user, unless otherwise noted.

Help with performing the general user or administrator steps described in this 
chapter can be found in the Oracle iSupport Concepts and Procedures (available in PDF 
and online). Some of the steps also are in the Implementation Tasks chapter of this 
guide.

For additional help with implementation, contact Support via Oracle MetaLink 
(http://metalink.oracle.com). MetaLink provides support and technical 
information relating to Oracle iSupport, as well as all Oracle products.
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6.2 Verifying Homepage Implementation
Verify that you have set up the Oracle iSupport Homepage.

■ As Oracle iSupport Administrator, select content for the Homepage. 

■ As Oracle iSupport Administrator, change the layout of Homepage content and 
verify that the changes can be seen on the Homepage.

■ As Oracle iSupport Administrator, make some content mandatory on the 
Homepage, and then log in as a non-administrative user and attempt to disable 
it.

■ As Oracle iSupport Administrator, sign up for Homepage e-mail subscription 
feature and verify that you receive the contents in an e-mail. 

■ Log in as a non-administrative user. Verify that you can view Homepage 
content set up by the administrator.

■ Log in as a non-administrative user. Verify that you can edit:

■ Service Request Quick Links bin

■ Service Request (saved views) bin

■ Quick Links bin

References: Setting up iSupport Homepage in the Implementation Tasks chapter of 
this guide.

6.3 Verifying User Setups
Verify that you can create the iSupport users and that you can log in as these users.

■ Create an Individual (B2C) User.

■ Create a Business (B2B) User.

■ Create a Primary User.

■ Create an Employee User.

■ Log in to Oracle iSupport as the users created. Verify that they can access the 
application and that their menu setups are as described in the Setting up 
iSupport Users section.

References: 

■ Setting up iSupport Users in the Implementation Tasks chapter of this guide
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■ CRM User Management Framework documentation (available online)

6.4 Verifying Service Request Implementation
Verify that you have set up service request functionality in Oracle iSupport.

■ Create a service request. Verify that you can attach files to the service request. 
Try attaching different types of files (.gif, .htm, .doc, etc.)

■ If you are integrating service request with Oracle Workflow, select the Email 
this to me button on the service request confirmation page and verify that the 
e-mail reaches you.

■ Close the service request. Verify that you can re-open it.

■ Wait until the Re-open closed service request time limit (set in the service 
request default settings) has expired, and then verify that you cannot 
re-open the service request.

■ If you have set up Products applications, verify that you can attach a product to 
a service request.

■ As administrator, set service request defaults to enforce product selection, 
then verify that a regular user is required to select a product while creating 
a service request.

■ If you have set up Oracle Knowledge Management, verify that you can search 
the solution repository while creating a service request.

■ As administrator, set service request defaults to enforce knowledge base 
search, then verify that a regular user is required to search the knowledge 
base while creating a service request.

References: 

■ Integrating Oracle iSupport with Service Request chapter of this guide

■ Integrating Oracle iSupport with Oracle Knowledge Management chapter of this 
guide.

■ Oracle Support (TeleService) documentation 

■ Integrating Oracle iSupport with Products and Returns

6.5 Verifying Products/Returns Integration
Verify that you have set up the dependent products and returns applications.
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6.5.0.1 Products (Products tab)
Verify the following:

■ As a non-administrative user, navigate to the Products tab. Verify that you can 
search and view products in the Install Base. 

■ As a non-administrative user, verify that you can add products to the Install 
Base.

References: 

■ Integrating Oracle iSupport with Products and Returns chapter in this guide

■ Oracle Install Base Implementation Guide

■ Oracle Inventory documentation

6.5.0.2 Returns (Accounts tab)
■ Log in as a non-administrative user and verify that you can create a return and 

receive an RMA number.

6.5.0.3 Account Management (Accounts tab)
■ Book an order in Order Management, ship it, and make a payment against it. 

Verify that you can view order under the Orders subtab. 

■ Verify that you can see the shipment details for the order.

■ Verify that you can view the invoice associated with the order under the 
Invoices tab.

■ Verify that you can view the payment details associated with the order under 
the Payments subtab.

■ If you have set up Contracts applications, create a contract in Contracts Core. 
Verify that you can you view the contract under the Contracts subtab.

References:

■ Integrating Oracle iSupport with Products and Returns chapter in this guide

■ Oracle Contracts documentation

■ Oracle Accounts Receivable and other financial products documentation
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6.6 Verifying Forums Implementation
Verify the setup of the Forums functionality.

■ As a non-administrative user, verify that you can view forums.

■ As a non-administrative user, verify that you can subscribe to forums.

■ As a non-administrative user, verify that you can select a forum message and 
post a reply that then shows up in the forum.

■ As Oracle iSupport Administrator, verify that you can create categories.

■ As Oracle iSupport Administrator, verify that you can create forums.

■ As Oracle iSupport Administrator, verify that you can create a forum 
moderator.

■ As a forum moderator, verify that you can perform the forum moderator tasks 
listed in the Creating Forum Moderators section of the Implementation Tasks 
chapter.

References:

■ Setting up iSupport Forums in the Implementation Tasks chapter in this guide

6.7 Verifying Knowledge Management Implementation
The following are the verification steps for using Oracle Knowledge Management 
module:

1. Verify that you have assigned CS_System_Admin role to the user and assigned 
CS_KB_Sys_Admin responsibility.

2. Verify that you can perform the following steps:

1. Create, view, and update a Solution Type.

2. Create, view, and update a Statement Type.

3. Associate, and disassociate a Statement Type to a Solution Type.

4. Relate Statement Types to External Links.

5. Create and modify Categories.

6. Create a new authoring flow, and edit an existing flow.

7. Create a Solution.
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8. Create a Statement, add Attachments, and add Comments.

9. View and search Work Pending Solutions.

10. Accept or reject a solution in the workflow.

11. Run Concurrent Programs. 

3. Verify that you can perform the following steps:

1. Add or update frequently used definitions for solutions.

2. Set up recommended solutions.

4. Verify that you can perform the following steps:

1. Basic Search

2. Advanced Search

3. Searching for a Statement

References:

Integrating Oracle iSupport with Oracle Knowledge Management chapter of this guide.
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Integrating Oracle iSupport with Service

Request

Oracle iSupport features the ability to create, update, and track service requests. It 
does this through integration with Oracle Support, also known as Oracle 
TeleService. The service request feature of Oracle iSupport also includes optional 
product selection/association, knowledge management queries, and e-mail 
submission of service request details.

Topics in this chapter include:

■ Overview of Service Request Functionality in Oracle iSupport

■ Overview of Dependencies

■ Overview of Setup Steps

■ Setting up Oracle Support

■ Setting up CRM Foundation Notes

■ iSupport Service Request Setups

■ Testing/Verification of Basic Setup

■ Products in iSupport Service Request

■ Knowledge Management in iSupport Service Request

■ Setting up E-Mail Submission of Service Request Details

7.1 Overview of Service Request Functionality in Oracle iSupport
The main features of service request functionality in Oracle iSupport are:
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■ Customizable templates for gathering information from users during request 
creation.

■ Enforceable or optional knowledge base search during request creation.

■ Enforceable or optional product selection during request creation.

■ Customer ability to re-open a closed request. Administrator ability to set a time 
limit on re-opening a closed request.

■ Customer ability to update an existing request by adding notes, attachments, or 
re-opening within a specific timeframe.

■ Delivery of submitted service request information to users via e-mail.

7.2 Overview of Dependencies
Oracle Support, also known as Oracle TeleService, provides the bulk of the service 
request functionality in Oracle iSupport. Oracle Support tracks all service issues 
reported by customers and employees of the merchant. It does this via agent and 
customer input and integration with other Oracle applications.

In addition to the dependency upon Oracle Support, other service request 
functionality within Oracle iSupport may be highly dependent upon additional 
applications, depending upon the features you elect to implement. These other 
applications include:

■ Oracle Workflow for processing e-mails.

■ Oracle Inventory and Install Base for products data.

■ The following CRM Application Foundation modules:

Assignment Manager (Assignment Engine) - Manager is required for service 
request functionality in Oracle iSupport and Oracle Support. Oracle iSupport 
calls the assignment manager to determine the owner (resource) of a service 
request. Who the assignment engine picks as the owner is dependent upon: 
request type, severity, urgency, status, problem code, product, and answers to 
template questions. If the assignment engine is unable to find an appropriate 
owner, the system picks the default resource and resource type configured in 
the profile options. 

Notes - The Notes module is required for service request functionality in Oracle 
iSupport and Oracle Support. Service request processes use notes to capture 
data during creation and update. Administrators must set up note types and 
map them to Oracle iSupport. 
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Resource Manager - The Resources module is optional for service request 
functionality in Oracle iSupport, unless you are going to set up and use 
Resources as owners of service requests. 

Territory Manager - Territory Manager is optional for service request 
functionality in Oracle iSupport.Territory Manager allows you to define rules in 
Assignment Manager.

Task Manager - The Tasks module is optional for service request functionality 
in Oracle iSupport, unless you are going to assign Tasks based on service 
request activity. Tasks allows you to create and assign work items to Resources. 
You create tasks, for example, to call back a customer or dispatch a service 
engineer to the customer site to fix a problem. A task may be assigned to an 
individual employee, a team, or a group.

7.3 Overview of Setup Steps
In order to use the service request functionality of Oracle iSupport, you must:

■ Set up the Oracle Support application which supplies the base functionality. See 
Setting up Oracle Support.

■ Set up the CRM Foundation Notes module which allows the capture of textual 
information in service request functionality. See Setting up Oracle CRM 
Foundation Notes.

In addition to setting up the basic functionality, you can choose to implement 
additional, optional functionality, including:

■ Products integration (see Setting up Products).

■ Knowledge base integration (see Knowledge Management in iSupport Service 
Request). 

■ E-mail of service request data to users (see Setting up E-Mail Submission of 
Service Request Details).

7.4 Setting up Oracle Support
The following sections provide abbreviated details of the Oracle Support setups 
required for service request functionality in Oracle iSupport. For additional 
information, consult the Oracle Support Implementation Guide.
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7.4.0.1 Define Service Request Status Codes
Service request status codes indicate the current state of a service request. In the 
most generic sense, the status of a service request can only be open or closed. 
Statuses default to open unless the Closed checkbox is enabled during setup.

Within the open type, you can define any number of statuses that mean open, and 
within the closed type status, you can define any number of statuses that mean 
closed. Since service requests can be re-opened, you may also wish to define a 
closed status that means permanently closed. Oracle Support ships with a limited 
number of seeded status codes, but you will want to define your own to increase 
service request flexibility.

Examples of status codes are: Assignment/Dispatch Complete, Cancelled by User, 
Engineer On-Site, Open, Closed, Resolution in Progress, and Permanently Closed.

In addition, it is important that you define status code transition rules to control the 
use and display of status codes. See Define Status Code Transitions for details.

See the latest version of Oracle Support Implementation Guide for additional setup 
details.

7.4.0.2 Define Status Code Transition Rules
Status code transition rules help control the use of status codes in the following 
ways:

■ Enables you to limit the status values that are allowable based on user 
responsibilities. If you do not define transition rules for status codes, then all 
status codes will be displayed to all users.source:

■ Allow users to change statuses based on rules, i.e., open -> working or closed, 
working -> closed, and closed -> open. Note that a status cannot go from 
working back to open.

The steps below can assist you in setting up transition rules for Oracle iSupport. 
Consult the Oracle Support Implementation Guide for more information on status code 
transition rules.

Prerequisite
■ Status Codes have been set up.

Steps
1. Log into Oracle Forms as sysadmin. Select the Customer Support responsibility.
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2. Navigate to Setup > Service Request > Request Status. The Service Request 
Statuses window displays with a list of all statuses that have been defined.

3. Select the Transitions button in the lower right-hand corner of the window. The 
Status Transitions window displays.

4. In the Application field, select iSupport using the popup LOV.

5. Enter a name for the transition rule in the Rule Name field.

6. Place the cursor in the Current State field and activate the popup LOV (...). 
Select a service request status from the Initial States window.

7. Place the cursor in the Next State field and activate the popup LOV. Select a 
status from the Final States window.

8. Continue pairing Initial and Final states as desired.

9. Save your work by selecting File > Save, or press the Save icon on the toolbar.

10. Select the Responsibility tab. Select a responsibility to map to the transition rule 
defined above.

11. Save your changes.

12. Enter additional responsibilities to map to transition rules, if desired.

13. Select Ok to save, and close the form.

7.4.0.3 Set up Service Request Types
Service request types categorize service requests and remain dynamic according to 
the state of the service request. For each service request type, you can set up a 
corresponding service request status or statuses. Additionally, each type can be 
linked to an Oracle Workflow process that can be automatically launched when the 
service request is created, or manually launched in the service request screen in 
Oracle Support. Service Request Type is a mandatory field in any service request.

You can also associate a service request type with a business process. Business 
processes are defined in Oracle Install Base and are used in generating charges for 
service requests.

The types you set up in the Forms application populate the customer LOV in Oracle 
iSupport. Typical types might be: Technical Problem, Installation Request, or 
Information Inquiry.

Prerequisites to Setting up Service Request Types
■ Set up your Status Codes.
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■ Define business processes in Oracle Install Base if you are going to use business 
processes. See the Oracle Install Base Implementation Guide for details.

■ Define workflow processes in Oracle Workflow if you are going to associate a 
workflow with a service request type. See Oracle Workflow Implementation Guide 
for details.

For more information on setting up Service Request Types, see the Oracle Support 
Implementation Guide.

7.4.0.4 Set up Service Request Severities
Service request severities indicate the agent’s perception of the reported service 
request. The severities you set here populate the LOVs on the Service Request 
Defaults setup screen in Oracle iSupport. Severity is a mandatory field in all service 
requests. Typical severities include: High, Medium, and Low.

Prerequisite
If you are using Oracle Quality Online, defect severity must be defined in that 
application if you wish to associate a service request severity with a defect severity. 
See the Oracle Quality Online Implementation Guide and the Oracle Support 
Implementation Guide for additional details.

For more information on setting up service request severities, see the Oracle Support 
Implementation Guide.

7.4.0.5 Set up Service Request Urgencies
Service request urgencies indicate the customer’s perception of the reported Service 
Request. The urgencies you set here populate the LOVs on the Service Request 
Defaults setup screen in Oracle iSupport, and will populate the Urgency LOV that 
the customer selects from when creating a service request. Urgency is an optional 
field in the Oracle Support application, but is required in Oracle iSupport.

Typical urgencies include: Inoperable, Partially Operable, and Not Urgent.

For more information on setting up service request urgencies, see the Oracle Support 
Implementation Guide.

7.4.0.6 Set up Service Request Problem Codes
Service request problem codes can further isolate the reason for a service request. 
Problem codes are user-subjective and are not required in the service request. The 
problem codes you setup here populate the customer LOV in Oracle iSupport. 
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Some sample problem codes include: Network Incident, Electrical Problem, and 
Usability Issue.

For more information on setting up Service Request Problem Codes, see the Oracle 
Support Implementation Guide.

7.4.0.7 Set up Service Request Resolution Codes
Service request resolution codes describe how a service request issue was resolved. 
It is optional to set up Resolution Codes. Some sample resolution codes include: 
Servers Rebooted, Unit Replaced, and Patch Sent.

For more information on setting up service request resolution codes, see the Oracle 
Support Implementation Guide.

7.4.0.8 Set up Oracle Support Profile Options
For information on setting up Oracle Support profile options, see the Oracle Support 
Implementation Guide.

7.5 Setting up Oracle CRM Foundation Notes
The Notes module of Oracle CRM Foundation enables the entire CRM suite to 
create, maintain, and share notes related to customers, opportunities, service 
requests, and other business objects. Notes allows the capture of extensive, textual, 
project relevant information within Oracle CRM applications. Notes comes seeded 
with predefined note types which you can use, or you can define new note types of 
your own. 

See the Oracle CRM Foundation Implementation Guide for more information. 

7.5.1 Set Note Types as Public to View in iSupport
In order for a Note to be viewed in Oracle iSupport, it must be specified as public.

7.5.2 Restrict Note Types Viewed in iSupport
Since note types are used across Oracle CRM products, it is important to restrict the 
note types that can be viewed in Oracle iSupport. If you do not do this, all note 
types used across CRM applications will be displayed in the service request default 
settings page in Oracle iSupport.
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Prerequisite
■ Note types have been set up.

Steps
1. Log on to Oracle Forms as sysadmin and select the Customer Support 

responsibility. 

2. Navigate to Setup > Notes > Source and Note Type Mapping. The Mapping 
Objects window displays.

3. Find the Source Object Public Service Requests:

a. Enter Query mode (F11). 

b. Enter Public Service Requests in Source Object field.

c. Execute the query (Ctrl + F11).

4. Ensure that the note types you are using are mapped to iSupport in the 
Application column.

For more information on setting up Notes, see the Oracle CRM Application 
Foundation Implementation Guide.

7.6 Setting up Service Request in iSupport
This section outlines the service request setups that are specific to Oracle iSupport. 
Topics include:

■ Set up iSupport Service Request Profile Options

■ Set up Service Request Defaults

■ Set up Service Request Templates

7.6.1 Set up iSupport Service Request Profile Options
There are profile options that control the user of some service request functionality 
in Oracle iSupport. See the appendix, Profile Options, for details.

7.6.2 Set up Service Request Defaults
In the Request Management screen, Oracle iSupport administrators can control the 
following service request default settings:

■ List of Values defaults in the Create Service Request screen
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■ Enforcing knowledge base search

■ Enforcing product association with a service request

■ Setting the time limit for re-opening a closed service request

■ Default note types used for various service request processes

■ Default owners of service requests.

Use the steps below to set service request defaults.

Prerequisites
■ Oracle Support/TeleService has been installed and configured. See Oracle 

Support Implementation Guide for details.

Steps
1. At the JTF login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Support > Request Management > General. The 
Request Management Administration screen displays.

3. In the Request Management Administration screen, set defaults for the 
following:

■ Default Severity - Default Severity for new Service Requests.

■ Default Status - Set a Default Status for new Service Requests. The Default 
Status is the status assigned to the Service Request at creation.

■ Closed Status - From the Closed Status list, set a default for closed Service 
Request.

■ Default Create Notetype - Set a default for the notetype used when a 
Service Request is created.

■ Default Update Notetype - Set a default for the notetype used when a 
Service Request is updated.

■ Default Escalate Notetype - Set a default for the notetype used when a 
Service Request is escalated.

■ Default Closed Notetype - Set a default for the notetype used when a 
Service Request is closed.

■ Default Resource Type - From the Default Resource Type list, set the 
default resource type. This indicates the resource type associated with the 
Default Resource ID (see below).
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■ Default Resource ID - From the Default Resource ID list, set the 
person/group who will be the default resource for Service Request routing.

■ Reopen SR Time Limit - Set the timeframe in hours during which a closed 
Service Request can be opened. 

4. In the During Service Request Creation area, set the following defaults: 

Enable Template:
■ Yes allows the use of templates during Service Request creation.

■ No prohibits the use of templates during Service Request creation.

There is also a profile option which controls this enabling of the templates. See 
the Profile Options appendix.

Search Knowledge Base:
■ Always Prompt Customer gives users the option of searching or not 

searching the knowledge base.

■ Always Search Knowledge Base enforces knowledge base search prior to 
submission of the service request.

■ Directly Submit to Oracle iSupport bypasses the knowledge base search 
option. The knowledge base button does not appear in this case.

Enforce Product Selection:
■ Yes enforces that the user select a product to associate with the request 

prior to submission.

■ No bypasses the product selection enforcement option.

5. When finished, select Update.

7.6.3 Set up Service Request Templates
Service request templates provide a structured, formatted method of gathering 
information during Service Request creation. Templates characteristics include:

■ Administrator-defined questions that gather information about service requests; 
these questions can be configured so that the user is required to answer them.

■ Administrator-defined free-form and choice-type answers that relate to the 
questions posed on the template.
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■ Weighting of choice-type answers used to determine severity of service requests 
automatically.

■ Ability to associate a template with a specific product and/or urgency.

■ Short codes which assist in characterizing and routing the service requests.

Templates are presented to the customer/user during request creation as questions 
and responses.

The information gathered from the templates assists in:

■ Routing the service request to the appropriate support agent or support group 
in Oracle Support.

■ Determining the severity of the service request in Oracle Support.

This topic area includes:

■ Creating New Templates

■ Selecting Effective Dates for Templates

■ Associating Products to Templates

■ Associating Urgencies to Templates

■ Defining Questions/Answers on Templates

■ Defining Severity Thresholds for Templates

■ Setting up a Default Template

7.6.3.1 Creating New Templates
Use the steps below to begin creating a new service request template.

Steps
1. Log in to the JTF login as Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Request Management > Template. The 
Service Request Template Administration screen displays.

3. In an empty textbox in the Template Name column, enter a meaningful name 
for the new template. 

4. In the Short Code column, enter a meaningful code for the template. The code 
must be less than 8 characters and should indicate an overall category for the 
template. For example, a short code for a template used for Toshiba laptop 
service requests could have a short code of TOSH_LAP.
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Note: In the 11.5.6 release of Oracle iSupport, the Short Code field is 
non-functional, but it is recommended that you use it so that when it is utilized 
in a future release, existing templates will already be using it. In a future 
release, the short code will help route service requests. The short code is not 
exposed to end users. 

5. Select Add. The screen refreshes and displays a confirmation message.

6. Next, select effective dates for the template. Click on the hyperlink of the 
template name. The Modify Template screen appears.

7. In the Template Info area, select the calendar icon next to the Start Date field 
and choose an effective start date for the template. Do the same for End Date. 
(You can also use the End Date function to disable existing templates.) All of the 
date steps are optional.

Renaming the template and altering the Short Code can be done here as well.

8. Select Update. A confirmation message appears.

9. Next, associate the template with a product. Select the underlined hyperlink of 
the appropriate template. The Modify Template screen displays.

10. In the Associate Attribute, Attribute to Associate: Product area, select Modify. 
The Associate Product screen appears.

11. From the Available Product list, select the desired association(s) and use the 
right (>) arrow button to move them to the Associated Product column. Select 
Update and then Back (bottom of screen) to return to the Associate Attribute 
area of the Modify Template screen.

12. Next, associate an urgency to the template. Select the underlined hyperlink of 
the appropriate template. The Modify Template screen displays.

13. In the Associate Attribute, Attribute to Associate: Urgency area, select Modify. 
The Associate Urgency screen appears.

14. From the Available Urgencies list, select the desired association(s) and use the 
right (>) arrow button to move them to the Associated Urgencies column. Select 
Update and then Back (bottom of screen) to return to the Associate Attribute 
area of the Modify Template screen.

15. Next, define questions and answers for the template. Select the underlined 
hyperlink of the appropriate template. The Modify Template screen displays.

16. Set up Questions on Template: In the Modify Template screen, the Template 
Detail area will list any questions associated with the template. If none is 
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associated, there will be an empty text box. Enter a question for the template in 
the empty Question field textbox.

17. Select Answer Type: You have two options for Answer types:

■ Choice - This is a pick-list type answer and can be used in scoring. Scoring 
is used for determining the Severity of the Service Request. 

■ Free Text - This is a free-form answer; you can specify the number of lines 
allowed for the answer (see below). This answer cannot be used in scoring.

18. If your question requires a Choice-type answer, select whether you wish the 
answer to be used in scoring/weighting when determining severities for 
submissions which use this template (see Set Severity Thresholds below). 
Answers to the question will be weighted from 1 to 9 during the Answer setup 
(see Set up Answers for a Choice Question below).

19. To enforce that the user is required to answer the question, select Yes in the 
Response Required field. Mandatory questions force the user to provide an 
answer before the application will continue creating the request. To make the 
question optional for the end user, choose No.

20. Select Add. The screen refreshes, with the question appearing as an underlined 
link in the Template Detail area.

21. To sort the questions, select Sort and use the up and down arrows in the Sort 
Questions screen to arrange the questions in the desired order. Use the back 
button to return to the Modify Template page.

22. Optionally, to edit a question, click on the hyperlink of the question you wish to 
modify.

23. Set up Answers for a Choice Question: In the Template Detail area, click on the 
underlined hyperlink of a question. The Define Question and Answer screen 
appears. 

24. Enter an answer for the question in an empty textbox.

The answers you set up here become a pick-list for the end user, and the answer 
you select as a default will appear as the default answer on the user side.

25. For each Choice-type answer, set a value of 1-9. Once the end user answers the 
questions, the application will add up these values and the final score will be 
used to determine the severity of the Service Request, based on the Severity 
Thresholds you set (see below). 
Integrating Oracle iSupport with Service Request 7-13



Setting up Service Request in iSupport
26. For Text-type questions, you will not need to determine answers. Instead, in the 
Define Question and Answer screen, select the number of rows the user will be 
limited to when answering. 

27. Select Update to save changes, and Back to return to the previous screen.

28. Next, set up severity thresholds for the template. Select the underlined 
hyperlink of the appropriate template. The Modify Template screen displays.

Use the Set Severity area to set Severity Thresholds for the template. The 
severities listed here come from the Severity setups in TeleService. For each 
Severity, enter a value in the Start and End Threshold boxes. Do not define 
overlapping thresholds or ranges (see examples, below). The weighting you 
gave to each scorable question in the defining answers step above will be 
calculated and used here. The user responses to all questions used in scoring are 
averaged, and the score determines the severity level. 

The sum score from all of the scorable answers is determined by the application 
and compared to the total possible. The percentage is determined by the 
application, and the appropriate threshold is assigned. See the example below 
for clarification.

Note: You do not need to define thresholds for all of your severities, only the ones 
you wish to use. Also: You can select one of the severities as a default and all 
templates will use that severity. Severities for which you do not define thresholds 
will be ignored by the application.

Sample scenario related to this setup
You have defined a new template with two questions on it. Each question has three 
possible answers, for a total of six answers defined by the administrator, and two 
possible answers for the user (user can only select one answer per question). 

In this example, you have set up each of the question’s three answers with identical 
scores: 1, 4, and 5. Since the user can only select one answer per question, the 
highest possible score in this scenario would be 10 (highest score for each question 
is 5, and 5 plus 5 is 10). (The user cannot see these scores.)

The user selects an answer from the first question with a score of 1. He selects an 
answer from the second question with a score of 4. Thus, the total of the two 
answers is 5. The application find the score of 5 and compares it against the total 
possible answer points, which in this case is 10. From there, the application 
formulates a percentage of answers scored (5) verses a total possible score (10). The 
percentage in this case is be 50%. Then, based on the severity thresholds you set (see 
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the example below), the application determines the severity (e.g, high, medium, 
low). Here are the thresholds set for this example:

High - Start Threshold = 61%; End Threshold = 100%

Medium - Start Threshold = 31%; End Threshold = 60%

Low - Start Threshold = 0%; End Threshold = 30%

29. When finished entering severity thresholds, select Update.When finished 
entering severity thresholds, select Update.

7.6.3.2 Setting up a Default Template
Oracle iSupport uses the Default Template you set up when users select a product 
and urgency combination for which a template does not exist. 

Only one default template is allowed.

Prerequisites 
■ A Service Request template has been created in Oracle iSupport. 

■ The service request template feature has been enabled by selecting Yes in the 
Enable Template LOV on the service request defaults screen.

Steps
1. Set up a new template with general questions. The questions should be "catch 

all" type questions related to service requests. Use the following procedure to 
set the default template.

2. In the list of templates, in the Set as Default column, select the radio button next 
to the appropriate template.

3. Select Update.

7.7 Setting up Products
Service request functionality in Oracle iSupport allows users to associate products 
associate with service requests, and allows administrators the option of enforcing 
product selection during request creation. Products also can be associated with 
service request templates set up by administrators. To enable product association, 
you must set up Oracle Inventory and Oracle Install Base. 

See the Integrating Oracle iSupport with Products and Returns chapter of this guide for 
more information.
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7.8 Using Knowledge Management in iSupport Service Request
The creation of new service requests can be reduced by allowing or enforcing users 
to search a knowledge base prior to submission. Oracle Knowledge Management 
must be set up to facilitate this functionality in Oracle iSupport.

See the Integrating Oracle iSupport with Oracle Knowledge Management chapter of this 
guide for more information.

7.9 Setting up E-mail Submission of SR Details
Service request functionality in Oracle iSupport allows users to have the details of a 
service request e-mailed to them by clicking a button on the service request 
verification screen. 

The application that facilitates the e-mail submission is Oracle Workflow. See the 
Integrating Oracle iSupport with Oracle Workflow chapter of this guide for more 
information.

Note: A valid e-mail address must be set up for the user in his Profile in order for 
the e-mail feature to work.
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Integrating Oracle iSupport with Products

and Returns

This chapter details how to integrate Oracle iSupport with the applications that 
provide products and returns functionality. Topics include:

■ Understanding Integration with Products and Returns

■ Setting up Oracle Inventory

■ Setting up Oracle Bills of Materials

■ Setting up Oracle Install Base

■ Enabling Returns Functionality

8.1 Understanding Integration with Products and Returns
Several processes within Oracle iSupport require the use of products and 
purchasing-related applications, including: 

■ Creating and processing returns

■ Viewing invoice information

■ Viewing payments data

■ Viewing shipment information

■ Creating and updating service requests

■ Maintaining products databases, such as customer products and inventory 
items 

The information in this chapter is designed to provide the merchant implementing 
Oracle iSupport with setup details directly related to Oracle iSupport. 
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The applications that integrate with Oracle iSupport and provide products 
repository and returns functionality include:

■ Oracle Inventory

■ Oracle Bills of Materials

■ Oracle Install Base

■ Oracle Order Management

■ Oracle Order Capture APIs

■ Oracle Shipping

■ Oracle Advanced Pricing

■ Oracle Purchasing

■ Oracle Service Contracts

■ Oracle Customer Care

Remember, a full install and setup of each product or purchasing application must 
be performed in order for the functionality to perform as described. Consult the 
specific product documentation for full implementation details.

8.2 Setting up Oracle Inventory
Oracle Inventory supplies the infrastructure that holds an organization’s entire 
product repository and configuration. It integrates closely with Install Base, which 
is the repository of customer- or party-purchased products. 

Both Inventory and Install Base may be required for service request functioning, 
Products tab functionality, and Accounts tab functionality in Oracle iSupport. 

For information on how to set up Oracle Inventory, see Oracle Inventory 
Implementation Guide.

8.3 Setting up Bills of Materials
Oracle Bills of Materials (BOM) is an application that allows the configuring of 
groups of products into coordinated and complementary systems. Within BOM, you 
can define product relationships and create products with multiple components and 
subcomponents. BOM integrates with Inventory and Install Base. 

BOM is an optional integration with products and returns functionality in Oracle 
iSupport.
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If using BOM, setup Oracle Bills of Materials. Refer to Oracle Bills of Material User’s 
Guide.

8.4 Setting up Oracle Install Base
Oracle Install Base is a repository which maintains the customer products in tree 
structure. Install Base maintains all the customer details, installation details, 
product information, and applicable service agreements. Install Base uses the 
concurrent program, Install Base Interface, to populate tables when new data is 
added.

Oracle iSupport uses Install Base for:

■ Retrieving customer product data in the Accounts tab

■ Adding items to the Install Base using the Products tab

■ Retrieving customer products while creating service requests

Confirm the setup of Oracle Install Base. Refer to Oracle Install Base Implementation 
Guide.

8.5 Enabling Returns Functionality
The following applications and relevant dependencies are necessary for returns 
functionality in Oracle iSupport:

■ Oracle Order Capture APIs

■ Oracle Order Management

8.5.1 Understanding Returns in OM
In Release 11i of Oracle Order Management, RMA is often used synonymously with 
Return or Credit Orders and Returned Material. An order can have a mix of 
outbound (regular) and inbound (return) lines, if not restricted by the order type 
definition. Credit order types are of the order type category Return, while an order 
with Mixed order type category can contain both regular and return lines. Each 
order type and each line type is associated with a workflow process. The Line Type 

Note: When setting up new users of the Install Base functionality, 
please add the role, CSI_END_USER to them. This role contains the 
required permissions for Install Base general users.
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Category associated with the Line Type determines if it is a return. Line types can 
be variations of Return, such as Return with Approval, Return for Credit Only, etc., 
and have a line type category of Return.

OM supports a variety of methods for returning products. An agent or 
administrator decides at the time of authorizing the return how to process the 
request. For example, an agent can accept the return and process a credit for the 
customer, updating all sales activity and credit balances. Or, the agent may accept 
the return for replacement and enter a replacement order instead of issuing a credit.

Examples of returns supported by OM:

RMA with Credit Only - Company issues a credit without the customer returning 
the product.

RMA with Repair - Customer returns damaged product. Company repairs and 
returns the product to customer.

RMA with Replacement - Customer returns a product. Company sends a 
replacement product rather than issuing a credit.

RMA with Receipt and No Credit - Customer returns a product sent to him on a 
trial basis or at no charge. Company does not issue a credit.

RMA with Receipt and Credit - Customer returns a product. Company issues a 
credit.

Returned Item Fails Inspection - Customer returns product. Company inspects 
product and rejects it. Company either destroys product or sends product back to 
customer.

Process Flow:
1. Create an RMA in Oracle iSupport.

2. Book the RMA into OM through Oracle Order Capture API.

3. Receive the RMA using the Receipts form of Oracle Purchasing.

4. Check the on-hand quantity of the item in inventory to verify that the correct 
quantity was received.

5. Fulfill the RMA line.

6. Generate a credit memo in Oracle Invoicing.

7. View the credit memo in OM.

8. Check the Shipped and Fulfilled quantity on the RMA line.
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8.5.2 Understanding Returns in iSupport
Oracle iSupport allows users to create a return by providing a UI that calls Oracle 
Order Capture APIs to submit the return to Order Management (OM) and perform 
customer validation. Oracle iSupport does not create the return to OM directly.

Navigation to the returns feature is Account tab > Return > Create Returns.

For this release of Oracle iSupport (11.5.6), iSupport only supports RMA with 
Receipt and Credit.

Process Flow:
Following is the process flow for creating a return within Oracle iSupport. For 
information on Oracle Workflow items associated with returns, refer to the chapter 
in this guide, Integrating Oracle iSupport with Oracle Workflow.

1. Within Oracle iSupport, the user accesses the Create Return screen.

2. User enters orders associated with his account number(s). For this release of 
Oracle iSupport, the user must have an exact order number to create a return. 
Only orders that have been ordered (booked) can be returned. 

3. The user provides the following information:

■ Account Number - This must be the account number associated with the 
order.

■ Contact for the company returning the item, if appropriate.

■ Bill to address - User must enter a bill to address. This indicates where the 
credit will be sent if the credit memo cannot be applied to an invoice. User 
can select alternate address using the drop list.

■ Ship from address - User will be see a default ship from address; this 
indicates where the return is originating from. User can select alternate 
address using the drop list.

■ Return reason - A return reason must be specified for each line being 
returned.

4. User selects the lines to be returned. Only items that are "returnable" can be 
returned. Only returnable lines will display select checkbox. 

5. The page will calculate the credit amount for the user; this will be the amount of 
the order line. The ordered amount is the net selling price per unit multiplied 
by the quantity ordered.
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6. Having selected a valid order item and quantity, user clicks Create Return and 
iSupport will submit the return to OM through the Oracle Order Capture API. If 
the return submission is successful, the user will receive an RMA number. If 
OM/Oracle Quoting-Forms return any errors, iSupport will capture and 
display them on the next page. When the return is booked, the same order line 
cannot be returned twice.

7. After creation of the return from Oracle iSupport, the return is handled by 
Oracle Order Capture API, Order Management, Oracle Purchasing, Workflow 
APIs, Oracle Inventory (or Oracle Install Base), Oracle Accounts Receivable, and 
Oracle Invoicing.

8.5.3 Setting up Oracle Quoting-Forms
Set up Oracle Quoting-Forms according to the latest Oracle Quoting-Forms 
Implementation Guide. This will enable access to the Order Capture APIs that are 
required for returns functionality in Oracle iSupport.

8.5.3.1 Returns Profile Options
The following profile options must be set to allow returns functionality in Oracle 
iSupport:

ASO: Default Order Type - Set to Mixed.

ASO: Default Order State - Set to Booked.

8.5.4 Setting up Oracle Order Management
Using the Oracle Order Management (OM) Suite, you can enter sales orders, 
calculate the price of items on order lines, fulfill the orders -- for example, by 
shipping the items -- and send information to an accounts receivable system so that 
invoices are created. The core OM products are: 

■ Oracle Order Management - required for returns in Oracle iSupport

■ Oracle Shipping Execution (SE) - required for returns in Oracle iSupport

■ Oracle Pricing

These products are included when OM is purchased. Additional products are 
available which are also integrated with OM, and these include:

■ Oracle Advanced Pricing - required for returns in Oracle iSupport

■ Oracle Configurator
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■ Oracle Accounts Receivable - a dependency for general Oracle iSupport setup

■ Oracle Advanced Planning and Scheduling

Confirm the setup of Oracle Order Management. While the steps in this section can 
assist you in setting up Order Management, you will need to refer to Oracle Order 
Management Suite Implementation Manual for complete setup information.

8.5.4.1 Set up Transaction Type Line Types
Order Management transaction types classify orders and returns. Credit order types 
are of the order type category Return. 

In order for the returns feature to work properly, the default order type in Order 
Management must be set to Mixed. This is controlled by the profile option, ASO: 
Default Order Type = Mixed.

The following steps can assist you in setting up Order Management Line Types. For 
complete setup information, refer to the Oracle Order Management Suite 
Implementation Manual.

Steps
1. Log in to Oracle Forms; select Order Management super user or administrator 

responsibility. 

2. Navigate to Setup > Transaction Types > Define. The Transaction Types window 
displays.

3. Query for Mixed (you must enter the word exactly as shown here) in the 
Transaction Type field. (Use F11 and Ctrl +F11 to query.) The Transaction Types 
window populates with the information for the Mixed transaction type.

4. Place the cursor in the Order Category field and select an Order Category of 
Mixed.

5. Place the cursor in the Default Return Line field and select a Default Return 
Line Type of Return (Receipt).

6. Place the cursor in the Default Order Line Type field and select a Default Order 
Line Type of Standard (Line Invoicing).

7. Access the Line Workflow Assignments screen by selecting the Assign Line 
Flow button.

8. In the Access the Line Workflow Assignments screen, add a new record.

9. In the Set Line Type field, select Standard (Line Invoicing) from the LOV.
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10. Select an appropriate Item Type to populate the Item Type field. 

11. In the Set Process Name field, select Line Flow Generic from the LOV.

12. Select an appropriate Start Date.

13. Add a second record. 

14. In the Set Line Type field, select Return (Receipt) from the LOV.

15. Select an appropriate Item Type to populate the Item Type field. 

16. In the Set Process Name field, select Line Flow Return for Credit with Receipt.

17. Select an appropriate Start Date for the record.

18. Select Ok. Save the changes.

8.5.5 Guidelines
■ When the lot controlled and serialized items are returned, the serial number 

entered by the user is not validated against an Inventory serial number or the 
original order serial number. However, the serial number is captured in the 
RMA lines and is viewable in Oracle Receivables.

■ Currently, Install Base does not get updated automatically when a serialized 
item is returned.

■ ATO/PTO configurations are configured items. For example, a configuration 
such as a computer system can consist of many items. Fulfillment of the entire 
configuration is required before crediting. The usage of fulfillment set can 
achieve the result of triggering crediting only after the entire configuration is 
fulfilled.

■ OM allows the return of freight and other special charges. 

8.5.6 Troubleshooting Returns in Oracle iSupport
To find out what is wrong in case the Create Return fails in Oracle iSupport, it is 
helpful to properly generate a debug file from Quoting-Forms/Order Management 
when a return is created. Use the following steps:

1. Inside the database, one of the v$parameter, utl_file_dir, needs to be set to the 
debug file directory. Specify the correct directory in the init.ora file to set this. 

2. Ensure the settings on the following Order Management (OM) and Order 
Quoting-Forms (ASO) profiles options:
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■ OM: Debug Level

■ OM: Debug Log Directory - This directory needs to be the same as the 
directory pointed to by utl_file_dir above.

■ ASO: Enable ASO Debug - Set to Yes.

Additional information on this topic is available in the Profile Options chapter of this 
guide.

8.5.7 Set up Oracle Advanced Pricing
Order Management uses Oracle Advanced Pricing for determining prices of goods 
sold; therefore, it is a mandatory module for returns execution. 

Confirm the setup of Oracle Advanced Pricing. Refer to Oracle Advanced Pricing 
Implementation Guide for setup details. 

8.5.8 Set up Oracle Shipping
Oracle Shipping provides shipping execution for Order Management and is 
necessary for the returns integration. It is mandatory for returns in Oracle iSupport. 

Refer to Implementing Oracle Shipping for setup details.

8.5.9 Set up Oracle Purchasing
The Receipts form of Oracle Purchasing receives an RMA when it is booked. 
Therefore, it is a mandatory module for returns execution. 

Confirm the setup of Oracle Purchasing. Refer to Implementing Oracle Purchasing.
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Integrating Oracle iSupport with Oracle

Knowledge Management

This chapter addresses Oracle iSupport’s integration with the Oracle Knowledge 
Management module. 

9.1 Overview of Oracle Knowledge Management
Oracle Knowledge Management (KM) is a comprehensive information management 
system that allows you to manage internal and external information using Oracle 
intelligent knowledge capture, storage, and distribution tools. It is a problem and 
solution management system and database. The solutions are separated by different 
criteria so that each solution has a specific meaning that relates directly to the issues 
being searched. 

KM allows easy solution capture and rapid access to new solutions. It is also 
designed to provide focused results and to reduce the cost of providing service 
while increasing customer satisfaction, thus helping companies compete in the 
marketplace.

For more information on KM, see the Understanding Knowledge Management and 
Using Oracle Knowledge Management chapters in the latest version of Oracle 
iSupport Concepts and Procedures.

9.2 KM User Roles and Responsibilities
KM supports both internal and external users. All users can search for published 
solutions in the KM repository.

Roles determine screen-level permissions. Responsibilities determine which menus 
the user will be able to view. 
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■ External users are end users who have only view and search access to published 
solutions. 

■ Internal users include KM agents, KM workers, and KM system administrators. 

The following table lists responsibilities, menus, and tabs associated with internal 
KM users.

Table 9–1 Responsibilities, Menus, and Tabs associated with Internal KM users

9.3 KM Concurrent Programs
You must run two concurrent programs to populate the tables that supply data to 
KM. How often you run these programs depends upon the specific needs of your 
company. Run these programs often enough to regularly pick up additions to the 
knowledge base, but not so often as to cause resource issues. The two concurrent 
programs are:

9.3.0.1 Knowledge Base Sync Indexes
This program retrieves any new solutions entered into the knowledge base for 
synchronization with the InterMedia Index. Intermedia text does not generate 
indexes automatically. When a new entry is added to the database, you cannot see it 
until the index is rebuilt. The short name for this concurrent program is CS_KB_
SYNC_INDEX. 

If you cannot retrieve new solutions, this program may not yet have run.

9.3.0.2 Knowledge Base Update Used Count
The solution usage count depends on the number of times a solution is used to 
solve a problem. Every time a solution is used, the usage count is increased by one. 
In the applications that integrate with KM, e.g, Oracle iSupport, the question, Can 
this solution solve your problem, appears in the UI flow. If the user selects yes, 

Responsibilities Menus Tabs

CS_KB_KNOWLEDGE_
WORKER

CS_KB_TOP_KW_MENU SMS > Search, Solution

MES

CS_KB_AGENT CS_KB_TOP_AG_MENU SMS > Search, Solution

CS_KB_SYSTEM_ADMIN CS_KB_TOP_MENU SMS > Search, Solution, 
Setup

MES
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Knowledge Base Update Used Count concurrent program runs and updates the 
usage count in KM.

The Used Count table is not refreshed automatically -- it requires Knowledge Base 
Update Used Count concurrent program to update the table. This concurrent 
program is used to determine the most frequently used solutions and part of the 
solution score, during the search process. Frequently Used Solutions list the top n 
number of solutions. This number is defined by the merchant. It is based on the 
number of times a solution has been used to solve an issue. 

The solution score in the Search Results screen is determined by the Solution Used 
Count and the InterMedia Index text match score. The higher the used count and 
the text match score, the higher the solution is placed in the results list. These scores 
are shown as a combined score to indicate the strength of the match to the query 
entered. The maximum score is 100.

The short name of this concurrent program is CS_KB_UPDATE_USED_COUNT.

9.4 Setup Dependencies for KM
These are the set up prerequisites for using KM functionality:

1. Set up the Notes module in Oracle CRM Foundation. 

2. Set up Relational Database Management System (RDBMS) for InterMedia Text.

3. Set up KM to access the solutions database. 

9.5 Setting up Notes
The Notes module enables the entire CRM suite to create, maintain, and share notes 
related to customers, opportunities, service requests, and other business tasks. The 
Notes module allows you to capture extensive textual, project relevant information 
within Oracle CRM applications. Notes comes seeded with predefined Note Types. 
Use the following procedure to create additional, customized Note Types.

Note: If you want to use the MES or Technical Library module, 
you have to set it up. See the latest version of Oracle Marketing 
Encyclopedia System Implementation Guide for more information. 
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Steps
1. Log on to Oracle Applications Forms as a system administrator. In the 

Responsibility Form, navigate to CRM Administrator > Notes Setup > Note 
Type Setup.

2. In the Application Object Library (AOL), in the Note Types Lookups Form, 
place the cursor in the multi-rec block, and click the New Record icon in the 
menu bar to open a new record.

3. Enter the Code that you want to use, its meaning, and description in the 
appropriate columns. Enter a Tag (Note) and a Start Date, if desired.

4. Navigate to File > Save and Proceed. Close the Form if you have no new note 
types to enter.

9.6 Setting up InterMedia Text
InterMedia Text (iMT) provides integrated management of free text stored in the 
database, on websites, or on file systems. It extends the Oracle SQL query language 
to provide content-based search and retrieval of information on formatted 
documents and free text. This allows you to access a number of advanced text 
search capabilities from any SQL tool or interface.

InterMedia Text (iMT) 8.1.7 has features that improve index performance and 
ease-of-use. iMT also has features that are targeted in two key areas: 

■ Structured documents 

■ Multi-lingual databases.

You must set up Intermedia Text to use KM Search functionality. 

For more information about InterMedia Text, navigate to:

■ http://www.oracle.com/intermedia/ (external and internal users)

■ http://otn.oracle.com/products/intermedia/index.htm (internal users)

9.7 Creating an Oracle KM System User/Administrator
To use KM, you must set up a user as an KM administrator in the JTF User 
Management Framework. Navigate to CS_SYSTEM_ADMIN role and assign the 
user CS_KB_SYS_ADMIN responsibility.
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9.8 Creating a Resource Group
A resource group, in KM, is a group of users who perform specific tasks in the 
solution workflow process. Examples include resource groups for editorial and 
technical review. 

Steps
1. Set up a user for Oracle iSupport. See Setting up Users section of the 

Implementation Tasks chapter.

2. Give the user Workflow User responsibility. See Oracle Applications Concepts and 
Procedures and Oracle Workflow Guide.

3. Create a resource group and associate the user to the resource group. See the 
Resource Manager section of the Oracle CRM Application Foundation 
Implementation Guide.

4. Relate the resource group to the application, Oracle iSupport. Oracle CRM 
Application Foundation Implementation Guide.

5. Relate additional users to the resource group as desired.

9.9 Setting Up Solution Authoring Profile
Authoring flows define the steps or tasks in the solution workflow process.

After creating a solution and submitting it to the workflow, a KM internal user in 
the assigned user group can approve or reject the solution. Members of the user 
group who subscribe to a product or category in the Solution Authoring Profile 
screen will receive a notification when a solution is ready for review. Members who 
do not subscribe will not receive a notification but can search for all in-progress 
solutions from the Work Pending screen by clicking Search Work in Progress.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

Note: Your system administrator can give you the values that 
should replace <host> and <apache port> in this URL.
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2. Enter your user name and password.

3. Click Profile > Solution Authoring Profile.

4. In the Categories sub-section, click Add. The Select Solution Categories screen 
appears.

5. Check the check-box corresponding to the solution category that you want to 
select. Click OK.

6. In the Products sub-section, click Add. Select a product from the list or search 
for the product.

7. Click Update. Solution Authoring Profile is updated.

9.10 Running Concurrent Programs
A concurrent program runs simultaneously with other programs and/or tasks.

Prerequisites
1. Knowledge Base Sync Indexes and Knowledge Base Update Used Count 

Summary Concurrent Programs must be available.

2. An assigned user with appropriate responsibility to run the above programs.

Steps
1. To allow a user with the system administrator responsibility to run Knowledge 

Base Sync Indexes and Knowledge Base Update Used Count Summary 
concurrent requests: 

a. Log on to Oracle Applications Forms. Responsibilities window appears.

a. Select the System Administrator responsibility.

b. Navigate to Security -> Responsibility -> Define. Click Open. 
Responsibilities window appears.

c. Query the system administrator responsibility to get the request group 
name for it.

d. Navigate to Security -> Responsibility -> Request. Request Groups window 
appears.

e. Query the request group name obtained for the system administrator 
responsibility.
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f. Under the Request section, add the concurrent request if it does not already 
exist.

g. Enter information in the following fields: 
Type = Program 
Name = <concurrent program name>

h. Click Save.

2.  To synchronize the InterMedia index:

■  concurrent program name = Knowledge Base Sync Indexes

■  short name = CS_KB_SYNC_INDEX

3. To update the solution used count for frequently used solutions:

■ concurrent program name = Knowledge Base Update Used Count 
Summary

■  short name = CS_KB_UPDATE_USED_CNT

4. To run the concurrent programs:

a. Switch the responsibility to system administrator.

b. Navigate to Concurrent ->Request.

c. Click Submit New Request.

d. Select Single Request.

e. Choose a program name.

f. Enter the required parameters. (The concurrent programs can be scheduled 
to run periodically).

g. Click Submit.

5. To view the status of the request:

a. Navigate to Concurrent -> Requests. Click Open. Find Requests screen 
appears.

b. You can enter the Request Id, or any other criteria to search for a request, or 
select All My Requests.

c. Click Find. Requests screen appears.

d. Click Refresh Data to see the latest status
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9.11 Overview of Setup Steps
To set up KM, perform the following tasks. For other process-oriented, task-based 
procedures see the Using KM chapter in the latest version of Oracle iSupport 
Concepts and Procedures.

9.12 Creating a New Solution Type
KM is seeded with the symptom/cause/action (SCA) solution type. Perform the 
following procedure to create a new solution type.

Prerequisites
KM administrators with edit permissions (CS_Type_Edit) can create a new solution 
type.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup > Create Type. The Create Type screen appears.

4. From the Type drop-down list, select Solution.

5. Enter a name for the solution type in the Name field.

6. In the Description field, briefly describe the solution type. The description of a 
solution type is only for administrators and cannot be viewed by a customer.

7. Click Create. The Solution Type screen reappears with a Related section. You 
can relate statement types or external links to the solution type.

9.13 Viewing a Solution Type
In KM, information is organized into solutions, segmented into solution types. KM 
is seeded with symptom/cause/action (SCA) solution type. 

Use this procedure to view existing solution types.

Prerequisites
All internal users can view existing solution types.
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Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup > Solution Types. The Solution Types screen 
displaying a list of existing solution types appears.

4. Click the numbered link to view details. You can also update the solution type 
and add/delete statement types or external links here.

9.14 Updating a Solution Type
Use this procedure to update an existing solution type.

Prerequisites
You must have edit permissions (CS_Type_Edit) to edit a solution type.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup > Solution Types. The Solution Types screen with a list 
of existing solution types appears.

4. Click a Solution Type Number link to view the corresponding Solution Type 
screen.

5. To update the name or description of the Solution Type, enter the new 
information in the appropriate fields. 

6. Click Update.

7. To update the related statement types or external links, make the required 
selections.

8. Click Update to save the changes, Restore to return to original values or Delete 
to delete the solution type.
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9.15 Deleting a Solution Type
Use this procedure to delete a solution type. Do not delete the default solution type, 
SCA.

Prerequisites
■ KM administrators must have edit permissions (CS_Type_Edit) to delete a 

statement type. Note: you must delete any statement types associated with the 
solution type.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup> Solution Types. The Solution Type screen appears.

4. Click the solution type numbered link that you want to delete.

5. In the Solution Type screen, ensure that there are no related statement 
types/external links listed in the Related sub section.

6. To remove related statement types:

a. Click Add/Delete button. The Associate Statement Types screen appears. 
Disassociate the statement type from that solution type. 

b. Click Save. The Solution Type screen reappears with no statement types or 
external links in the Related section.

7. Similarly delete the related statement types and external links: Click Delete to 
delete the solution type. This procedure cannot be undone.

9.16 Creating a Statement Type
A statement is a description about any aspect of a problem, its cause, or resolution. 
Statements can be segmented into statement types. 

Prerequisite
KM administrators with edit permissions (CS_Type_Edit) can create a new 
statement type.
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Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup > Create Type. The Create Type screen appears.

4. In the Type drop-down list, select Statement.

5. Enter a name for the statement type in the Name field.

6. Enter a description for the statement type in the Description field.

7. Click Create. The Statement Type screen reappears with a Related section. You 
can also relate this statement type to a solution type or external links. To relate 
this statement type to an external link (e.g, JTF Note Type), perform the 
following steps:

4. In the Related section, select External Links from the drop-down box.

5. Click Add. The External Object screen appears. Click Note Type.

6. The Note Type screen appears. Search for the note type that you want to 
add to this statement type. Use % for a wildcard search. 

7. From the Search results select the JTF note type to add to the statement 
type. Click Update.

9.16.1 Associating a Statement Type to a Solution Type
You can associate a statement type to a solution type in the Associate Statement 
Types screen.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup > Solution Types. The Solution Types screen appears.

Note: The name of the JTF note type must be exactly the same as 
the statement type.
Integrating Oracle iSupport with Oracle Knowledge Management 9-11



Viewing a Statement Type
4. Click the Solution Type Number link. The linked Solution Type screen appears.

5. Click Add/Delete button. The Associate Statement Types screen appears.

6. To add a statement type to the existing solution, choose the desired statement 
type from the Available Statements Types box and assign (>) it to the Selected 
Statement Types box.

7. Click Save to save the changes or Cancel to restore the original values and 
return to the previous screen.

9.16.2 Disassociating a Statement Type from a Solution Type
You can disassociate a statement type from a solution type in the Associate 
Statement Types screen.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup > Solution Types. The Solution Types screen appears.

4. Click the Solution Type Number link. The linked Solution Type screen appears.

5. Click Add/Delete button. The Associate Statement Types screen appears.

6. To delete a statement type from the existing solution, choose the desired 
statement type from the Selected Statement Types box and use the arrow key 
(<) to move it to the Available Statements Types box.

7. Click Save to save the changes or Cancel to restore the original values and 
return to the previous screen.

9.17 Viewing a Statement Type
Statement type is an identifying name associated with a particular part of the 
solution type. For example, symptom is a statement type within the 
symptom/cause/action solution type.

Prerequisites
Internal users with view permissions (CS_Statement_View) can view existing 
statement types.
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Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup> Statement Types. The Statement Types screen 
appears.

4. Click the numbered link to navigate to the associated Statement Type screen.

9.18 Updating an Existing Statement Type

Prerequisites
KM administrators with edit permissions (CS_Type_Edit) can edit a statement type.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup> Statement Types. The Statement Types screen 
appears.

4. Click the numbered link to navigate to the associated Statement Type screen.

5. Update the name or description of the statement type. 

6. Click Update.

7. In the Related section, you can add or update the solution types or external 
links.

8. Click Update.

9.19 Deleting a Statement Type
Use this procedure to delete a statement type. You cannot delete the default 
statement type.
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Prerequisites 
■ KM administrators with edit permissions (CS_Type_Edit) can delete a statement 

type. Note: You must remove a solution type or external link in use by the 
statement type to be deleted.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup> Statement Types. The Statement Types screen 
appears.

4. Click on the numbered link of the statement type you want to delete.

5. In the Statement Type screen, ensure that there are no related solutions types or 
external links listed in the Related sub section.

6. To remove a solution type or external link being used by a statement type:

a. In the Remove column, check the relevant checkboxes.

b. Click Update.

7. After removing the related solution types or external links, click Delete. This 
procedure cannot be undone.

9.20 Adding Solution Categories
You can add solution categories from the Managing Solution Categories screen.

Prerequisites
Administrative permissions to add solution categories.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS >Setup> Categories. The Manage Solution Categories screen 
appears.
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4. Select the root category or one of the child categories to which you would like 
to add categories by clicking the corresponding radio button.

5. Click the Add button. A new field populated as New Category appears.

6. Remove New Category from the field and enter a new category name in that 
field.

7. Click Save.

9.21 Editing Solution Categories
You can edit solution categories from the Managing Solution Categories screen.

Prerequisites
Administrative permissions to edit solution categories.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS >Setup> Categories. The Manage Solution Categories screen 
appears.

4. Select the root category or one of the child categories to edit by clicking the 
corresponding radio button.

5. Click Edit.

6. The selected category name appears in a field.

7. Edit the category name.

8. Click save.

9.22 Deleting Solution Categories
You can delete solution categories from the Manage Solution Categories screen.

Prerequisites
Administrative permissions to delete solution categories.
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Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS >Setup> Categories. The Manage Solution Categories screen 
appears.

4. Select the category you want to delete by clicking the corresponding radio 
button.

5. Click Delete.

9.23 Creating a New Authoring Flow
Authoring flows define the steps or tasks that a solution must follow in the solution 
approval or rejection process. 

Prerequisites
Administrative permissions to create a new authoring flow. 

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup >Authoring Flows. The Available Flows screen 
appears.

4. Click Create. The Authoring Flow Set Up screen appears.

5. Enter a flow name.

6. For each row, enter an order number, select the Step, Assigned to, and Action 
fields.

■ Order: A number determining view order.

■ Step: an authoring flow can be assigned any of the following steps: Deleted, 
Draft, Editorial Review, Public, Public Internal, Public Limited, Published, 
Technical Review, and Under Edit
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■ Assigned To: an authoring flow can be assigned to any of the user groups 
that have required permissions. Examples include, Business User Group, 
Editorial Reviewers, and Technical Reviewers.

■ Action: an authoring flow can have Notify, Obsolete, or Publish actions.

7. Click Update.

9.24 Viewing Authoring Flows
Authoring flows are the steps or tasks that a solution goes through in the solution 
approval or rejection process. 

Prerequisites
Administrative permissions to view (CS_Workflow_Setup_View) a new workflow. 

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup >Authoring Flows. The Available Flows screen 
appears.

4. Click the Authoring Flow name to view flow details.

5. On this screen you can modify the following authoring flow parameters:

■ Order: A number determining view order.

■ Step: an authoring flow can be assigned any of the following steps: Deleted, 
Draft, Editorial Review, Public, Public Internal, Public Limited, Published, 
Technical Review, and Under Edit

■ Assigned To: an authoring flow can be assigned to any of the user groups 
that have required permissions. Examples include, Business User Group, 
Editorial Reviewers, and Technical Reviewers.

■ Action: an authoring flow can have Notify, Obsolete, or Publish actions.

6. You can also add a new row of values by clicking the More Rows arrow or 
delete a row by checking the Remove checkbox corresponding to the row that 
you want to remove. Click Update.
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9.25 Setting Up Frequently Used Definitions for Solutions
You can provide your customers with a list of frequently used solutions within a 
specified time period. Use this procedure to set up frequently used definitions for 
solutions.

Prerequisites
KM administrators with update permissions (CS_Freq_Used_Def_Update) can add 
or update frequently used definitions.

Steps
1. Navigate to the Oracle CRM Applications login page at:

http://<host>:<apache port>/OA_HTML/jtflogin.jsp

2. Enter your user name and password.

3. Navigate to SMS > Setup > Frequently Used Definition. The Frequently Used 
Definitions screen appears.

4. Select the time period that you want to use as a default time period.

5. Click Update.

6. To add a new time period, click Add. The Add Definition screen appears.

7. Enter the new name, description, and number of days.

8. Click Save.

Note: You can also remove a time period from the list.

Note: To view Frequently Used Solutions, navigate to Oracle 
iSupport Homepage. In the How can we help you section, click 
Frequently Used Solutions.
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Integrating Oracle iSupport with Oracle

Workflow

Oracle iSupport integrates with Oracle Workflow to provide e-mail submission and 
other workflow processes. 

Topics in this chapter include:

■ Oracle Workflow Overview

■ Overview of Oracle Workflow Functionality in iSupport

■ Setting up Oracle Workflow

10.1 Oracle Workflow Overview
Oracle Applications 11i comes with Oracle Workflow (WF) already installed as part 
of the Applications Object Library (AOL). WF consists of two tiers: 

■ Workflow Client (Workflow Builder)

■ Workflow Server

The sections below provide an overview of these two tiers.

10.1.1 Workflow Client
Workflow Client is the Workflow Builder which is used by Workflow developers to 
create or modify custom workflows. This is installed on Windows 95/NT/2000 
clients only.
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10.1.2 Workflow Server
The Workflow Server consists of the following elements:

Workflow Engine: Monitors workflow states and coordinates the routing of 
activities for a process. Changes in workflow state -- such as the completion of 
workflow activities -- are signalled to the engine via a PL/SQL API or Java API. 
Based on flexibly-defined workflow rules, the engine determines which activities 
are eligible to run, and then runs them. The Workflow Engine supports 
sophisticated workflow rules, including looping, branching, parallel flows, and 
subflows.

Workflow Notification Mailer (WFMAIL): Electronic mail (e-mail) users can 
receive notifications of outstanding work items and can respond to those 
notification using their e-mail application of choice.

Note: Email notifications will only be sent if the Workflow mailer is setup and 
configured properly. The PHP/Self Service Workflow notifications page can 
also be used to view notifications. Please refer to the Workflow documentation 
for more information on how to start and configure the workflow mailer. 

Workflow Definitions Loader (WFLOAD): The Workflow Definitions Loader is a 
utility program that moves workflow definitions between the database and 
corresponding flat file representations. You can use it to move workflow definitions 
from a development to a production database, or to apply upgrades to existing 
definitions. In addition to being a standalone server program, the Workflow 
Definitions Loader is also integrated into Oracle Workflow Builder, allowing you to 
open and save workflow definitions in both a database and a file.

Workflow Monitor: Workflow administrators and users can view the progress of a 
work item in a workflow process by connecting to the Workflow Monitor using a 
standard Web browser that supports Java. The Workflow Monitor displays an 
annotated view of the process diagram for a particular instance of a workflow 
process, so that users can get a graphical depiction of their work item status. The 
Workflow Monitor also displays a separate status summary for the work item, the 
process, and each activity in the process.

Message Delivery Scheduler Concurrent Program: 

Workflow Background Engine/Workflow Background Process Concurrent 
Program: A supplemental Workflow Engine that processes deferred or timed-out 
activities.

Purge Obsolete Workflow Runtime Data Concurrent Program (WF_PURGE): This 
program purges obsolete item types runtime status information. source:
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For more information on Oracle Workflow, see the Oracle Workflow User’s Guide.

On MetaLink, search for Oracle Workflow to find additional relevant documents.

10.2 Overview of Oracle Workflow Functionality in iSupport
The sections that follow describe Oracle Workflow’s relationship to Oracle iSupport. 
For more information on Oracle Workflow, see the Oracle Workflow User’s Guide.

10.2.1 Service Request
Oracle iSupport features the ability to create, update, and track service requests. It 
does this through integration with Oracle Support (Oracle TeleService).

Service request types can be linked to an Oracle Workflow process that can be 
automatically launched when a service request is created, or manually launched in 
the service request screen in Oracle Support. Oracle Workflow automatically 
notifies service personnel about their assignments based on service request. When a 
service request is escalated, Oracle Workflow processes and delivers the 
notifications regarding escalation activity.

Oracle iSupport also uses Oracle Workflow to submit service request details to 
users. This is done via the Email this to me button during service request creation.

For more information, see:

■ Oracle Workflow Guide

■ Oracle Support Implementation Guide

■ Oracle iSupport Implementation Guide:Integrating Oracle iSupport with Service 
Request

10.2.2 Returns
When a customer books a return in Oracle iSupport, Workflow picks it up using the 
seeded workflow, Order Flow - Return with Approval. Next, Workflow uses the 
Return for Credit with Receipt workflow to send the return to the Return Receiving 
Line stage. Then, the receiving agent from Oracle Purchasing uses Oracle 
Purchasing to pull up the Return Material Authorization (RMA) to verify and mark 
the items as received. The agent then selects a destination for the product(s), such as 
Oracle Inventory. As the receiving agent does this, a Workflow API is invoked to 
move the workflow to the next stage, and Order Management receives data that 
updates the RMA as appropriate. The workflow now waits in Oracle Inventory. It is 
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here that an agent verifies and indicates in Inventory that the correct quantity has 
been received. When a configurable item set (BOM-enabled) is returned, the 
workflow will wait here until all items are checked into the inventory. The 
workflow will next invoke the Accounts Receivable interface APIs. After all of the 
items are fulfilled, an invoice is generated and a credit memo can be generated 
through Oracle Invoice auto-invoice master program. 

For more information, see the chapter, Integrating Oracle iSupport with Products and 
Returns.

10.2.3 Homepage Subscription E-mails
The Homepage e-mail subscription feature uses Oracle Workflow to process 
e-mails. This can be useful if a user is unable to access the Homepage for a period of 
time. The user signs up for the subscription e-mails through the Profile > Support 
menu. In the Support page, the user can select the days that the e-mails should be 
sent and whether the e-mails should be HTML or text-based. The system then uses 
Workflow to sends the e-mails to the address setup in the Profile > Contact Points 
menu.

For more information, see the Setting up iSupport Homepage topic in the 
Implementation Tasks chapter. 

10.2.4 Knowledge Management
Oracle Workflow is essential for the solution authoring feature of knowledge 
management. Using Workflow, the authoring process allows users to define the 
steps in processing content. The process can be as simple as a single step, 
author-publish, or can include several approval stages prior to publication. In an 
approval-dependent process, Workflow allows content to be rejected back to the 
previous stage or a selected previous stage. Individuals involved in solution 
authoring can be assigned to specific groups that are aligned with specific stages 
and categories of content, and these groups can be sent e-mails notifying them of 
the status of content.

For more information, see the chapter, Integrating Oracle iSupport with Oracle 
Knowledge Management.

10.2.5 User Approvals
The approvals notifications used in the CRM User Management Framework are 
dependent upon Oracle Workflow. The workflow notifications provide e-mails to 
user approvers notifying them that they have users in the queue waiting to be 
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approved. Workflow also sends e-mails to users notifying them that they have been 
approved for an application. For more information, see the Oracle CRM Technology 
Foundation Implementation Guide, the Oracle CRM Technology Foundation Concepts and 
Procedures, and the CRM User Management online help.

10.3 Setting up Oracle Workflow
Refer to the Oracle Workflow Guide.
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 Diagnostics and Troubleshooting

This section contains instructions on how to troubleshoot specific problems that you 
may encounter in the configuration or administration of Oracle iSupport. Topics 
include:

■ Stop/Start (Bounce) Apache Server

■ Java/HTML Stack Errors

■ How to Find Responsibility ID Values

■ Debugging iSupport Returns Functionality

■ Customizing the iSupport Quick Find Menu

■ Oracle iSupport Administration FAQs

11.1  Stop/Start Apache (Bounce) Server after Patching
After you apply a patch that affects Java applications, you should stop and re-start 
the Apache server and clear the cache on the Apache server. This will help to 
minimize patching errors.

Note: For 11.5.4 and above, the cache is being taken based on the Servlet 
Initialization parameter, page_repository_root. This parameter can be located in the 
zone.properties file section: servlet.oracle.jsp.JspServlet.initArgs=page_repository_
root=$<ANY Directory> _pages.

11.2 Java/HTML Stack Errors
The following section addresses typical issues associated with the Java applications 
and the HTML technology stack. Topics in this section include:
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■ Understanding JSPs and Server Cache

■ Where are E-Commerce Cookies Stored?

■ JspCompileException

■ NoSuchMethod

■ java.lang.nullpointerException

■ JTF-0198

11.2.0.1 Understanding JSPs and Server Cache
The HTML applications are made up of Java Server Pages (JSPs). JSPs are converted 
into Java programs (files with the extension, .java), and those Java programs are 
converted into Java binaries (files with the extension, .class). These Java binaries 
will be executed by the Jserv Java Virtual Machine (JVM). This translation process 
happens on the fly for every JSP, and once it is completed, the Java programs, along 
with the Java binary, are stored/cached in a special directory called _pages.

11.2.0.2 Where are E-Commerce Cookies Stored?
The cookie file for Netscape browsers is located under the 
Netscape\Users\YourNetscapeUser directory. The file is called cookie.txt.

Cookie files for Internet Explorer are located in the C:\WINDOWS\Cookies 
directory. The name of the file is yourWindowsUser@domain.com. 

11.2.1 JspCompileException

Problem Description
While navigating the HTML application, you receive the following error:

JSP Error: Request URI:/OA_HTML/jtfasuf.jsp

Exception:oracle.jsp.provider.JspCompileException:

Errors compiling:e:\oracrm\viscomn\html\_pages\_oa__html\\_
jtfasuf.java:706

Incompatible type for method. Can’t convert into 
java.lang.Object. 
params.put(’companyid’,ub.getCompanyPartyID());
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When applying E-Commerce patches, the Java Business Objects are replaced in the 
apps.zip and the JSP files are replaced in the system. The server cache is not rebuilt 
automatically, unless a directive has been specified in the JSP. This leads to an 
inconsistency or mismatch (displayed as the error: Incompatible type for method. 
Cannot convert into java.lang.Object) between the JSP and the Java Business Object 
in use. Therefore, the oracle.jsp.provider.JspCompileException occurs.

 The directive that makes the cache able to be rebuilt is developer_mode = true. This 
is a servlet initialization parameter for Oracle Java Server Page Servlet, and it can be 
found in the jserv.properties file located in $APACHE_TOP/Jserv/etc. path of any 
installation.

Solution Description
Most of the time, this error can be resolved by removing the server cache 
(JSP/Jserv), and stopping and re-starting the web server. When you remove the 
server cache, the Java programs and the Java binaries are rebuilt, and when 
bouncing the web server, the Java classes cached in memory are removed. This then 
eliminates any possible mismatch and the exception.

11.2.2 NoSuchMethod

Problem Description
You receive the error, java.lang.NoSuchMethodError.

This error occurs because the system is trying to use a method within a Java object 
that does not exist. This error results due to incorrect/improper setting of the 
classpath variable. In the case of Apache/Jserv, the classpath is defined in a special 
configuration file called jserv.properties, usually located at $APACHE_
TOP/Jserv/etc. (for example, $APACHE_TOP/Jserv/conf in Windows NT). 

Other, not-as-common causes for this error are:

■ Incorrect patch set level or missing patches

■ Errors while patching application

■ Bug in the application 
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11.2.3 JTF Login Page Errors

Problem Description
You are trying to log into the HTML stack via the jtflogin.jsp or the 
jtfdefaultlogin.jsp. 

Jtflogin.jsp page does not display and returns the message, error in error 
page. 

Jtfdefaultlogin.jsp page does not display and returns a message like system 
error, followed by several Java messages, the most significant being 
oracle.apps.jtf.base.session.ServletSessionManagerException.

You have tried to run the diagnostics via jtfqalgn.htm or jtfmain.htm and the 
database connectivity tests fail.

Solution Description
There can be several reasons for this problem scenario, including configuration files 
not being correct for httpd.conf, jserv.conf, jserv.properties, and zone.properties.

The following solution is for correcting one specific condition where your .dbc file 
has been manually edited, looks correct, but the connectivity issue persists.

1. Select * from fnd_application_servers:

The query should return one row. If the query return more than one row, delete 
the rows that are most obviously incorrect. You will probably be able to 
recognize the invalid rows by the IP address column (server_address) that 
points to an invalid host database tier.

The authentication string in this table (column server_id) must match the same 
string in your host_sid.dbc file (appl_server_id).

2. Make a backup copy of your .dbc file.

3. To ensure that everything is in sync, run the adgendbc.sh script located in your 
$COMMON_TOP\admin\install directory. This script takes no parameters 
except -deinstall, which you probably do not want to do. This script will assign 
a new authentication string (server_id), update your .dbc file, and update your 
fnd_application_servers table.

It’s okay if you get an error message related to unique key constraint (read the 
script file).
11-4    Oracle iSupport Implementation Guide



Java/HTML Stack Errors
4. Double-check the information in your .dbc file and fnd_application_servers 
table. It should be in sync. Display or print the .dbc file. Please do not use an 
editor, because you may forget the rule and save it.

Summary
It is strongly recommended that you do not edit your .dbc file. Results are 
unpredictable and can take a long time to diagnose.

11.2.4 java.lang.nullpointerException

Problem Description
You receive the error, java.lang.nullpointerException.

This error occurs because the system is trying to use an object (variable) that has not 
been instantiated (initialized). The instantiation problem can be due to:

■ Bug in the application

■ Invalid business scenario or flow caused by a configuration problem

Summary
If you are unable to resolve this error, create a Technical Assistance Request (TAR) 
with Oracle Support, and be sure to attach the log files for the application.

11.2.5 JTF-0198

Problem Description
You receive the error, JTF-0198.

This application-generated error occurs when the system cannot identify a valid 
cookie. Most of the time, the root cause of the problem is one of these two:

Note: If you receive this error while running Rapid Install: On 
the screens that tell RapidWiz where to store files/directories, do 
not press Ctrl + V (paste) with an empty clipboard. Be sure your 
clipboard has some data stored on it before pressing Ctrl + V, or 
you will receive an error, Java.lang.NullPointerException. (The 
command in Windows for copying text to the clipboard is Ctrl + 
C.)
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1. The domain name field in the ICX_PARAMETERS table is set incorrectly. 

2. You have more than one system installed (with the same domain configuration) 
and with the same cookie name, and are accessing both systems from the same 
browser/machine. Intermittently, the server rejects the cookie because it finds 
two identical cookies on the two systems that are being run. 

Solution Description
To resolve this error, use the following steps.

1. For the first case, set the domain name to either null or a fully qualified domain 
name. For example, if your domain name is computers.com, then the fully 
qualified domain name is .computers.com. This field can accept no 
abbreviated versions of the domain name. Note that the fully qualified 
domain name must contain a dot (.) starting the domain.

For domains that do not belong to the global internet (i.e., private intranets) the 
session_cookie_domain field in ICX_PARAMETERS table must be set to the 
correct domain. If the domain does not belong to the global internet, the 
preferred value for the session_cookie_domain field in ICX_PARAMETERS 
table is null.

2. Change the value of the JTF Property cookie name in one of the systems. Stop 
all browser sessions and clean browser cookie files.

The cookie file for Netscape browsers is located under the 
Netscape\Users\YourNetscapeUser directory. The file is called cookie.txt.

Cookie files for Internet Explorer are located in the C:\WINDOWS\Cookies 
directory. The name of the file is yourWindowsUser@domain.com. In the case of 
IE, you should delete the file name with the extension that matches the domain 
name of the server you are trying to reach, or delete them all.

Summary
If you are unable to resolve this error by following the above steps, create a 
Technical Assistance Request (TAR) with Oracle Support, and be sure to attach the 
log files for the application.

11.3 How to Find Responsibility ID Values
The following steps describe how to find the RESPONSIBILITY_ID value of a 
responsibility.
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1. Log in to Oracle Forms application as sysadmin. Select System Administrator 
responsibility. Navigate to Security > Responsibility > Define. The 
Responsibilities form opens.

2. Enter query mode (F11). Under responsibility name, type in IBU_%. Execute the 
query (Ctrl + F11). 

3. An Oracle iSupport (IBU) user responsibility and its associated details will 
appear. Use the Down Arrow key to scroll through the list of Oracle iSupport 
responsibilities.

4. To find the responsibility ID, place your cursor in the Responsibility Key field of 
the responsibility whose ID you wish to find. From the menu, select Help > 
Diagnostics > Examine. The Examine Fields and Variable Values window 
appears. 

5. In the Examine Fields and Variable Values window, click on the LOV button of 
the Responsibility Key. In the LOV that appears, select Responsibility ID. The 
Examine Fields and Variables Values window will then be populated with the 
Responsibility ID for that responsibility.

11.4 Debugging iSupport Returns Functionality
To find out what is wrong in case the Return functionality fails in Oracle iSupport, it 
is helpful to properly generate a debug file from Quoting-Forms/Order 
Management when a return is created. Use the following steps:

1. Inside the database, one of the v$parameter, utl_file_dir, needs to be set to the 
debug file directory. Specifying the correct directory in the init.ora file can set 
this. 

2. Ensure the settings on the following Order Management and Order 
Quoting-Forms (Order Capture) profiles options:

■ OM: DEBUG LEVEL needs to be set. 10 is the highest debug level.

■ OM: DEBUG LOG Directory - This directory needs to be the same as the 
directory pointed to by utl_file_dir above.

■ ASO: ENABLE ASO DEBUG - Set to Yes.

■ See the chapter, Integrating Oracle iSupport with Products and Returns for 
additional information.
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11.5 Customizing iSupport Quick Find Menu
The Quick Find Menu appears on most of the Oracle iSupport UI pages. The steps 
below can assist you in customizing this menu.

1. Log in to the JTF UI as sysadmin.

2. Navigate to Settings > System > Advanced > View. 

3. Select Oracle iSupport’s product code, IBU. 

4. You will see a corresponding category and descriptor defined for the each 
search item.

5. Remove any items which you do not wish to use.

Note: When deleting items, be sure to remove the pairs of items that end in 
.categories and .desc.

11.6 Oracle iSupport Administration FAQs
The following are common questions that might be asked by an administrator or 
primary user on Oracle iSupport.

■ How do I customize iSupport?

■ How do I remove links in the How Can We Help You? bin on the Homepage?

■ Does iSupport support different languages?

■ Can users renew contracts through iSupport?

■ What is the relationship between iSupport and TCA?

■ What is the significance of the account number in iSupport?

■ Where do users reset their passwords?

■ Why type of users can change their first and last names in the Personal Profile?

■ What type of users can see company profile information?

■ What causes permission errors under the Profile menu?

■ Why would a user not be able to see the side menus in the Profile screens?

■ What if I am a primary user who can see other companies’ information?

■ How can a user’s address information be changed?
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■ What if I have removed a permission and now I want to restore the original 
values?

■ How can a user add more than three attachments to a service request?

■ How does selecting a default responsibility for users on the iSupport UI work?

11.6.0.1 How do I customize iSupport?
Oracle JDeveloper can be used for Oracle iSupport custom development. It can be 
used to write, debug, deploy and test Java and JSP applications. 

Note: However, not every aspect of Oracle iSupport is customizable. Much of the 
Homepage code is generated in the PL/SQL layer, and to customize it you have to 
modify the PL/SQL packages.

11.6.0.2 How do I remove links in the How Can We Help You? bin on the 
Homepage?
Currently, the only way to eliminate a link from the help bin is to comment out the 
HTML section that generates the link in the procedure. Unfortunately, in the current 
code, you cannot afterward place the link back in. 

The bin is generated from the IBU_HELP_BIN package, get_html procedure.

11.6.0.3 Does iSupport support different languages?
Yes. Oracle iSupport is NLS and MLS compliant. 

Note: Some hard-coded HTML, messages, and/or displays may appear in English.

■ National Language Support (NLS) - Running of applications in one 
non-American English language.

■ Multi Language Support (MLS) - Running of applications in more than one 
language, one of which is the base language.

See Oracle MetaLink for the latest NLS and MLS release notes.

11.6.0.4 Can users renew a contract through iSupport?
No, the current functionality in Oracle iSupport allows you to view contract 
information. Contract renewal can be done through Order Management or 
Contracts Core applications.
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11.6.0.5 What is the relationship between iSupport and TCA?
Trading Community Architecture is the name used in external marketing by Oracle 
to describe what is internally known as the TCA data model and architecture. TCA 
is an architecture concept designed to support complex trading communities. The 
goal of TCA is to provide the foundation for Oracle ERP, CRM, and eBusiness 
applications (i.e., the entire E-Business Suite). To do this, TCA strives to model all 
relationships within a trading community. This enables one data model to store B2B, 
B2B2C, B2C, and B2C2C data.

For example, the trading community of an appliance manufacturer may include 
suppliers, distributors, resellers, retailers, service providers, individual consumers, 
and business consumers. The appliance manufacturer not only wishes to track 
relationships between itself and other entities within the trading community, the 
manufacturer may also be interested in relationships that other community 
members have with each other. The manufacturer may not even have direct 
relationships with all the members of its trading community. But, it is important 
that the appliance manufacturer know about these entities and how they relate to 
other entities within the community.

In summary, there is only one customer data model/schema used both by ERP and 
CRM. The 11i Customer Model is not a product that can be purchased. Rather, it is 
the underlying data model that stores customer information and is included with 
any CRM or ERP application. All CRM modules utilize the Customer Model to store 
customer information, although the degree to which the Customer Model is utilized 
differs from module to module. 

11.6.0.6 What is the significance of the account number in iSupport?
The account number represents a customer’s financial record/account. In Oracle 
iSupport, an account number is required to create a service request. Also, all 
real-time accounts inquiries in Oracle iSupport are based on the account number. 

B2C (individual) customers are assigned account numbers automatically by the 
system when they register. Customers can view their account numbers by 
navigating to the Profile screens (Profile > Accounts). 

B2B (business) users can be assigned multiple accounts during or after registration 
approval. Account assignments are made on the JTF sysadmin console by a B2B 
user’s primary user or merchant administrator. B2B users can view their account 
numbers and set a default account number in the Profile screens (Profile > 
Accounts).
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11.6.0.7 How do users reset their passwords?
Access the user’s profile information (Profile > Personal Profile) and enter a new 
password. Select Update on the page to save changes.

11.6.0.8 What type of users can change their first and last names in the Personal 
Profile?
B2B and B2C users can change their first and last names, but employee users 
cannot.

11.6.0.9 What type of users can see company profile information?
B2C users and employee users cannot see company profile information in the 
profile screens. The company information is applicable only to B2B users, and is 
contained in the TCA.

11.6.0.10 What causes permission errors under the Profile menu?
Users need IBU_PROFILE_VIEW or IBU_PROFILE_UPDATE permissions to view 
and update their profile pages.

11.6.0.11 Why would a user not be able to see the side menus in the profile 
screens?
Users need the seed data for JTF_USER_PROFILE_TYPE to access these menus.

11.6.0.12 What if I am a primary user who can see other companies’ 
information?
If this occurs, check the roles (collections of permissions) assigned to you. Most 
likely, you have been assigned a role that contains one of the following permissions:

■ IBU_USER_MGMT_VIEW_ALL_COMPANY

■ IBU_USER_MGMT_VIEW_ALL_ROLE

These two permissions should only be given to an administrator who has the 
privilege to view information across companies. 

11.6.0.13 How can a user’s address information be changed?
The application administrator or primary user can change the addresses and contact 
points (phone, fax, e-mail data) of a user by searching for the user in the 
administration screens, selecting the underlined hyperlink of the username, and 
selecting the Profile button. From there, the administrator or primary user can 
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navigate to appropriate user information from the hyperlink menu to the left of the 
Profile screens.

Users themselves can select the Profile button to access and change their address 
and contact points information.

11.6.0.14 What if I have removed a permission from a role and now I want to 
restore the original values of the role?
Re-run the driver that creates the permissions.

11.6.0.15 How can a user add more than three attachments to a service request?
On the service request creation screen in Oracle iSupport, there are enough 
rows/blank entry areas to add only three attachments. If a user wishes to add more 
than three attachments to the service request, this can be done by going ahead and 
creating the service request, and then accessing the details of the service request. In 
the Service Request Details screen, the user can add more attachments to the service 
request. Another way would be to zip (or compress or tar) the attachments into one 
file before attaching them to the service request.

11.6.0.16 How does selecting a default responsibility for users on the iSupport 
UI work?
A user can select a default responsibility from the Profile > Preferences menu. The 
next time the user logs in, the default responsibility chosen previously will be the 
default responsibility he logs in with. When the user selects the default 
responsibility, this overrides any default responsibility that the administrator has 
selected for the user. Conversely, if the administrator selects a default responsibility 
for the user from the Administration > Profile > Preferences menu, then when the 
user logs into the JTF login, the user will be logged in with the default responsibility 
chosen by the administrator. If a user logs in without a default responsibility having 
been set, then the user will be asked to choose from a list of responsibilities. This, 
however, can cause errors if the default responsibility the user selects in the prompt 
screen is for a Forms-based product. To avoid problems ensure that all users always 
have at least one responsibility defined.
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Profile Options

This chapter describes the profile option settings needed to implement Oracle 
iSupport. Topics include:

■ Before you Begin

■ About User Profile Options

■ How to Set Profile Options

■ JTT Profile Options

■ CRM User Management Profile Options

■ iSupport Service Request Profile Options

■ Service Core Profile Options

■ Returns Profile Options

■ Knowledge Management Profile Options

■ Miscellaneous Profile Options

A.1 Before you Begin
Before making Oracle Forms application settings, ensure that Oracle Forms 
application is up and running. All of the steps in this section require you to log onto 
Oracle Forms application with the sysadmin login.

A.2 About User Profile Options
A user profile is a set of changeable options that affect the way Oracle applications 
appear and how they function. Oracle Applications uses a set of user profile options 
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that are common to all the applications. In addition, each module has its own 
unique set of user profile options. 

For a complete list of profile options in the Oracle Application Object Library 
(AOL), see Oracle Applications System Administrator’s Guide.

The system administrator sets user profile options at four levels that have a set 
hierarchy. From lowest level to highest, the profiles categories are:

1. Site - Option settings pertain to all users at an installation site; has the lowest 
priority.

2. Application - Option settings pertain to all users of any responsibility 
associated with the application; has the next-to-lowest priority.

3. Responsibility - Option settings pertain to all users currently signed on under 
the responsibility; has the second-highest priority.

4. User - Option settings pertain to an individual user, identified by application 
username; has the highest priority.

Each user profile ordinarily exists at each level. For example, Oracle Applications 
provides a site-level Printer option, an application-level Printer option, a 
responsibility-level option, and so on. Oracle Applications enforced the level 
hierarchy to ensure that a higher-level option value overrides a lower-level value, 
with Site being the lowest and User the highest in the hierarchy. If, for example, you 
set your site-level Printer option to print to Printer 1, but your user-level Printer 
option is set to Printer 2, printing will occur at Printer 2. 

Site-level option values are generally set by the system administrator before profile 
options are specified at the other three levels. The options specified at site-level 
work as defaults until the same options are specified at the other levels. 

Changes to the user profile option values take effect as soon as your users log on 
again or change responsibilities.

A.3 How to Set Profile Options
Use the following procedure to set any profile option.

Steps
1. Log in to Oracle Forms with System Administrator responsibility.

2. Navigate to Profile > System. The Find System Profile Values window opens.

3. Check the level(s) at which you wish to set the profile option. 
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■ Site

■ Application - If you choose this level, from the Application LOV, select the 
application for which you wish to set the profile option.

■ Responsibility - If you choose this level, from the Responsibility LOV, 
select the responsibility for which you wish to set the profile option.

■ User - If you choose this level, from the User LOV, select the user for whom 
you wish to set the profile option.

4. In the Profile field, enter the a partial profile name followed by the percent sign 
as a wildcard. Example: IBU%. 

5. Select Find. The System Profile Values form opens with the results of your 
search.

6. Verify or set the profile option(s) at the levels that you selected.

7. Remember to save your work.

A.4 Setting CRM User Management Profile Options
The following is a list of profile options that affect the behavior of the CRM (JTF) 
User Management module. Set these profile options at the site level according to 
your requirements. 

For additional information on CRM User Management, please see the Oracle CRM 
Technology Foundation Concepts and Procedures, (user management chapters) and 
CRM Technology Foundation Implementation Guide (setting up users section).

■ JTF_UM_APPROVAL_URL - Defines the absolute patch of the login page 
(jtflogin.jsp) that an approver must go to in order to accept or reject a request. 
The URL is included in the workflow notification sent to each approver. The 
same URL is sent to the user once their request is accepted or rejected.

■ JTF_UM_MERCHANT_NAME - Defines the name of your organization. The 
workflow inserts this name into the request approvals and rejections when they 
are sent to the user.

■ JTF_UM_APPROVAL_OWNER - Set by default to sysadmin, this profile 
option is used in the approval process. If the last approver in a predefined 
approval definition fails to approve a request, the person defined in this profile 
option will be the escalation point of contact and will receive the request. The 
user specified as the value for this profile option must have the CRM_HTML_
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ADMINISTRATION responsibility and the JTF_REG_APPROVAL and JTF_
SECURITY_ASSIGN_ROLE permissions.

■ JTF_UM_APPROVAL_TIMEOUT_MINS - Defines (in minutes) how long a 
workflow notification remains in a queue before it is timed out. The default is 
1440 (1 day). If you enter 0 as the value, no time out occurs. If no value is set, 
the profile option is defaulted to 0.

Note: The Process Timeout field in the parameters window when starting the 
JTF Approval workflow must be set to Yes for this profile option to take effect.

■ JTF_REGISTRATION_CACHE - Determines whether the browser will cache 
the data entered by a user during the registration flow. The default value is Yes. 
If set to Yes and if the user presses the Back button, then the data entered on the 
previous page is available. If the profile option is set to No, then the data (page) 
expires as soon as the user leaves the page.

■ JTF_PRIMARY_USER - Predetermines the username that corresponds with the 
Universal Primary User Approver. 

■ JTF_INDIVIDUALUSER_ACCOUNT - When set to Yes, this profile option 
creates a new account (in the HZ_CUST_ACCOUNTS table) for each individual 
user. It also associates the user with the corresponding account. Users must 
have an account in order to purchase products through Oracle iStore.

A.5 CRM Technology Foundation (JTT) Profile Options
Several Oracle CRM Technology Foundation (JTT) profile options must be set for 
the Oracle iSupport UI to display. The values of the JTT profiles set the basic JTT 
Foundation default elements and values. These profiles are seeded in the Profiles 
form in ERP, and values are defined by the user (as System Administrator). 

These affect all users logged in with any responsibility that is associated with the 
application.

Steps
1. Log on to Oracle Forms as sysadmin/sysadmin.

2. Select the System Administrator responsibility.

3. Navigate to Profile > System > Find System Profile Values form.

4. Query the system for JTF profile options:

a. Check the Application checkbox. Uncheck the Site checkbox, if necessary.
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b. Enter iSupport in the Application field.

c. In the Profile field, enter JTF_PROFILE%, and select Find.

5. Verify and/or set the following JTF profile option for Oracle iSupport. Use the 
topic below, Finding Responsibility ID and Application ID Values, for 
assistance.

■ JTF_PROFILE_DEFAULT_RESPONSIBILITY - This value tells the system 
which responsibility to grant to users who are automatically approved by 
the system. This default responsibility ID will be different in every instance. 
Use the following steps to find this value.

Finding Responsibility ID and Application ID Values

Use the following steps to find the APPLICATION_ID and RESPONSIBILITY_
ID value of a responsibility.

a. Log in to Oracle Forms application as sysadmin. Select System 
Administrator responsibility. Navigate to Security > Responsibility > 
Define. The Responsibilities form opens.

b. From the top menu, select View > Find. Search for the responsibility that 
you wish to be the default responsibility, highlight it, and click Ok in the 
search window. The Responsibilities form is populated with the record for 
the selected responsibility.

c. With the cursor in any field of the record, select Help > Diagnostics > 
Examine. The Examine Field and Variable Values form opens.

d. In the Examine Field and Variable Values form, select APPLICATION_ID 
from the Field LOV. The Value field displays the value of APPLICATION_
ID.

e. In the Examine Field and Variable Values form, select RESPONSIBILITY_ID 
from the Field LOV. The Value field displays the value of 
RESPONSIBILITY_ID.

6. Verify and/or set these additional JTF profile options for Oracle iSupport:

■ JTF_PROFILE_DEFAULT_APPLICATION - 672.

This sets the default application. This must be set to the Oracle iSupport 
application ID, 672.

■ JTF_PROFILE_DEFAULT_BLANK_ROWS - 3

This sets the default number of blank rows in tables on the Oracle iSupport UI. 
It can be set to any integer greater than zero. The recommended value is 3.
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■ JTF_PROFILE_DEFAULT_CSS - jtfucss.css

This designates the default cascading style sheet to use for HTML display. The 
recommended value is jtfucss.css.

■ JTF_PROFILE_DEFAULT_CURRENCY - USD

This tells the application which country’s monetary currency to use as a default. 
Set it to USD for U.S. Dollars if this is what you wish the default currency to be.

■ JTF_PROFILE_DEFAULT_NUM_ROWS - 10

This tells the application how many rows to display when displaying tables on 
the UI. The recommended value is 10.

A.6 iSupport Service Request Profile Options
For the service request functionality to work in Oracle iSupport, you must set the 
following profile options in Oracle Forms. These profile values are specific to Oracle 
iSupport. For Oracle Support-TeleService profile options, please see the Oracle 
Support Implementation Guide. 

■ Oracle iSupport: Default Closed Status: This is the closed status of a service 
request when the user clicks the Close button. However, when status transition 
is used, sysadmin needs to make sure this status is a valid next status, otherwise 
the applications will error out. This value is mandatory, and can be set at 
application and site levels.

■ Oracle iSupport: Default Solved Status - This value determines the status of 
the service request when it is solved after knowledge base search in Oracle 
iSupport. This value is mandatory, and can be set at application and site levels.

■ Oracle iSupport: Default Updated Service Request Status: Determines the 
default state of a service request when it is updated.

■ Oracle iSupport: Service Request Creation Note Type: Determines the default 
Note Type when a Service Request is created. Not mandatory. Can be set at all 
levels.

■ Oracle iSupport: Service Request Update Note Type: Determines the default 
Note Type used when a Service Request is updated. Not mandatory. Can be set 
at all levels.

■ Oracle iSupport: Service Request Escalate Note Type: Determines the default 
Note Type when a Service Request is escalated.
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■ Oracle iSupport: Service Request Closed Note Type: Determines the default 
Note Type when a Service Request is closed.

■ Oracle iSupport: Search Knowledge Base Option: Determines whether a 
Knowledge Base Prompt shows up on the Service Request creation page or not, 
and whether or not the Knowledge Base search procedure is required. Not 
mandatory. Can be set at all levels.

■ Oracle iSupport: Enforce Product Selection Option: This value determines 
whether a product is mandatory while creating a service request. Not 
mandatory. Can be set at all levels.

■ Oracle iSupport: Service Request Reopen Time Limit in Hours: Set to the time 
limit in hours within which one can reopen a service request.

■ Oracle iSupport: Enable Service Request Template - Determines whether 
service request template is able to be used.

A.6.0.1 Obsolete iSupport SR Profile Options
■ Oracle iSupport: Service Request Product Category Set: This determines the 

default category set used when creating a service request.

A.6.0.2 Currently Unused iSupport SR Profile Options
■ Oracle iSupport: Enforce Entitlement Check Option: Determines whether an 

entitlement check will be enforced when creating a service request. Not 
mandatory. Can be set at all levels.

A.7 Service Core Profile Options
The following service core profile options can be set according to your business 
requirements.

■ Service: Use State Transition: Determines whether state transitions can be 
used. Set to Yes at the application level to use state transitions. For more 
information on state transitions, see the chapter, Integrating Oracle iSupport with 
Service Request.

■ Service: Default Service Request Severity: Determines the default severity of a 
created service request. 

■ Service: Default Service Request Status: Determines the default status of a 
created service request. 
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■ Service: Default Service Request Type: Determines the default type of a 
created service request. 

■ Service: Default Service Request Urgency: Determines the default urgency of a 
created service request. 

■ Service: Default Service Request Owner: Determines the default Resource ID 
when a Service Request is created. This should be set at the application level.

■ Service: Default Service Request Owner Type: Determines the default owner 
type of a created service request. 

■ Service: Default Product Category Set: Determines the default product 
category set for a service request. 

■ Service: Default Platform Category Set: Determines the default platform 
category set for a service request. 

■ Service: Inventory Validate Organization: Maps Inventory/Product 
Organization.source:

■ Service Item Flexfield (Product): This value determines the Oracle Inventory 
key flexfield structure you want to use when displaying the product. This value 
is mandatory; without it, the system will be unable to display the product 
number. It is recommended that you set this profile to MSTK. Set at application 
and site levels.

■ Service: Item Flexfield (Service): This value determines the Oracle Inventory 
key flexfield structure you want to use when displaying support services. This 
value is mandatory. It is recommended that you set this profile to MSTK. Set at 
application and site levels.

■ Service: System generated Service Request Number 

■ Service: Active Knowledge Base System - Selection for which integrated 
HTML based Knowledge Base System is being used. Allowed values: Oracle 
Basic Knowledge Base Search, Oracle Advanced Knowledge Base Search.

■ Service: Auto Launch Workflow - Determines whether Workflow launches 
automatically when a service request is created.

■ Service: Allow Updates Across Organizations - Allows users to make updates 
and deletions to data not belonging to their own operating units. Set to Yes.

■ Service: Default Make Public Flag 

■ Service: Publish Flag Update Allowed 

■ Service: Time Unit of Measure Class
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■ Service: Minute Unit of Measure

■ Service: Hour Unit of Measure 

■ Service: Day Unit of Measure - Identifies the unit of measure representing the 
day. This option is required.

■ Service: Month Unit of Measure 

■ Service: Item for facilitating conversions of units of time 

A.8 Returns Profile Options
The following profile options allow returns functionality in Oracle iSupport:

■ ASO: Default Order Type - This profile determines how the order is to be 
processed in Oracle Order Management. The order types are set up in Oracle 
Order Management. This profile also determines what price list and currency 
code appear by default in the main Quoting form. If this profile value is null, no 
default value is assumed. Set to Mixed.

■ ASO: Default Order State - Set to Booked.

■ ASO: Enable ASO Debug - Set to Yes to allow returns debugging. 

■ ASO: Product Organization - Defines which product organization to look for 
products. Note the space between the name ASO and the colon (:) in the name of the 
profile. Set this to your master organization.

■ ASO: Validate Salesrep - This profile is used to determine whether a Sales 
representative must be specified on a quote prior to creating an order. If this 
profile is set to Yes, a sales representative must be specified on the quote prior 
to creating an order. If this profile is set to No, then a sales representative will be 
defaulted from ASO: Default Salesrep. If this profile value is null, a default 
value of Yes is assumed. For Oracle iSupport, set this value to No.

■ OM: Debug Level - This profile option determines the level of debug messages 
printed in a OE Debug log file. To print all messages set it to 5 and for no 
messages set it to NULL. The default value is NULL.

■ OM: DEBUG LOG Directory - The directory path of the OM debug log file. 
Specify the value from the session parameter utl_file_dir from 
v$parameters. The default value is NULL. 
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A.9 Knowledge Management Profile Options
Knowledge Management has its own set of profile options. If you are implementing 
Knowledge Management, set the following profile options:

■ CS_KB_ALLOW_KB_NOTE_UPDATE - Allows the update of notes that have 
been saved to the Knowledge Base. Seeded value: No. Allowed values: No, Yes

■ CS_KB_DEFAULT_SOLUTION_TYPE - Allows you to define a specific 
Solution Type as a default. Allowed values: any. Seeded default values: 

■ KB_SYMPTOM

■ KB_FACT

■ KB_CHANGES

■ KB_CAUSE

■ KB_OBJECTIVE

■ KB_ACTION

■ CS_KB_DEF_CONTRIBUTION_STATUS - Default Status for Knowledge Base 
Contributions: You can use the status with user privileges to determine which 
users can see what information. Seeded default value: Draft. Allowed values:

■ DRAFT

■ PUBLIC

■ PUBLIC_INTERNAL

■ TECHNICAL_REVIEW

■ UNDER_EDIT

■ PUBLIC_LIMITED

■ CS_KB_MAX_SEARCH_RESULTS - Maximum Number of Search Results to 
be Queried from the Database: You can set up this value to any reasonable 
number. The top scored results in the database will be displayed from the 
highest score to the lowest score. Seeded default value: 100

■ CS_KB_PRODUCT_CATEGORY_SET - Service: Default Knowledge Base 
Category Set. This selects the Product Category Set to populate the Product 
LOV in the Knowledge Management screens. 
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A.10 Miscellaneous Profile Options
A number of profile options categorized here as miscellaneous should be set at the 
site-level.

■ MO: Operating Unit - Set this to your master organization.

■ OE: Item Validation Organization - Set this to your master organization.

■ iSupport: Mandatory Layout Time Stamp - Determines the value for the time 
stamp recorded on creation of a mandatory layout.

■ APPS_SERVLET_AGENT - This is the URL that will be used to call JSP forms 
from applications menus. Set to the URL for the Apache server.
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Seed Data

This appendix addresses that data that ships with Oracle iSupport as seed data, or 
data that is shipped "out-of-the-box". Covered here are: 

■ Seeded Menus

■ Seeded Functions

■ Seeded User Responsibilities

■ Seeded User Roles

■ Seeded Permissions

■ Oracle Knowledge Management Seed Data

B.1 Seeded Menus
This section lists menus associated with the application.

B.1.1 Oracle iSupport Menus
The table below, Oracle iSupport Menus, shows the main menus and a description 
of each menu.

Table B–1 Oracle iSupport Menus

Menu Description

IBU_A_FB_MENU Administration > Survey

IBU_A_FORUM_MENU Administration > Forum

IBU_A_FR_CATEGORY_MENU Administration > Forum > Category

IBU_A_FR_FORUM_MENU Administration > Forum > Forum
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B.1.2 Oracle iSupport Top Menus by User Type
The table below, Oracle iSupport Top Menus by User Type, shows the top menus by 
user type.

IBU_A_FR_USERGROUP_MENU Administration > Forum > Usergroup

IBU_A_PROFILE_MENU Administration > Homepage

IBU_A_RM_MENU Administration > Support > Request Management

IBU_A_ROOT_MENU Administration tabs: User, Homepage, etc.

IBU_A_SUB Administration > Homepage > Subscription

IBU_A_SUPPORT_MENU Administration > Support

IBU_A_USER_MENU Administration > User

IBU_BUS_USER_PROFILE_MENU Profile menu for B2B user

IBU_BUS_USER_TOP_MENU Top menu for iSupport B2B user

IBU_EMPL_ISUPPORT_MENU iSupport menu for iSupport employee user

IBU_EMPL_REQ_MENU Support menu for employee users

IBU_EMPL_USER_TOP_MENU Top menu for iSupport employee user

IBU_HOME_MENU iSupport > Home

IBU_IB_MENU Home > Products

IBU_IND_USER_PROFILE_MENU User profile menu for iSupport B2C user

IBU_IND_USER_TOP_MENU Top menu for iSupport B2C user

IBU_INQ_MENU iSupport > Account (for normal_user responsibility)

IBU_ISUPPORT_MENU iSupport (primary user iSupport menu)

IBU_PRI_USER_REQ_MENU iSupport > Support menu (for iSupport primary user)

IBU_PRI_USER_TOP_MENU Top menu for iSupport primary user

IBU_PROFILE_ACCOUNT_MENU Menu for account settings

IBU_PROFILE_COMPANY_MENU Company profile menu

IBU_PROFILE_MENU Menu for iSupport settings

IBU_PROFILE_USER_MENU User profile menu

IBU_REQ_MENU Home > Support

IBU_ROOT_MENU iSupport (normal_user responsibility)

IBU_ROOT_PROFILE_MENU Root menu for profile

Table B–1 Oracle iSupport Menus

Menu Description
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B.2 Oracle iSupport Functions
The table below, Oracle iSupport Functions, shows the functions which are linked to 
menus, along with a description of each function.

Table B–2 Oracle iSupport Top Menus by User Type

Menu Description

IBU_BUS_USER_TOP_MENU Top menu for iSupport B2B User

IBU_EMPL_USER_TOP_MENU Top menu for iSupport B2E User

IBU_IND_USER_TOP_MENU Top menu for iSupport B2C User

IBU_PRI_USER_TOP_MENU Top menu for iSupport Primary User

IBU_NORMAL_USER_TOP_MENU Top menu for iSupport Administrator

IBU_GUEST_USER_TOP_MENU Top menu for iSupport Guest User, not currently used

Table B–3 Oracle iSupport Functions

Function Description

IBU_ACCOUNT_CONTACT not used

IBU_A_CAT_FN Administration > Support > Technical Library

IBU_A_CM_FN Administration > Support > Call Me

IBU_A_FB_LIST_FN Administration > Survey > Feedback List

IBU_A_FR_CT_CREATE_FN Administration > Category > Create

IBU_A_FR_CT_DELETE_FN Administration > Category > Delete

IBU_A_FR_CT_MODSTATUS_FN Administration > Category > Modify

IBU_A_FR_CT_RENAME_FN Administration > Category > Rename

IBU_A_FR_FR_CREATE_FN Administration > Forum > Create

IBU_A_FR_FR_DELETE_FN Administration > Forum > Delete

IBU_A_FR_FR_MODATTR_FN Administration > Forum > Modify Attribute

IBU_A_FR_FR_MODSTATUS_FN Administration > Forum > Modify Status 

IBU_A_FR_FR_MOVE_FN Administration > Forum > Move 

IBU_A_FR_FR_RENAME_FN Administration > Forum > Rename 

IBU_A_FR_MESSAGE_FN Administration > Forum > Messages 

IBU_A_FR_UG_ASSC_FN Administration > Forum > Associate Usergroup 

IBU_A_FR_UG_DISASSC_FN Administration > Forum > Disassociate Usergroup 

IBU_A_PZ_FN Administration > Homepage > Personalize
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IBU_A_RM_FN Administration > Support > Request Management 

IBU_A_RM_TEMPLATE_FN Administration > Support > Request Management > Template 

IBU_A_RPT_FN Not used in generic product.

IBU_A_SUB_FN Administration > Homepage > Subscription subtab

IBU_A_TM_FN Administration > Subscription > Template

IBU_A_UG_FN Administration > Support > Usergroup

IBU_A_USER_APPROVALS_FN Administration > User > Pending Approvals

IBU_A_USER_FN Administration > Users

IBU_CMN_FORUM Forum tab 

IBU_COMPANY_ADDRESS Profile > Company address

IBU_COMPANY_ADMIN Profile > Company Administrators 

IBU_COMPANY_CONTACT_POINTS Profile > Contact points of company 

IBU_COMPANY_INFORMATION Profile > Company Information 

IBU_GEN_PREF Profile > General Preferences 

IBU_HLP_CALLME Support > Call Me 

IBU_HLP_FEEDBACK Support > Survey

IBU_HOM_HOME iSupport Home

IBU_INQ_ACCOUNT Accounts

IBU_INQ_CONTRACTS Accounts > Contracts

IBU_INQ_DEFECTS Defects

IBU_INQ_INSTALLBASE Install Base

IBU_INQ_INSTALLBASEREPORT Install Base Report

IBU_INQ_INSTALLBASE_ADDPRODUCT Install Base Add Product

IBU_INQ_INSTALLBASE_BUILT Install Base as Built

IBU_INQ_INSTALLBASE_SUMMARY Install Base Summary

IBU_INQ_INVOICES Accounts > Invoices

IBU_INQ_ORDERS Accounts > Orders

IBU_INQ_PAYMENTS Accounts > Payments

IBU_INQ_RMAS Accounts > Returns

IBU_PERSONAL_PROFILE Profile button

IBU_PROFILE_CONTRACT not used

Table B–3 Oracle iSupport Functions

Function Description
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B.3 Seeded User Responsibilities
The table below, Oracle iSupport User Responsibilities, displays seeded user 
responsibilities and their descriptions for Release 11.5.6.

IBU_PROFILE_GENERAL Profile > User Profile > Support

IBU_REQ_ASKME Search Knowledge Base

IBU_REQ_CREATESR Support > Create Service Requests

IBU_REQ_VIEWSR Support > View Service Requests

IBU_SYSTEM_ADD not used

IBU_SYSTEM_ADM not used

IBU_SYSTEM_CSI not used

IBU_SYSTEM_LIC not used

IBU_SYSTEM_PRF not used

IBU_SYSTEM_ROL not used

IBU_SYSTEM_USR not used

IBU_USER_ACCOUNTS Profile > User Profile > Accounts

IBU_USER_ADDRESSES Profile > User Profile > Addresses

IBU_USER_CONTACTPOINTS Profile > User Profile > Contact Points

IBU_USER_CONTRACTS not used

Table B–4 Oracle iSupport User Responsibilities

Responsibility Description

IBU_BUSINESS_USER_RESP iSupport Business (B2B) Users

IBU_INDIVIDUAL_USER_RESP iSupport Individual (B2C) User

IBU_EMPLOYEE_USER_RESP iSupport Employee (B2E) Users

IBU_PRIMARY_USER_RESP iSupport Primary User

IBU_SYS_ADMIN No longer used.

IBU_GUEST For guest user, not currently used

IBU_NORMAL_USER For iSupport Administrator user

Table B–3 Oracle iSupport Functions

Function Description
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B.4 Seeded User Roles
This section contains information about seeded roles and permissions, including:

B.4.1 User Roles
The table below, Oracle iSupport User Roles, displays seeded user roles and their 
descriptions for Release 11.5.6.

B.4.2 Oracle iSupport User Roles by User Type
The table below, Oracle iSupport User Roles by User Type, displays Oracle iSupport 
typical users and the roles they must receive to receive their appropriate 
permissions.

B.5 Seeded Permissions
This section displays the user roles and the permissions that they contain.

The table below, Oracle iSupport Permissions, displays the permissions associated 
with the seeded user roles.

Table B–5 Oracle iSupport User Roles

Role Description

IBU_REG_USER Contains permissions for standard B2B and B2C users.

IBU_B2B_PRIMARY_USER_MANAGEMENT Contains permissions for standard iSupport Primary User.

IBU_EMPLOYEE Contains permissions for standard Employee User.

IBU_SYSTEM_ADMIN Contains permissions for standard iSupport Administrator.

Table B–6 Oracle iSupport User Roles by User Type

User Roles Assigned

B2C, B2B users IBU_REG_USER

Primary User IBU_REG_USER, IBU_B2B_PRIMARY_USER_MANAGEMENT

Employee User IBU_REG_USER, IBU_EMPLOYEE

iSupport Administrator IBU_REG_USER, IBU_SYSTEM_ADMIN
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Table B–7 Oracle iSupport Permissions 

Role Permissions

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_USER_MGMT

IBU_USER_MGMT_VIEW_COMPANY_USER

IBU_USER_MGMT_VIEW_MY_ROLE

JTF_PRIMARY_USER_SUMMARY

IBU_ADMIN_UPDATE

IBU_ADMIN_VIEW

IBU_REG_USER CSI_ACCT_ACCESS_ONLY

CSI_ADDI_ATTR_UPDATE

CSI_ADDI_ATTR_VIEW

CSI_CONTACT_DETAIL_UPDATE

CSI_CONTACT_DETAIL_VIEW

CSI_CONTRACT_UPDATE

CSI_CONTRACT_VIEW

CSI_CREATE_INST_UPDATE

CSI_CREATE_INST_VIEW

CSI_GENERAL_ATTRIB_CUST_ONLY

CSI_INST_CONFIG_UPDATE

CSI_INST_CONFIG_VIEW

CSI_INST_GENERAL_UPDATE

CSI_INST_GENERAL_VIEW

CSI_LATEST_TRANSACTION_UPDATE

CSI_LATEST_TRANSACTION_VIEW

CSI_PARTY_CONTACT_UPDATE

CSI_PARTY_CONTACT_VIEW

CSI_PERZ_EDIT_UPDATE

CSI_PERZ_EDIT_VIEW
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IBU_REG_USER (cont.) CSI_PRICING_UPDATE

CSI_PRICING_VIEW

CSI_PROPERTY_READ

CSI_REPAIR_ORDER_UPDATE

CSI_REPAIR_ORDER_VIEW

CSI_SEARCH_PRODUCT_UPDATE

CSI_SEARCH_PRODUCT_VIEW

CSI_SERVICE_REQUEST_UPDATE

CSI_SERVICE_REQUEST_VIEW

CSI_SHOW_EXT_CONTACTS

CSI_SHOW_EXT_LOCATIONS

CSI_SHOW_EXT_PARTIES

CSI_SHOW_INST_CUSTOMER_MENU

CSI_SPLIT_QUANTITY_UPDATE

CSI_SPLIT_QUANTITY_VIEW

CSI_TRANSACTION_DETAIL_UPDATE

CSI_TRANSACTION_DETAIL_VIEW

CSI_TRANSACTION_INSTANCE_UPDATE

CSI_TRANSACTION_INSTANCE_VIEW

CS_Freq_Used_Sol_View

CS_Products_Add

CS_Products_Delete

CS_Products_Update

CS_Products_View

CS_Rec_Sol_View

CS_Solution_View

CS_Solution_View_All

Table B–7 Oracle iSupport Permissions 

Role Permissions
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IBU_REG_USER (cont.) IBU_CallMe

IBU_Contracts_View

IBU_Defects_View

IBU_Forum

IBU_Forum_View_Restrict

IBU_Homepage

IBU_Homepage_Update

IBU_Invoices_View

IBU_Orders_View

IBU_Patch_View

IBU_Payments_View

IBU_Profile_Update

IBU_Request_Close

IBU_Request_Create

IBU_Request_Escalate

IBU_Request_Update

IBU_Request_View

IBU_Request_View_Company

IBU_Returns_Add

IBU_Returns_View

IBU_Role_Mgt

IBU_Survey_Create

IBU_Technical_Library_View

IBU_User_Mgt

IBU_SYSTEM_ADMIN CS_Assoc_Ext_Obj_To_Sol

CS_Assoc_Ext_Obj_To_Stmt

CS_Categories_View

Table B–7 Oracle iSupport Permissions 

Role Permissions
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IBU_SYSTEM_ADMIN (cont.) CS_EMPLOYEE_CONTACT_ADD

CS_Freq_Used_Def_Update

CS_Freq_Used_Def_View

CS_Freq_Used_Sol_View

CS_PROPERTY_UPDATE

CS_Products_Add

CS_Products_Delete

CS_Products_Report

CS_Products_Update

CS_Products_View

CS_Rec_Sol_Update

CS_Rec_Sol_View

CS_Solution_Create

CS_Solution_Delete

CS_Solution_Status_Update

CS_Solution_Update

CS_Solution_View

CS_Solution_View_All

CS_Solution_View_B

CS_Solution_View_Internal

CS_Solution_View_Public

CS_Solution_View_Restricted

CS_Statement_Create

CS_Statement_Delete

CS_Statement_Global_Update

CS_Statement_Update

CS_Statement_View

Table B–7 Oracle iSupport Permissions 

Role Permissions
B-10 Oracle iSupport Implementation Guide



Oracle Knowledge Management Seed Data
B.6 Oracle Knowledge Management Seed Data
The following sections contain information on Oracle Knowledge Management seed 
data.

IBU_SYSTEM_ADMIN (cont.) CS_Types_Edit

CS_Types_View

CS_Workflow_Setup_View

IBU_Forum_Category_Edit

IBU_Forum_Edit

IBU_Forum_Messages_Edit

IBU_Forum_User_Group_Edit

IBU_Personalized_Homepage_Edit

IBU_Request_Management_Edit

IBU_Subscription_Edit

IBU_Survey_Import

IBU_TEMPLATE_MANAGEMENT

IBU_USER_MGMT

IBU_USER_MGMT_VIEW_ALL_ROLE

IBU_USER_MGMT_VIEW_ALL_USER

IBU_USER_MGMT_VIEW_COMPANY_USER

IBU_USER_MGMT_VIEW_MY_ROLE

IBU_User_Group_Edit

JTF_DAC_Maintain

JTF_REG_APPROVAL

JTF_SECURITY_ASSIGN_ROLE

IBU_ADMIN_UPDATE

IBU_ADMIN_VIEW

Table B–7 Oracle iSupport Permissions 

Role Permissions
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B.6.1 User Role to Permission Mapping
The following tables summarize Roles to Permissions mapping.

B.6.1.1 Oracle Knowledge Management Administrator
An Oracle Knowledge Management Administrator has all Oracle KM-specific 
permissions, including all setup and other process-oriented permissions. 

The following table, Permissions for Oracle KM Administrators, lists the 
permissions associated with Oracle Knowledge Management Administrator role, 
CS_SYSTEM_ADMIN.

Table B–8 Permissions for Oracle KM Administrators

Permission Description

CS_Solution_View View Published Solutions

CS_Solution_Create Create a Solution, Add Attachments and Comments

CS_Assoc_Ext_Obj_To_Sol Associate External Object to a Solution

CS_Solution_Update Update a Solution

CS_Solution_Delete Delete a Solution

CS_Solution_View_
Internal

View Work-In-Progress Solutions

CS_Solution_Status_
Update

Update Solution Status

CS_Freq_Used_Def_View View Frequently Used Definitions

CS_Freq_Used_Def_
Update

Update Frequently Used Definition

CS_Freq_Used_Sol_View View Frequently Used Solutions

CS_Rec_Sol_View View Recommended Solutions

CS_Rec_Sol_Update Update Recommended Solutions

CS_Statement_View View a Statement

CS_Statement_Create Create a Statement

CS_Statement_Delete Delete a Statement

CS_Statement_Update Update a Statement

CS_Statement_Global_
Update

Update a Statement Being Linked to More Than One Solution
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B.6.1.2 Oracle KM Knowledge Worker
A knowledge worker creates/edits/technically reviews information in Oracle 
Knowledge Management. The following table, Roles and Permissions Associated 
with Oracle KM Workers, lists role and permissions associated with an Oracle 
Knowledge Management Worker

CS_Type_View View a Statement Type and a Solution Type

CS_Type_Edit Create and Edit Solution Types and Statement Types

CS_Assoc_Ext_Obj_To_
Stmt

Associate an External Object to a Statement

CS_Workflow_Setup_View View Workflow Setup Screens

CS_Categories_View View Categories

Table B–8 Permissions for Oracle KM Administrators

Permission Description
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.

B.6.1.3 Oracle KM Agent
An Oracle Knowledge Management Agent interfaces with the customers directly 
(on the phone) or indirectly (online) to record their problems and provides them 
existing solutions or creates new solutions.

The following table, Roles and Permissions Associated with Oracle KM Agent, lists 
role and permissions associated with an Oracle Knowledge Management Agent.

Table B–9 Role and Permissions Associated with Oracle KM Workers

Role Permissions/Description

CS_KNOWLEDGE_
WORKER 

CS_Solution_View (View Published Solutions)

CS_Solution_Create (Create a Solution, Add Attachments and 
Comments)

CS_Assoc_Ext_Obj_To_Sol (Associate External Object to a 
Solution)

CS_Solution_Update (Update a Solution)

CS_Solution_Delete (Delete a Solution)

CS_Solution_View_Internal (View Work-In-Progress Solutions)

CS_Solution_Status_Update (Update Solution Status)

CS_Freq_Used_Def_View (View Frequently Used Definitions)

CS_Freq_Used_Sol_View (View Frequently Used Solutions)

CS_Rec_Sol_View (View Recommended Solutions)

CS_Statement_View (View a Statement)

CS_Statement_Create (Create a Statement)

CS_Statement_Delete (Delete a Statement)

CS_Statement_Update (Update a Statement)

CS_Type_View (View a Statement Type and a Solution Type)

CS_Type_Edit (Create and Edit Solution Types and Statement 
Types)

CS_Assoc_Ext_Obj_To_Stmt (Associate an External Object to a 
Statement)
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Table B–10 Role and Permissions Associated with Oracle KM Agent

Role/Description Permissions/Description

CS_SUPPORT_AGENT CS_Solution_View (View Published Solutions)

CS_Solution_Create (Create a Solution, Add Attachments and 
Comments)

CS_Solution_View_Internal (View Work-In-Progress Solutions)

CS_Statement_Create (Create a Statement)

CS_Type_View (View a Statement Type and a Solution Type)

CS_Statement_View (View a Statement)

CS_Freq_Used_Sol_View (View Frequently Used Solutions)
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Oracle iSupport APIs

This chapter describes the public APIs that are a part of Oracle iSupport. Topics 
include:

■ Oracle CRM API Overview

■ Oracle iSupport APIs

■ Package oracle.apps.ibu.requests Overview

■ Interface ServiceRequest

■ Interface ServiceRequestUtil

■ Interface SRConstant

■ Class ServiceRequestFactory

■ Class ServiceRequestInfo

■ Class NoteInfo

■ Class ProductInfo

■ Class ViewServiceRequest

C.1 Oracle CRM API Overview
Oracle CRM Division classifies its APIs into the following types:

C.1.0.1 Private APIs
Private APIs are for internal development use only. Details are not provided to 
anyone outside of the immediate development environment, nor are they intended 
for use by anyone outside of the CRM development environment.
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C.1.0.2 Public APIs
Public APIs are designed so that customers and/or Oracle consultants can interface 
non-Oracle systems into CRM or extend the functionality of the base products. 
However, unless published, they are not supported by Oracle, and users exploit 
them at their own risk.

There are two types of Public APIs:

Public, published APIs - Oracle guarantees that this type will remain valid from 
release to release and that Oracle-released software patches will not alter the API 
behavior. Public, published APIs are supported by Oracle to the same extent as 
released software.

Public, non-published APIs are not guaranteed by Oracle. Oracle makes no 
guarantees regarding the consistency of naming, usage, or behavior (public or 
private) between releases. It is also possible that a patch could alter any 
characteristic of any non-published CRM API. As such, those who choose to use 
these APIs do so at their own risk. Having said that, Oracle does attempt to 
minimize all changes to public APIs, even if not published.

C.2 Oracle iSupport API Overview
Oracle iSupport has one public, published API package:

■ oracle.apps.ibu.requests

C.3 Package oracle.apps.ibu.requests Overview
This package provides support for the service request functionality in Oracle 
iSupport.

C.3.1 Package oracle.apps.ibu.requests Interface Summary
The following table, Package oracle.apps.ibu.requests Interface Summary, shows the 
public, published interfaces within the package oracle.apps.ibu.requests.

Table C–1 Package oracle.apps.ibu.requests Interface Summary

Interface Summary

ServiceRequest Defines a set of methods that can be applied to a service 
request.
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C.3.2 Package oracle.apps.ibu.requests Class Summary
The following table, Package oracle.apps.ibu.requests Class Summary, shows the 
public, published classes within the service request package. 

C.4 Interface ServiceRequest
The interface ServiceRequest defines a set of methods that can be applied to a 
service request. Classes implementing this interface will be instantiated by 
ServiceRequestFactory class.

C.4.1 ServiceRequest Field Information
The table below is the field information for the ServiceRequest interface.

ServiceRequestUtil Defines a set of methods that helps retrieve relevant data about 
a service request.

SRConstant Defines the constant that can be used in JSP and in 
constructing a view object.

Table C–2 Package oracle.apps.ibu.requests Class Summary

Class Name Summary

ServiceRequestFactory Creates an appropriate instance of ServiceRequest and 
ServiceRequestUtil interfaces based on conditions such as 
Oracle Rollout flag, etc. 

ServiceRequestInfo This is a data object that stores information about a service 
request.

NoteInfo This is a data object that holds note information attached to a 
service request.

ProductInfo This is a data object that stores product information.

ViewServiceRequest This is an abstract class used to search service requests.

public static java.lang.String RCS_ID

public static final boolean RCS_ID_RECORDED

Table C–1 Package oracle.apps.ibu.requests Interface Summary

Interface Summary
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C.4.2 ServiceRequest Method Index
The table below is a method index of this interface.

C.4.3 ServiceRequest Method Detail
Following are the details of the methods in the ServiceRequest interface.

Method Description

void close Closes a service request.

void create Creates a service request.

void escalate Escalates a service request.

IDNamePair[] fetchAttachment Fetches the attachments associated with a service 
request.

IDNameNumber[] fetchAttachment2 Fetches the attachments associated with a service 
request.

java.lang.String[][] fetchBugInfo Fetches related bug information for a service 
request.

ContactInfo[] fetchContactInfo Fetches the contact information about a service 
request.

ServiceRequestInfo fetchDetail Fetches the detail of a service request from a 
service request number.

void fetchNotes Fetches all notes attached to an SR.

void fetchNoteSolutionAudit Fetch the note, solution, and audit history 
together.

IDNamePair fetchPrimaryContractInfo Fetch the primary contract information about a 
service request.

boolean isClosed Check if a service request is closed.

boolean isReopenOK Test if one closed service request can be reopend 
or not.

void sendEmail Sends the confirmation of the service request to 
the email address.

void update Updates a service request with a note and/or 
attached files.
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close
public void close (IBU Parameters ibuParam, ServiceRequestInfo srInfo)

Closes a service request.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

srInfo - service request information

create
public void create (IBU Parameters ibuParam, ServiceRequestInfo srInfo)

Creates a service request.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

srInfo - service request information

escalate
public void escalate (IBU Parameters ibuParam, ServiceRequestInfo srInfo)

Escalates a service request.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

srInfo - service request information

fetchAttachment
public IDNamePair [] fetchAttachment (IBUParameters ibuParam, long srID)

Fetches the attachments associated with a service request.

Throws: java.lang.Exception if error.

Returns: the attachments of the service request

Parameters:
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ibuParam - standard IBU parameter

srID - the service request id

fetchAttachment2
public IDNameNumber [] fetchAttachment2 (IBUParameters ibuParam, long srID)

Fetches the attachments associated with a service request.

Throws: java.lang.Exception if error.

Returns: the attachments of the service request. id = file ID, name = name, number 
= description

Parameters:

ibuParam - standard IBU parameter

srID - the service request id

fetchBugInfo
public java.lang.String [] [] fetchBugInfo (IBUParameters ibuParam, long srID)

Fetches the related bug information for a given service request.

Throws: java.lang.Exception if error.

Returns: the String containing the bug information

Parameters:

ibuParam - standard IBU parameter

srID - the service request id

fetchContactInfo
public ContactInfo [] fetchContactInfo (IBUParameters ibuParam, java.lang.String 
srNum, boolean primary)

Fetches the contact information about a service request.

Throws: java.lang.Exception if error.

Returns: the contact information about a service request

Parameters:

ibuParam - standard IBU parameter
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srNum - the service request number

fetchDetail
public ServiceRequestInfo fetchDetail (IBUParameters ibuParam, java.lang.String 
srNum)

Fetches the detail of a service request from the service request number.

Throws: java.lang.Exception if error.

Returns: the service request information

Parameters:

ibuParam - standard IBU parameter

srNum - the service request number

fetchNotes
public void fetchNotes (IBUParameters ibuParam, ServiceRequestInfo srInfo, 
boolean ascending)

Fetches all notes attached to a service request.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

srInfo - the service request information; the notes of the service request are 
stored in srInfo.notes

ascending - the order of the result

fetchNoteSolutionAudit
public void fetchNoteSolutionAudit (IBUParameters ibuParam, 
ServiceRequestInfo srInfo, boolean ascending, boolean showDetail)

Fetches the note, solution, and audit history together. The result is stored in 
srInfo.otherInfo1 as a String array format.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter
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srInfo - the service request information

ascending - the order of the result

fetchPrimaryContactInfo
public IDNamePair fetchPrimaryContactInfo (IBUParameters ibuParam, 
java.lang.String srNum)

Fetches the primary contact information about a service request.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

srNum - the service request number

isClosed
public boolean isClosed (IBU Parameters ibuParam, ServiceRequestInfo srInfo)

Checks whether a service request is closed or not. 

Throws: java.lang.Exception if error.

Returns: true if the service request is closed, false if it is open.

Parameters:

ibuParam - standard IBU parameter

srInfo - the service request information; the notes of the service request are 
stored in srInfo.notes

isReopenOK
public boolean isReopenOK (IBU Parameters ibuParam, long srID)

Tests if one closed service request can be reopened or not.

Throws: java.lang.Exception if error.

Returns: true if the service request can be reopened, false if it cannot be reopened.

Parameters:

ibuParam - standard IBU parameter

srID - the service request id
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sendEmail
public void sendEmail (IBU Parameters ibuParam, java.lang.String srNum)

Sends the confirmation of the service request to the e-mail address.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

email - the email address

msgbody - the email message body (includes confirmation of the service 
request)

subject - subject of the email

update
public void update (IBU Parameters ibuParam, ServiceRequestInfo srInfo)

Updates a service request with a note and/or attached files.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

srInfo - the service request information; the notes of the service request are 
stored in srInfo.notes

C.5 Interface ServiceRequestUtil
The interface Service RequestUtil defines a set of methods that help get relevant 
data about a service request. Classes implementing this interface will be instantiated 
by ServiceRequestFactory class.

C.5.1 ServiceRequestUtil Field Information
The table below is the field information for the ServiceRequestUtil interface.

static String RCS_ID

static boolean RCS_ID_RECORDED
Oracle iSupport APIs C-9



Interface ServiceRequestUtil
C.5.2 ServiceRequestUtil Method Index
The table below is a method index of this interface.

Method Description

void addAttachment Adds attachments to a service request

void addKBLink Adds knowledge base link to service request.

IDNamePair[] fetchDateOptions Returns the service request date range options.

ProductInfo[] fetchInstalledBaseProducts Fetches all Install Base products based on the 
search conditions.

IDNameNumber[] fetchInvItems Fetches the available inventory items based on 
search criteria and range.

String [] fetchItemVersion Fetches all valid versions associated to an 
inventory item.

KeyDescPair[] fetchNoteType Fetches all service request note types.

IDNameNumber [] fetchPlatform Fetches all available platforms.

KeyDescPair [] fetchProblemCodes Fetches all valid problem codes.

IDNamePair [] fetchProductVersion Fetches all valid versions associated to a product.

IDNamePair [] fetchRequestTypes Fetches all valid service request types.

IDNamePair [] fetchSeverities Fetches all valid service request severities.

IDNamePair [] fetchStatuses Fetches all valid service request statuses.

IDNamePair [] fetchUrgencies Fetches all valid service request urgencies.

String lookupContract Looks up the contract number of a contract id.

String lookupInventoryItem Looks up the inventory item name and 
description.

long lookupInventoryItemFromProduct Looks up the inventory item id of a product.

String lookupNoteDetail Looks up the note detail of a note.

String lookupOwnerName Looks up the owner name from the resource id.

String lookupPlatform Looks up the name and description of a platform.

String lookupProblem Looks up the problem code and description.

String lookupProduct Looks up the product name and description.
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C.5.3 ServiceRequestUtil Method Detail
Following are the details of the methods in the ServiceRequestUtil interface.

addAttachment
public void addAttachment (IBUParameters ibuParam, IDNamePair [] attachFiles, 
long srID, long loginID)

Adds attachments to a service request.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

attachFiles - the fileID and description

srID - the service request ID

loginID - the login ID

addKBLink
public void addKBLink (IBUParameters ibuParam, String docID, long srID, 
boolean success)

Adds knowledge base link to a service request.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

docID - the document ID in CSV format  

String lookupProductVersion Looks up the product version name for the 
version id.

String lookupRequestType Looks up the request type name of a request type 
id.

String lookupSeverity Looks up the severity name.

String lookupStatus Looks up the status name of a status id.

String lookupUrgency Looks up the urgency name.

Method Description
Oracle iSupport APIs C-11



Interface ServiceRequestUtil
srID - the service request ID

success - successful document or unsuccessful document

fetchDateOptions
public IDNamePair [] fetchDateOptions 

Returns the service request date range options.

fetchInstalledBaseProducts
public ProductInfo [] fetchInstalledBaseProducts (IBUParameters ibuParam, 
Hashtable params, int startPage, int batchSize, int[] totalCount)

Fetches the Install Base products based on search conditions.

Throws: java.lang.Exception if error.

Parameters:

conn - the OracleConnection

params - the parameters for searching

accountID - the account ID (mandatory)

productName - the product name (optional)

productDesc - the product description (optional)

fetchInvItems
public IDNameNumber [] fetchInvItems (IBUParameters ibuParam, 
java.util.Hashtable params, int startPage, int batchSize, int[] totalCount)

Fetches the available inventory items based on search criteria and range.

Throws: java.lang.Exception if error.

Returns: the array of IDNameNumber, where ID is the inventory item ID, Name is 
the iten name, Number is the item description

Parameters:

ibuParam - standard IBU parameter

params - search criteria

invItemName - inventory item name

invItemDesc - inventory item description
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startPage - the start page number, 0-based

batchSize - the number of records per page

totalCount - the total number of records satisfying the search criteria

fetchItemVersion
public String [] fetchItemVersion (IBUParameters ibuParam, long itemID)

Fetches all valid versions associated to an inventory item.

Throws: Exception if error.

Returns: the valid versions

Parameters:

ibuParam - standard IBU parameter

productID - the inventory item id

fetchNoteType
public KeyDescPair [] fetchNoteType (IBUParameters ibuParam)

Fetches all service request note types.

Returns: an array of KeyDesc pair, with note type code and note type meaning

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

fetchPlatform
public IDNameNumber [] fetchPlatform (IBUParameters ibuParam, String 
findName, String findDesc, int startPage, int batchSize, int [] totalCount)

Fetches the available platform based on search criteria.

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

findName - the search name

findDesc - the search description
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startPage - the start page, 0-based

batchSize - the number of records per page

totalCount - the total number of records satisfying the search criteria

fetchProblemCodes
public KeyDescPair [] fetchProblemCodes (IBUParameters ibuParam)

Fetches all valid problem codes.

Throws: Exception if error.

Returns: the valid problem codes.

Parameters:

ibuParam - standard IBU parameter

fetchProductVersion
public IDNamePair [] fetchProductVersion  (IBUParameters ibuParam, long 
productID)

Fetches all valid versions associated to a product.

Throws: Exception if error.

Returns: the valid versions

Parameters:

ibuParam - standard IBU parameter

productID - the product id

fetchRequestTypes
public IDNamePair fetchRequestTypes (IBUParameters ibuParam)

Fetches all valid service request types.

Throws: Exception if error.

Parameters:

ibuParam - standard IBU parameter

fetchSeverities
public IDNamePair [] fetchSeverities  (IBUParameters ibuParam)
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Fetches all valid service request severities.

Throws: Exception if error.

Returns: the valid service request severities.

Parameters:

ibuParam - standard IBU parameter

fetchStatuses
public IDNamePair [] fetchStatuses  (IBUParameters ibuParam)

Fetches all valid service request statuses.

Throws: Exception if error.

Returns: the valid service request statuses.

Parameters:

ibuParam - standard IBU parameter

fetchUrgencies
public IDNamePair [] fetchUrgencies  (IBUParameters ibuParam)

Fetches all valid service request statuses.

Throws: Exception if error.

Returns: the valid service request urgencies.

Parameters:

ibuParam - standard IBU parameter

lookupContract
public java.lang.String lookupContract  (IBUParameters ibuParam, java.lang.String 
contractID)

Looks up the contract number of a contract id.

Returns: the version name

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter
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version - the contract ID

lookupInventoryItem
public java.lang.String lookupInventoryItem  (IBUParameters ibuParam, long 
itemID)

Looks up the inventory item name and description.

Returns: the name and description of the inventory item ID

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

itemID - the inventory item ID

lookupInventoryItemFromProduct
public long lookupInventoryItemFromProduct  (IBUParameters ibuParam, long 
productID)

Looks up the inventory item ID of a product.

Returns: the inventory ID

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

productID - the product ID

lookupNoteDetail
public java.lang.String lookupNoteDetail  (IBUParameters ibuParam, long noteID)

Looks up the note detail.

Returns: the note detail

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

noteID - the note ID
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lookupOwnerName
public java.lang.String lookupOwnerName  (IBUParameters ibuParam, String 
resourceID, String resourceType)

Looks up the service request owner name from the resource ID.

Returns: the resource name

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

itemID - the resource ID

lookupPlatform
public  java.lang.String lookupPlatform  (IBUParameters ibuParam, long 
platformID)

Looks up the name and description of a platform.

Returns: the platform name and description

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

platformID - the platform ID

lookupProblem
public java.lang.String lookupProblem  (IBUParameters ibuParam, String 
problemCode)

Looks up the prblem code and description.

Returns: the problem code and description

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

problemCode - the problem code
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lookupProduct
public java.lang.String lookupProduct  (IBUParameters ibuParam, long productID)

Looks up the product name and description.

Returns: the product name and description

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

productID - the product ID

lookupProductVersion
public java.lang.String lookupProductVersion  (IBUParameters ibuParam, long 
versionID)

Looks up the product version name for the version ID.

Returns: the version name

Throws: java.lang.Exception if error.

Parameters:

ibuParam - standard IBU parameter

version - the version ID

lookupRequestType
public String lookupRequestType  (IBUParameters ibuParam, long typeID)

Looks up the request type name of a request type ID.

Parameters:

ibuParam - standard IBU parameter

typeID - the request type ID

Returns: the request type name

Throws: Exception if error

lookupSeverity
public java.lang.String lookupSeverity  (IBUParameters ibuParam, long severityID)
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Looks up the severity name.

Parameters:

ibuParam - standard IBU parameter

urgencyID - the severity ID

Returns: the severity name

Throws: java.lang.Exception if error

lookupStatus
public String lookupStatus  (IBUParameters ibuParam, long statusID)

Looks up the status name of a status ID.

Parameters:

ibuParam - standard IBU parameter

typeID - the status ID

Returns: the status name

Throws: Exception if error

lookupUrgency
public java.lang.String lookupUrgency  (IBUParameters ibuParam, long urgencyID)

Looks up the urgency name.

Parameters:

ibuParam - standard IBU parameter

urgencyID - the urgency ID

Returns: the urgency name

Throws: java.lang.Exception if error

C.6 Interface SRConstant
The interface SRConstant defines the constant that can be used in JSP and in 
constructing a view object.
Oracle iSupport APIs C-19



Interface SRConstant
C.6.1 SRConstant Field Summary
The following table shows the field summary for this interface.

Description

static 
java.lang.String

ACCOUNT_ID Account ID

static 
java.lang.String

ASC Ascending order

static 
java.lang.String

CALLER_TYPE Caller type

static 
java.lang.String

CALLER_TYPE_VALUES Caller type values

static 
java.lang.String

COLUMN Columns that allow to be used in the selected column, 
filtering condition, and the order by columns. Important: 
the order of this array cannot be changed. If you append 
new items into this array, you need to update 
ViewServiceRequest.COLUMN, 
ViewServiceRequest.COLUMN2, 
ViewServiceRequest.VIEW, and the populate method. 

static 
java.lang.String

CONTRACT_ID Contract ID

static 
java.lang.String

CREATION_DATE Creation date

static 
java.lang.String

CUSTOMER_ID Customer ID

static 
java.lang.String

DESC Descending order

static 
java.lang.String

EMPLOYEE_ID Employee ID

static 
java.lang.String

HELPDESK_NUM Helpdesk number

static 
java.lang.String

INV_ITEM_ID Inventory item ID

static 
java.lang.String

LAST_UPDATE_DATE Last update date

static 
java.lang.String

PARTY_ID Contact party ID
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C.7 Class ServiceRequestFactory
The public class ServiceRequestFactory creates an appropriate instance of 
ServiceRequest and ServiceRequestUtil interfaces based on conditions such as 
Oracle Rollout flag, etc. It is recommended not to instantiate ServiceRequest and 
ServiceRequestUtil object yourself.

Dependency
oracle.apps.ibu.contract.ContractUtil

static 
java.lang.String

PRODUCT_ID Customer product ID

static 
java.lang.String

PROJECT_NUM Project number

static 
java.lang.String

RCS_ID

static 
java.lang.String

RCS_ID_RECORDED

static 
java.lang.String

SEVERITY_ID Severity ID

static 
java.lang.String

SOURCE Command - source of invocation

static 
java.lang.String

SR_NUM Service request number

static 
java.lang.String

STATUS_ID Status ID

static 
java.lang.String

SUMMARY Service request summary

static 
java.lang.String

TYPE_ID Request type ID

static 
java.lang.String

URGENCY_ID Urgency ID

static 
java.lang.String

lookupStatus Looks up the status name of a status id.

static 
java.lang.String

lookupUrgency Looks up the urgency name.

Description
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C.7.1 ServiceRequestFactory Field Information
The table below is the field information for the ServiceRequestFactory class.

C.7.2 ServiceRequestFactory Constructor Information
public ServiceRequestFactory

C.7.3 ServiceRequestFactory Method Information
The table below is contains method information for this class.

Methods Inherited from class java.lang.Object
clone, equals, finalize, getClass, hashCode, notify, notifyAll, toString, wait, wait, 
wait

C.8 Class ServiceRequestInfo
The public class ServiceRequestInfo extends java.lang.Object. This class stores 
information about a service request.

C.8.1 ServiceRequestInfo Field Information
The table below is the field information for the public ServiceRequestInfo class.

public static java.lang.String RCS_ID

public static final boolean RCS_ID_RECORDED

Method Description

public static Service Request createServiceRequest Creates a ServiceRequest object.

public static ServiceRequestUtil createServiceRequestUtil Creates a ServiceRequestUtil object.

Table C–3 Class ServiceRequestInfo Field Information

Field

java.lang.String accountNum

IDNamePair [] attachedFiles

java.lang.String attribute1
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java.lang.String attribute10

java.lang.String attribute11

java.lang.String attribute12

java.lang.String attribute13

java.lang.String attribute14

java.lang.String attribute15

java.lang.String attribute2

java.lang.String attribute3

java.lang.String attribute4

java.lang.String attribute5

java.lang.String attribute6

java.lang.String attribute7

java.lang.String attribute8

java.lang.String attribute9

ContactInfo [] contactInfos

java.lang.String contract

java.lang.String contractID

java.lang.String customerName

java.lang.String DBVersion

java.sql.Timestamp expectedResolutionDate

KeyDescPair [] extensions

long mAccountID

java.lang.String mCallerType

java.lang.String mComments

java.lang.String mContactBy

java.lang.String mContactInfo

java.lang.String mContactName

Table C–3 Class ServiceRequestInfo Field Information

Field
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long mContactPartyID

long mContactPointID

java.lang.String mCpRevision

long mCpRevisionID

long mCustomerID

java.sql.Timestamp mDateLogged

long mEmployeeID

java.lang.String mFileIDList

java.lang.String mHelpDeskNO

long mID

boolean mIsCancelledByUser

long mItem

java.lang.String mItemDesc

java.lang.String mItemRevision

java.lang.String mKbUsefulIDList

java.lang.String mLanguage

java.lang.String mLastUpdated

java.lang.String mLoggedBy

long mLoginID

java.lang.String mLongDesc

java.lang.String mNumber

java.lang.String mOwner

java.lang.String mOwnerID

long mPartyID

java.lang.String mProblemCode

java.lang.String mProblemCodeID

long mProduct

Table C–3 Class ServiceRequestInfo Field Information

Field
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C.8.2 ServiceRequestInfo Constructor Information
public ServiceRequestInfo ( ) Constructor

java.lang.String mProductDesc

java.lang.String mRequestType

long mRequestTypeID

java.lang.String mSeverity

long mSeverityID

java.lang.String mShortDesc

java.lang.String mStatus

long mStatusID

long mSystemID

java.lang.String mUrgency

long mUrgencyID

long mUserID

NoteInfo [] notes

java.lang.String noteType

java.sql.Timestamp obligationDate

java.lang.String OSVersion

java.lang.Object [] otherInfo1

java.lang.String platform

long platformID

java.lang.String projectNum

static java.lang.String RCS_ID

static boolean RCS_ID_RECORDED

java.lang.String shortCode

Table C–3 Class ServiceRequestInfo Field Information

Field
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C.8.3 ServiceRequestInfo Method Index
The table below is a method index of this class.

Method Description

long getAccountID Returns the account number.

java.lang.String getAttribute1

java.lang.String getAttribute10

java.lang.String getAttribute11

java.lang.String getAttribute12

java.lang.String getAttribute13

java.lang.String getAttribute14

java.lang.String getAttribute15

java.lang.String getAttribute2

java.lang.String getAttribute3

java.lang.String getAttribute4

java.lang.String getAttribute5

java.lang.String getAttribute6

java.lang.String getAttribute7

java.lang.String getAttribute8

java.lang.String getAttribute9

java.lang.String getCallerType

java.lang.String getContactBy Returns the contact method.

java.lang.String getContactInfo Returns the contact information

java.lang.String getContactName Returns the contact name.

long getContactPartyID Returns the contact party id.

long getContactPointID Returns the contact point id.

java.lang.String getCpRevision Returns the revision.

long getCpRevisionID Returns the revision id.

long getCustomerID Returns the customer id.
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java.sql.Timestamp getDateLogged Gets the creation date of the service request.

java.lang.String getDBVersion Gets and database version.

long getEmployeeID Returns the employee id.

java.lang.String getFileIDList Returns the attached file id list.

java.lang.String getHelpdeskNO Returns my reference number.

long getID Gets the service request id.

boolean getIsCancelledByUser Return true is the service request is cancelled by the user.

long getItem Returns the item id.

java.lang.String getItemDesc Returns the item description.

java.lang.String getItemRevision Returns the item revision

java.lang.String getKbNotUsefulIDList Returns not useful solution id list from knowledge base.

java.lang.String getKbUsefulIDList Returns useful solution id list from knowledge base.

java.lang.String getLanguage Returns the language.

java.sql.Timestamp getLastUpdated Gets the last update date of the service request.

java.lang.String getLoggedBy Returns the user id of the user who logged the request.

long getLoginID

java.lang.String getLongDesc Returns the service request long description.

java.lang.String getNumber Gets the service request number.

java.lang.String getOSRevision Gets the operating system version.

java.lang.String getOwner Returns the owner name of the service request.

java.lang.String getOwnerID Returns the owner id of the service request.

long getPartyID Returns the party id

java.lang.String getPlatform Returns the platform.

long getPlatformID Returns the platform id.

java.lang.String getProblemCode Returns the service request problem code description.

java.lang.String getProblemCodeID Returns the service request problem code id.

long getProduct Returns the product id.

java.lang.String getProductDesc Returns the product description.

Method Description
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java.lang.String getRequestType Returns the service request type.

long getRequestTypeID Returns the service request type id.

java.lang.String getSeverity Returns the service request severity.

long getSeverityID Returns the service request severity id.

java.lang.String getShortDesc Returns the service request summary.

java.lang.String getStatus Returns the service request status.

long getStatusID Returns the service request status id.

long getSystemID Returns the system id (CSI)

java.lang.String getUrgency Returns the service request urgency.

long getUrgencyID Returns the service request urgency id.

void setAccountID Sets the account number.

void setAttribute1

void setAttribute10

void setAttribute11

void setAttribute12

void setAttribute13

void setAttribute14

void setAttribute15

void setAttribute2

void setAttribute3

void setAttribute4

void setAttribute5

void setAttribute6

void setAttribute7

void setAttribute8

void setAttribute9

void setCallerType

void setContactBy Sets the contact method.

Method Description
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void setContactInfo

void setContactName Sets the contact name.

void setContactPartyID Sets the contact party id.

void setContactPointID Sets the contact point id.

void setCpRevision

void setCpRevisionID

void setCustomerID Sets the customer id.

void setDateLogged Sets the service request creation date.

void setEmployeeID Sets the employee id.

void setFileIDList Set attached file id list.

void setHelpdeskNO Set my reference number.

void setID Set the service request id.

void setIsCancelledByUser Set to true if the service request is cancelled by user.

void setItem Set the item id.

void setItemDesc Set the item description.

void setItemRevision Set the item revision.

void setKbNotUsefulIDList Set not useful solution id list from knowledge base.

void setKbUsefulIDList Set useful solution id list from knowledge base.

void setLanguage Set the language

void setLastUpdated Sets the last update of the service request.

void setLoggedBy Public accessors for setting the user id who logged the 
service request.

void setLoginID

void setLongDesc Set the service request long description.

void setNumber Sets the service request number.

void setOSRevision Set the operating system version.

void setOwner Public accessors for setting the owner of the service 
request.

Method Description
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C.8.4 ServiceRequestInfo Method Detail
Following is the method detail for this class.

getAccountID
public long getAccountID ()

Returns the account number.

void setOwnerID Public accessors for setting the user id of the owner of the 
service request.

void setPartyID Set the party id.

void setPlatform Set the platform.

void setPlatformID Set the platform id.

void setProblemCode Set the service request problem code description.

void setProblemCodeID Set the service request problem code id.

void setProduct Set the product id.

void setProductDesc Set the product description.

void setRDBMSRevision Set the database version.

void setRequestType Set the service request type.

void setRequestTypeID Set the service request type id.

void setSeverity Set the service request severity.

void setSeverityID Set the service request severity id.

void setShortDesc Set the service request summary.

void setStatus Set the service request status.

void setStatusID Set the service request status id.

void setSystemID Set the system id.

void setUrgency Set the service request urgency.

void setUrgencyID Set the service request urgency id.

void setUserID Set the user id.

Method Description
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getAttribute1
public java.lang.String getAttribute1 ()

getAttribute10
public java.lang.String getAttribute10 ()

getAttribute11
public java.lang.String getAttribute11 ()

getAttribute12
public java.lang.String getAttribute12 ()

getAttribute13
public java.lang.String getAttribute13 ()

getAttribute14
public java.lang.String getAttribute14 ()

getAttribute15
public java.lang.String getAttribute15 ()

getAttribute2
public java.lang.String getAttribute2 ()

getAttribute3
public java.lang.String getAttribute3 ()

getAttribute4
public java.lang.String getAttribute4 ()

getAttribute5
public java.lang.String getAttribute5 ()

getAttribute6
public java.lang.String getAttribute6 ()
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getAttribute7
public java.lang.String getAttribute7 ()

getAttribute8
public java.lang.String getAttribute8 ()

getAttribute9
public java.lang.String getAttribute9 ()

getCallerType
public java.lang.String getCallerType ()

getContactBy
public java.lang.String getContactBy ()

Returns the contact by method.

getContactInfo
public java.lang.String getContactInfo ()

Returns the contact information

getContactName
public java.lang.String getContactName ()

Returns the contact name.

getContactPartyID
public long getContactPartyID ()

Returns the contact party id.

getContactPointID
public long getContactPointID ()

Returns the contact point id.

getCpRevision
public java.lang.String getCpRevision ()
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Returns the revision.

getCpRevisionID
public long getCpRevisionID ()

Returns the revision id.

getCustomerID
public long getCustomerID ()

Returns the customer id.

getDateLogged
public java.sql.Timestamp getDateLogged ()

Gets the creation date of the service request.

getDBVersion
public java.lang.String getDBVersion ()

Gets the RDBMS version.

getEmployeeID
public long getEmployeeID ()

Returns the employee id.

getFileIDList
public java.lang.String getFileIDList ()

Returns the attached file id list.

getHelpdeskNO
public java.lang.String getHelpdeskNO ()

Returns my reference number.

getID
public long getID ()

Gets the service request id.
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getIsCancelledByUser
public boolean getIsCancelledByUser ()

Return true is the service request is cancelled by the user.

getItem
public long getItem ()

Returns the item id.

getItemDesc
public java.lang.String getItemDesc ()

Returns the item description.

getItemRevision
public java.lang.String getItemRevision ()

Returns the item revision

getKbNotUsefulIDList
public java.lang.String getKbNotUsefulIDList ()

Returns not useful solution id list from knowledge base.

getKbUsefulIDList
public java.lang.String getKbUsefulIDList ()

Returns useful solution id list from knowledge base.

getLanguage
public java.lang.String getLanguage ()

Returns the language.

getLastUpdated
public java.sql.Timestamp getLastUpdated ()

Gets the last update date of the service request.

getLoggedBy
public java.lang.String getLoggedBy ()
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Returns the user id of the user who logged the request.

getLoginID
public long getLoginID ()

getLongDesc
public java.lang.String getLongDesc ()

Returns the service request long description.

getNumber
public java.lang.String getNumber ()

Gets the service request number.

getOSRevision
public java.lang.String getOSRevision ()

Gets the operating system version.

getOwner
public java.lang.String getOwner ()

Returns the owner name of the service request.

getOwnerID
public java.lang.String getOwnerID ()

Returns the owner id of the service request.

getPartyID
public long getPartyID ()

Returns the party id

getPlatform
public java.lang.String getPlatform ()

Returns the platform.
Oracle iSupport APIs C-35



Class ServiceRequestInfo
getPlatformID
public long getPlatformID ()

Returns the platform id.

getProblemCode
public java.lang.String getProblemCode ()

Returns the service request problem code description.

getProblemCodeID
public java.lang.String getProblemCodeID ()

Returns the service request problem code id.

getProduct
public long getProduct ()

Returns the product id.

getProductDesc
public java.lang.String getProductDesc ()

Returns the product description.

getRequestType
public java.lang.String getRequestType ()

Returns the service request type.

getRequestTypeID
public long getRequestTypeID ()

Returns the service request type id.

getSeverity
public java.lang.String getSeverity ()

Returns the service request severity.

getSeverityID
public long getSeverityID ()
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Returns the service request severity id.

getShortDesc
public java.lang.String getShortDesc ()

Returns the service request summary.

getStatus
public java.lang.String getStatus ()

Returns the service request status.

getStatusID
public long getStatusID ()

Returns the service request status id.

getSystemID
public long getSystemID ()

Returns the system id (CSI)

getUrgency
public java.lang.String getUrgency ()

Returns the service request urgency.

getUrgencyID
public long getUrgencyID ()

Returns the service request urgency id.

setAccountID
public void setAccountID (long accountID)

Sets the account number.

Parameters: accountID - the account number.

setAttribute1
public void setAttribute1 (java.lang.String attr)
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setAttribute10
public void setAttribute10 (java.lang.String attr)

setAttribute11
public void setAttribute11 (java.lang.String attr)

setAttribute12
public void setAttribute12 (java.lang.String attr)

setAttribute13
public void setAttribute13 (java.lang.String attr)

setAttribute14
public void setAttribute14 (java.lang.String attr)

setAttribute15
public void setAttribute15 (java.lang.String attr)

setAttribute2
public void setAttribute2 (java.lang.String attr)

setAttribute3
public void setAttribute3 (java.lang.String attr)

setAttribute4
public void setAttribute4 (java.lang.String attr)

setAttribute5
public void setAttribute5 (java.lang.String attr)

setAttribute6
public void setAttribute6 (java.lang.String attr)

setAttribute7
public void setAttribute7 (java.lang.String attr)
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setAttribute8
public void setAttribute8 (java.lang.String attr)

setAttribute9
public void setAttribute9 (java.lang.String attr)

setCallerType
public void setCallerType (java.lang.String callerType)

setContactBy
public void setContactBy (java.lang.String contactBy)

Sets the contact method.

Parameters: contactBy - the contact by method.

setContactInfo
public void setContactInfo (java.lang.String contactInfo)

setContactName
public void setContactName (java.lang.String contactName)

Sets the contact name.

Parameters: contactName - the contact name.

setContactPartyID
public void setContactPartyID (long contactPartyID)

Sets the contact party id.

Parameters: contactPartyID - the contact party id.

setContactPointID
public void setContactPointID (long contactPointID)

Sets the contact point id.

Parameters: contactPointID - the contact point id.
Oracle iSupport APIs C-39



Class ServiceRequestInfo
setCpRevision
public void setCPRevision (java.lang.String cpRevision)

setCpRevisionID
public void setCPRevisionID (long cpRevisionID)

setCustomerID
public void setCustomerID (long customerID)

Sets the customer id.

Parameters: customerID - the customer id.

setDateLogged
public void setDateLogged (java.sqlTimestamp dateLogged)

Sets the service request creation date.

Parameters: dateLogged - the service request creation date

setEmployeeID
public void setEmployeeID (long employeeID)

Sets the employee id.

Parameters: employeeID - the employee id.

setFileIDList
public void setFileIDList (java.lang.String fileIDList)

Set attached file id list.

Parameters: fileIDList - the file id list.

setHelpdeskNO
public void setHelpdeskNO (java.lang.String helpdeskNO)

Set my reference number.

Parameters: helpdeskNO - my reference number.

setID
public void setID (long id)
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Set the service request id.

Parameters: id - the service request id.

setIsCancelledByUser
public void setISCancelledByUser (boolean isCancelledByUser)

Set to true if the service request is cancelled by user.

Parameters: true - if the service request is cancelled by user.

setItem
public void setItem (long item)

Set the item id.

Parameters: item - the item id.

setItemDesc
public void setItemDesc (java.lang.String itemDesc)

Set the item description.

Parameters: itemDesc - the item description.

setItemRevision
public void setItemRevision (java.lang.String itemRevision)

Set the item revision.

Parameters: itemRevision - the item revision.

setKbNotUsefulIDList
public void setKbNotUsefulIDLList (java.lang.String kbNotUsefulIDList)

Set not useful solution id list from knowledge base.

Parameters: not - the solution id list from knowledge base.

setKbUsefulIDList
public void setKBUsefulIDList (java.lang.String kbUsefulIDlist)

Set useful solution id list from knowledge base.

Parameters: useful - the solution id list from knowledge base.
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setLanguage
public void setLanguage (java.lang.string language)

Set the language.

Parameters: language - the language.

setLastUpdated
public void setLastUpdated (java.sqlTimestamp lastUpdated)

Sets the last update of the service request.

Parameters: lastUpdated - the last update date of the service request.

setLoggedBy
public void setLoggedBy (java.sqlTimestamp loggedBy)

Public accessors for setting the user id who logged the service request.

Parameters: loggedBy - who logged the service request.

setLoginID
public void setLoginID (long loginID)

setLongDesc
public void setLongDesc (java.lang.String longDesc)

Set the service request long description.

Parameters: longDesc - the service request long description.

setNumber
public void setNumber (java.lang.String number)

Sets the service request number. 

Parameters: number - the service request number

setOSRevision
public void setOSRevision (java.lang.String OSVersion)

Set the operating system version.

Parameters: OSVersion - the operating system version.
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setOwner
public void setOwner (java.lang.String Owner)

Public accessors for setting the owner of the service request.

Parameters: owner - the name of the owner of the service request.

setOwnerID
public void setOwnerID (java.lang.String OwnerID)

Public accessors for setting the user id of the owner of the service request.

Parameters: ownerID - the user id of the owner of the service request.

setPartyID
public void setPartyID (long partyID)

Set the party id.

Parameters: partyID - the party id.

setPlatform
public void setPlatform (java.lang.String platform)

Set the platform.

Parameters: platform - the platform.

setPlatformID
public void setPlatformID (long platformID)

Set the platform id.

Parameters: platformID - the platform id.

setProblemCode
public void setProblemCode (java.lang.String problemCode)

Set the service request problem code description.

Parameters: problemCode - the service request problem code description.

setProblemCodeID
public void setProblemCodeID (java.lang.String problemCodeID)
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Set the service request problem code id.

Parameters: problemCodeID - the service request problem code id.

setProduct
public void setProduct (long product)

Set the product id.

Parameters: product - the product id.

setProductDesc
public void setProductDesc (java.lang.String productDesc)

Set the product description.

Parameters: productDesc - the product description.

setRDBMSRevision
public void setRDBMSRevision (java.lang.String DBVersion)

Set the database version.

Parameters: DBVersion - the database version.

setRequestType
public void setRequestType (java.lang.String requestType)

Set the service request type.

Parameters: requestType - the service request type.

setRequestTypeID
public void setRequestTypeID (long requestTypeID)

Set the service request type id.

Parameters: requestTypeID - the service request type id.

setSeverity
public void setSeverity (java.lang.String severity)

Set the service request severity.

Parameters: severity - the service request severity.
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setSeverityID
public void setSeverityID (long severityID)

Set the service request severity id.

Parameters: severityID - the service request severity id.

setShortDesc
public void setShortDesc (java.lang.String shortDesc)

Set the service request summary.

Parameters: shortDesc - the service request summary.

setStatus
public void setStatus (java.lang.String status)

Set the service request status.

Parameters: status - the service request status.

setStatusID
public void setStatusID (long statusID)

Set the service request status id.

Parameters: statusID - the service request status id.

setSystemID
public void setSystemID (long systemID)

Set the system id.

Parameters: systemID- the system id.

setUrgency
public void setUrgency (java.lang.String urgency)

Set the service request urgency.

Parameters: urgency - the service request urgency.

setUrgencyID
public void setUrgencyID (long urgencyID)
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Set the service request urgency id.

Parameters: urgencyID - the service request urgency id.

setUserID
public void setUserID (long userID)

Set the user id.

Parameters: userID - the user id.

C.9 Class NoteInfo
The public class NoteInfo extends java.lang.Object. This class is a data object that 
stores note information that is attached to a service request.

C.9.1 NoteInfo Field Information
The table below is the field information for the public NoteInfo class.

C.9.2 NoteInfo Constructor Information
public NoteInfo () Default constructor

public NoteInfo (java.lang.String note, java.lang.String status, long userID, 
java.lang.String type, java.sql.Timestamp lastUpdateDate) Constructor

Table C–4 Class NoteInfo Field Information

Description

public 
java.sql.Timestamp

lastUpdateDate Holds the last update date of the service request.

public java.lang.String note Holds the note text.

public static final 
java.lang.String

RCS_ID

public static final boolean RCS_ID_RECORDED

public java.lang.String status Holds the note status.

public java.lang.String type Holds the note type.

public long userID Holds the user ID of the user who updates the note.
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C.9.2.1 Methods Inherited from class java.lang.Object
clone, equals, finalize, getClass, hashCode, notify, notifyAll, toString, wait, wait, 
wait

C.10 Class ProductInfo
The public class ProductInfo extends java.lang.Object. This class is a data object that 
stores product information that is attached to a service request.

C.10.1 ProductInfo Field Information
The table below is the field information for the public ProductInfo class.

C.10.2 ProductInfo Constructor Information
public ProductInfo () Constructor

C.10.2.1 Methods Inherited from class java.lang.Object
clone, equals, finalize, getClass, hashCode, notify, notifyAll, toString, wait, wait, 
wait

C.10.3 ProductInfo Method Index
The table below is a method index of this class.

Table C–5 Class ProductInfo Field Information

public static final java.lang.String RCS_ID

public static final boolean RCS_ID_RECORDED

Method Description

long getCustomerProductID Gets the customer product ID.

java.lang.String getPartNumber Gets the product part number.

java.lang.String getProductDesc Gets the product description.

java.lang.String getProductName Gets the product name.

java.lang.String getSerialNumber Gets the product serial number.

void setCustomerProductID Sets the customer product ID.
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C.10.4 ProductInfo Method Detail
Following is the method detail for this class.

getCustomerProductID
public long getCustomerProductID ()

Gets the customer product ID.

getPartNumber
public java.lang.String getPartNumber ()

Gets the product part number.

getProductDesc
public java.lang.String getProductDesc ()

Gets the product description.

getProductName
public java.lang.String getProductName ()

Gets the product name.

getSerialNumber
public java.lang.String getSerialNumber ()

Gets the product serial number.

setCustomerProductID
public void setCustomerProductID (long id)

viod setPartNumber Sets the product part number.

void setProductDesc Sets the product description.

void setProductName Sets the product name.

void setSerialNumber Sets the product serial number.

void setUserID Set the user id.

Method Description
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Sets the customer product ID.

Parameters: id - the customer product ID.

setPartNumber
public void setPartNumber (java.lang.String partNumber)

Sets the product part number.

Parameters: partNumber - the product part number.

setProductDesc
public void setProductDesc (java.lang.String productDesc)

Sets the product description.

Parameters: productDesc - the product description.

setProductName
public void setProductName (java.lang.String productName)

Sets the product name.

Parameters: productName - the product name.

setSerialNumber
public void setSerialNumber (java.lang.String serialNumber)

Sets the product serial number.

Parameters: serialNumber - the product serial number.

C.11 Class ViewServiceRequest
The public class ViewServiceRequest is an abstract class used to search service 
requests. It contains code that is common among all different types of searches. 
Classes extending ViewServiceRequest are required to define the from table and 
additional joining conditions.

C.11.1 ViewServiceRequest Field Information
The table below is the field information for the public ViewServiceRequest class.
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Table C–6 Class ViewServiceRequest Field Information

Description

protected static 
java.lang.String

ACCOUNT_ID

protected static 
java.lang.String []

COLUMN Columns that are allowed in the search criteria. This 
needs to be a 1-to-1 mapping to SRConstant.COLUMN.

protected static 
java.lang.String []

COLUMN2 Column names in the foreign table that joins with CS_
INCIDENTS_ALL_VL. This needs to be a 1-to-1 
mapping to COLUMN.

protected static 
java.lang.String

CONTRACT_ID

protected static 
java.lang.String

CREATION_DATE CREATION_DATE column.

protected static 
java.lang.String

CUSTOMER_ID

protected static 
java.lang.String

EMPLOYEE_ID

protected static 
java.lang.String

HELPDESK_NUM

protected static 
java.lang.String

INV_ITEM_ID

protected static 
java.lang.String

LAST_UPDATE_DATE

protected static 
java.lang.String

PARTY_ID

protected static 
java.lang.String

PRODUCT_ID

protected static 
java.lang.String

PROJECT_NUM

static java.lang.String RCS_ID

static boolean RCS_ID_RECORDED

protected static 
java.lang.String

SEVERITY_ID

protected static 
java.lang.String

SR_ID INCIDENT_ID column.
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C.11.2 ViewServiceRequest Constructor Information
public ViewServiceRequest () Constructor

C.11.2.1 Methods Inherited from class java.lang.Object
clone, equals, finalize, getClass, hashCode, notify, notifyAll, toString, wait, wait, 
wait

C.11.3 ViewServiceRequest Method Index
The table below is a method index of this class.

protected static 
java.lang.String

SR_NUM INCIDENT_NUMER column.

protected static 
java.lang.String

STATUS_ID

protected static 
java.lang.String

SUMMARY

protected static 
java.lang.String

TYPE_ID

protected static 
java.lang.String

UPDATE_DATE LAST_UPDATE_DATE column

protected static 
java.lang.String

URGENCY_ID

protected static 
java.lang.String []

VIEWS Name of the foreign tables/views that joins with CS_
INCIDENTS_ALL_VL. This needs to be a 1-to-1 
mapping to COLUMN.

Method Description

protected void contstructFrom Constructs the rest of the from clause of the query string.

protected abstract 
void

constructFromTable Constructs the from table clause of the query string.

protected void constructOrderBy Constructs the order by clause of the query string.

protected void constructQuery Constructs the query string.

Table C–6 Class ViewServiceRequest Field Information

Description
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C.11.4 ViewServiceRequest Method Detail
Following is the method detail for this class.

constructFrom
protected void constructFrom (java.lang.StringBuffer buffer, java.lang.String [] 
select)

Constructs the rest of the from clause of the query string.

Parameters: buffer - the query string buffer; select - the selected columns.

constructFromTable
protected abstract void constructFromTable (java.lang.StringBuffer buffer, 
java.lang.String [] select)

Constructs the from table clause of the query string.

Parameters: buffer - the query string buffer; select - the selected columns.

protected void constructSelect Constructs the select statement of the query string.

protected void constructWhere Constructs the where clause of the query string.

protected abstract 
void

constructWhereExtra Constructs the extract where clause of the query string.

abstract 
ServiceRequestInfo 
[]

fetchResults Deprecated. Use fetchResults2

static  
ServiceRequestInfo 
[]

fetchResults2 Fetches service request based on view object.

ServiceRequestInfo 
[]

fetchSR Fetches service request based on the select criteria.

protected abstract 
boolean

fetchSRPreAction This method will be invoked by classes extending 
ViewServiceRequest.

protected void populate Populates the service request information object.

protected static void processFilter Processes the filter condition.

Method Description
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constructOrderBy
protected void constructOrderBy (java.lang.StringBuffer buffer, StringPair [] 
orderBy)

Constructs the order by clause of the query string.

Parameters: buffer - the query string buffer; orderBy - the order by columns.

constructQuery
protected void constructQuery (java.lang.StringBuffer buffer, java.lang.String [] 
select, java.util.Hashtable filter, StringPair [] orderBy)

Constructs the query string.

Parameters: buffer - the query string buffer; select - the selected columns; filter - the 
filtering criteria; orderBy - the order by columns.

constructSelect
protected void constructSelect (java.lang.StringBuffer buffer, java.lang.String [] 
select)

Constructs the select statement of the query string.

Parameters: buffer - the query string buffer; select - the selected columns.

constructWhere
protected void constructWhere (java.lang.StringBuffer buffer, java.lang.String [] 
select, java.util.Hashtable filter)

Constructs the where clause of the query string.

Parameters: buffer - the query string buffer; select - the selected columns; filter - the 
filtering criteria.

constructWhereExtra
protected abstract void constructWhereExtra (java.lang.StringBuffer buffer, 
java.lang.String [] select, java.util.Hashtable filter)

Constructs the extract where clause of the query string. This method is invoked 
upon entering constructWhere method.

Parameters: buffer - the query string buffer; select - the selected columns; filter - the 
filtering criteria.
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fetchResults2
public static ServiceRequestInfo [] fetchResults2 (IBUParameters ibuParam, 
ViewInfo viewInfo, int startPage, int batchSize, int [] totalCount)

Fetches service request based on the view object. If the SRConstant.EMPLOYEE_ID 
is not set in the filter criteria, it will search for customer service requests. Otherwise, 
it will assume the caller is an employee and does appropriate logic.

Returns: The array of service request info taht match the criteria and range.

Throws: java.lang.Exception - if error.

Parameters: ibuParam - the standard IBU parameters; viewInfo - the view object; 
startPage - the start page number, 0-based; batchSize - the number of records per 
page; totalCount - the total number of records matching the criteria, this is a return 
parameter.

fetchSR
public ServiceRequestInfo [] fetchSR (IBUParameters ibuParam, java.lang.String [] 
select, java.util.Hashtable filter, StringPair [] orderBy, int startPage, int batchSize, int 
[] totalCount)

Fetches the service request based on the select criteria.

Returns: True to continue the execution of fetchSR, otherwise false.

Throws: java.lang.Exception - if error.

Parameters: ibuParam - the standard IBU parameters; select - the selected columns; 
filter - the filtering criteria; orderBy - the order by columns; startPage - the start 
page number, 0-based; batchSize - the number of records per page; totalCount - the 
total number of records matching the criteria, this is a return parameter.

fetchSRPreAction
protected abstract boolean fetchSRPreAction (IBUParameters ibuParam, 
java.lang.String [] select, java.util.Hashtable filter, StringPair [] orderBy, int 
startPage, int batchSize, int [] totalCount)

This method will be invoked by classes extending ViewServiceRequest. It is invoked 
upon entering fetchSR method. If this method returns false, fetchSR will exit.

Returns: True to continue the execution of fetchSR, otherwise false.

Parameters: ibuParam - the standard IBU parameters; select - the selected columns; 
filter - the filtering criteria; orderBy - the order by columns; startPage - the start 
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page number, 0-based; batchSize - the number of records per page; totalCount - the 
total number of records matching the criteria, this is a return parameter.

populate
protected final void populate (ServiceRequestInfo si, java.lang.string [] select, 
java.sql.ResultSet set, ServiceRequestUtil util, IBUParameters ibuParam)

Populates the service request information object.

Throws: java.lang.Exception if error.

Parameters: si - the service request info object; select - the selected columns; set - the 
result set; util - the service request util instance; ibuParam - the standard IBU 
parameters.

processFilter
protected static void processFilter (java.util.Hashtable filter)

Processes the filter condition. Converts those attributes that are in CSV format into a 
String query.

Parameters: filter - the filter criteria.
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Glossary

account

Account refers to the details or attributes of a deploying company’s selling 
relationship with a party. A selling relationship can include orders or negotiated 
prices. Account attributes do not describe a party; they only exist when a selling 
relationship is present between the deploying company and the party. 

account number

Number designated in the Trading Community Architecture (TCA) or Accounts 
Receivable (AR) and used to group account information about a party.

account site

A party site that is used within the context of an account, e.g., for shipping or billing 
purposes.

business entity

A branch, subsidiary, division, etc. of a company.

company

The entire business, including all business entities in the organizational structure.

contact point

A means of contacting a party other than sending physical mail, e.g., a phone 
number, e-mail address, telex number, fax number, etc.

customer

A person or organization with whom the deploying company has a selling 
relationship, regardless of whether anything has actually been purchased or 
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serviced. A selling relationship may be established by actually selling products, or it 
may be established by simply negotiating terms that will be used if you later sell 
products. In both scenarios, a selling relationship exists.

deploying company

The Oracle customer that has, or will, install, implement, and run all or part of the 
Oracle E-Business suite. 

DUNS Number

A unique identifier used by Dun & Bradstreet, a major business data content 
provider. The DUNS number is an attribute in the TCA.

GUI

An acronym for Graphical User Interface.

instance, item instance

In Oracle Install Base, an instance is an occurence of an item entity. For example, a 
manufacturer has a part number for a television he makes; each time he sells one 
television, an occurrence of this part number is recorded in Install Base

location

A point in geographical space described by a street address.

merchant

An Oracle E-business suite customers. Used to alleviate confusion with the term 
customers, which refers to customers of a business using Oracle products.

multiple organizations (multi org)

The ability to define multiple organizations and the relationships among them 
within a single installation of Oracle Applications. These organizations can be sets 
of books, business groups, legal entities, operating units, or inventory 
organizations.

party

An entity in the TCA that can enter into business relationships. A party is a real 
person, an organization, a branch, a subsidiary, a legal entity, a holding company, 
etc. In TCA, the attributes of a party are considered universal, i.e., they are 
independent of your selling or buying relationship with the party.
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party relationship

In TCA, a binary relationship between two parties, such as a partnership. A party 
relationship can be a party itself, meaning certain party relationships can enter into 
relationship themselves.

party site

In TCA, the link between a party and a location that indicates the location is valid 
for that party. A party site is not intended to represent a distinct business entity 
with which you can do business.

registration

Refers to the process by which any user would gain access to application 
functionality.

Registration Admin UI

User Interface (UI) used by merchant administrator or any person granted 
privileges to maintain users and accounts.

Registration Self-Service User UI

User Interface (UI) that is used by individual users or business users to register 
themselves.

registration template

Part of the Oracle CRM JTF User Management Framework (JUMF), registration 
templates are JSP pages set up by the application administrator to capture 
accommodate user information-gathering requirements.

responsibilities

A grouping of application menus that determine the user interface accessible to a 
particular user.

roles

Groupings of permissions which are page- and function-level, granular privileges 
used to maintain application security.

self-service registration

Refers to the process of user self-registration through a self-service UI, as opposed 
to being registered by an administrator. Self-service registration includes the UI and 
background processes used to complete the registration processes (including 
assigning users the appropriate data access and UI access privileges).
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system administrator

Also called sysadmin, the system administrator is a user who performs the 
highest-level administrator tasks in Oracle applications. 

TCA

An acronym for Trading Community Architecture, sometimes used interchangeably 
with the Oracle Trading Community Model.

Trading Community Model

The Oracle Trading Community Model, also known as Trading Community 
Architecture (TCA).

UI

An acronym for User Interface.

user

Refers to any person who needs access to any application. This includes various 
types of customers, partners, suppliers, and employees.

user types

Users are categorized into types based on their registration requirements and access 
privileges. User types can be associated with default roles, responsibilities, 
accounts, registration templates, and approval requirements.

user type, business

A user with a selling relationship to the deploying company.

user type, employee

A user who is an employee of the deploying company.

user type, individual

A user with no selling relationship to the deploying company.

user type, primary

A designated person of a party, business entity, or internal group (for example, sales 
department) who is responsible for approving other users and resetting passwords.
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